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Chapter 1 - Introduction 
Overview 

 
SchoolCenter WebTools is a user-friendly, web-based application used for creating and 
maintaining education-related websites with a minimal amount of effort.   
 
Within our WebTools products, we have already done the programming work so you do not 
need to have knowledge of HTML or FTP to produce an interactive and dynamic website.  Your 
website will bring together administrators, teachers, parents, students, and the community 
with the common goal of enhancing the educational experience.   
 
The SchoolCenter WebTools system can be used at the district, school, or classroom level, 
and allows you to produce unlimited webpages with minimal effort. 
 
Congratulations on bringing your school into the age of technology. 
 

Software/System Requirements 
The only requirement for using SchoolCenter WebTools is that you have an Internet 
connection and web browser.  The program can be used with an IBM, Macintosh, or PC 
computer. Version 6 or higher of Internet Explorer or Netscape is the minimum requirement to 
run the SchoolCenter WebTools program.  JavaScript and cookies must be enabled. Certain 
browsers do not support some components within SchoolCenter; complete browser 
information can be found online at www.schoolcenter.net or you may contact SchoolCenter 
Support for more information. 
 

Things to Remember 
If you are logged in and do not work with the program, you will automatically be logged off 
after 20 minutes.  You must go back and log in again. 
 
The program does not support the use of the browser Back button to move around within the 
program, as doing this may cause error messages to occur.  If you must use the Back button, 
after doing so, please click Refresh or Reload. 
 
If you want to upload files from a floppy disk, transfer the data to your hard drive first and 
upload the files from your hard drive. The program does not respond well to information 
pulled from a floppy disk. 
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About This Manual 

 
This manual explains the different components of the SchoolCenter WebTools system and 
contains brief How To instructions.  
 
In addition, for more detailed information on how to perform a certain task or to access our 
software tutorials, please refer to the Component Tutorials section of the SchoolCenter Support 
and Services website.  You can also click the Support link for additional help. 
 

 

Images and screenshots used in this manual may differ from your software. 
Browsers and operating systems affect how your software is displayed. Images 

have also been edited for content. 

 

How to Use This Manual 
 
Within the manual, please pay special attention to areas highlighted and marked in blue text; 
these notes often contain tips or important information and reminders pertaining to the 
software. Below is an overview of those areas and what each icon means. 
 

  These areas are for notes that a user may want to read. 
 

This icon refers to special information that users may find useful and save them time in 
the future. 
 

 These warnings include things that may cause the software not to act the way it should. 
 These are common user errors that users are being warned of in advance. 
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How This Manual is Organized 

 
The SchoolCenter WebTools manual is organized in a chapter format. Each chapter deals with 
different components of the SchoolCenter WebTools system.  
 
Chapter 1 - Introduction 
This chapter covers the SchoolCenter WebTools system and how it is used. It includes the 
different aspects of the SchoolCenter WebTools manual and how to use it.   
 
Chapter 2 - Getting Started 
In Chapter 2, you will learn the various ways SchoolCenter can help you get started creating your 
website. Rapid Design and training options are explained. 
 
Chapter 3 - Enhancements Options 
This chapter covers other features and enhancements available with SchoolCenter WebTools 
including, Content Approval, Grades Online and SchoolCenter WebMail. 
 
Chapter 4 - Desktop Management 
Desktop Management and features are covered in this chapter, including Start Page, Page Design, 
Usage Reports, Site Admin, User Editor, Organizer, and Support options.  Logging In, the Desktop 
Start Page and the Desktop Organizer are also covered in this chapter. 
 
Chapter 5 -  Site Administration and Reports 
In this chapter, Site Administrators will learn about administrative functions, references, and 
useful reports. 
 
Chapter 6 - User Management 
This chapter explains how Site Administrators can upload teachers and students in the 
SchoolCenter software.   
 
Chapter 7 - Editing Your Webpage 
In this chapter, you will learn how to edit your webpage by uploading text and media.  
Chapter 8 - Website Design 
This chapter has instructions on how to use the Page Design Features and Themes.  You will also 
learn about navigation options and how to use the Advanced Content Editor. 
 
Chapter 9 - Page Components 
All of the SchoolCenter Webtools page components are covered in this chapter.  You will receive 
a brief overview and explanation of the tools in each page. 
 
Chapter 10 – Advanced Editing 
Linking pages, hidden pages, URL redirecting, and password-protecting pages are covered in this 
chapter. This chapter also explains how to copy and move pages. 
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Contacting Us 
 

SchoolCenter’s staff is always available to help you in every way possible. Here are the most 
efficient ways to get answers for your questions:  
 

• Review the Help and Support website documents online at www.schoolcenter.net. 

• Email help@schoolcenter.net for a response within 24 hours. 

• Access Live Help on the Support and Services website to chat with a SchoolCenter 
customer service representative immediately. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you want to speak to a SchoolCenter representative on the phone, please call (888) 642-4448 
and ask for the Customer Service Department.  
 
Additional Contact Information 
SchoolCenter 
1075 Reed Station Road 
Carbondale, IL 62901 
Fax: (618) 351-1996 
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Chapter 2 - Getting Started 
 

Now that you have been introduced to the SchoolCenter WebTools system, you can begin 
creating a valuable communication tool for your district and/or school.  
 

Rapid Design 
Building a website from scratch can be a scary and challenging task. To help get your site off to 
a great start, the Rapid Design Department can help with setting up users and email.  The Rapid 
Design Department can also help give your district or your school a distinctive look that can be 
easily distinguished with banners, backgrounds, and many other enhancement features.  By using 
this service, you can have the site designed just the way you want.  Adding content to your site 
is simple and easy. 
 
 

 
 
Districts can have sites that proudly display each school's specific colors, but is still recognized 
as being a part of the same district. We are extremely excited about Rapid Design and how it 
allows you to have the site you really want.  
 

Starting From Scratch 
We continually try to provide the best possible instruction and support so you can use the 
program to its fullest capabilities. In addition to help files, a support site, and manuals, you also 
have access to software tutorials, a help forum, and a FAQ online at www.schoolcenter.net. 
 

Basic Component Overview 
As part of our training process, we also offer basic component overview sessions led by a 
member of our Professional Services team. During scheduled phone conversations, we will teach 
you more advanced aspects of the software while you work on your site. This overview is 
recommended to ensure that your website is as successful and thoroughly designed as possible. 
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Web Resources 

 
Online Manuals 
All SchoolCenter manuals are available in online versions on our Support and Services site. 
The online manuals contain all of the information available in our print manuals.  
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 2-1 
Help and Support 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Software Tutorials 
As companion tutorials to our manuals, SchoolCenter offers Flash™ video tutorials on our 
Support and Services site. The videos provide a more detailed level of assistance in 
demonstrating the steps for website management and design than the steps outlined in the 
manuals. 
 
The videos can be accessed through links on our online manuals and by clicking the Support 
button on the software. Not only does the Support button, with one click, give you access to all 
of the support services available on the Support and Services site, but it also provides you with 
direct links to our video tutorials so you can easily find the information and assistance you 
need. 
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Training 
 

The SchoolCenter Instructional Services Department is responsible for the instructional design 
and training of the software. Currently, we offer four courses that fit many different types of 
learners.  
 

1. Basic Training Program 
This is a six-hour program designed for the learner 
new to the SchoolCenter software or the veteran 
user who needs a refresher course.   
 
The Basic Program curriculum is as follows:  
• Login 
• Desktop Start Page 
• Title Bar buttons 
• Navigation Bar Links 
• Calendar Functions 
• Document Manager 
 

2. Advanced Training Program  
The advanced training program is a six-hour program designed for users that have mastered the 
basics and want more control over how their site looks. Users also learn about ways to customize 
components to better meet their needs. 
 
The Advanced Program curriculum is as follows:  
• Page Design 
• Advanced Content Editor 
• Categorized Scrapbook 
• Real World Application 
• Create a Custom Contact Form and CSV Export 
• Page Setting Details 
 

3. Site Administration Training Program 
The Site Administration training program is a six-hour program that teaches the Site 
Administrator functions of the 
software. 
The Site Admin curriculum is as 
follows: 
• Site Hierarchy 
• User Management (Adding 
Categories, Classrooms, New Users, 
Existing Users, etc.) 
• Navigational Grouping 
• Full Site Utilities (Manage Fonts, 
Site Preferences, Profanity Filter, 
Global Messaging, & Restrict File 
Types for Users) 
• Report 
• Manage Gallery 
 
In addition to the three different 
training programs offered above, 
we now have Customized Training.  With Customized Training,our professional staff will sit 
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down with you and develop a curriculum to address your specific needs.  This training is 
customized specifically with you in mind, since different districts and schools have different 
needs. 
 
Our instruction material is created using time-proven cognitive instructional design principles. 
Before we use any of our training products, you can be assured it has been thoroughly tested and 
put through a filter to check for clarity and accuracy.  
 
We take pride in our work at SchoolCenter and are constantly analyzing and evaluating our 
products to make them better.  You can find more information on training, including the training 
calendar and a contact information, online at www.schoolcenter.net in the training section.  
You can also call us at (888)642-4448. 
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Chapter 3 - Enhancement Options 
Enhancement Options 

 
One of the key advantages in using SchoolCenter is the wide range of available products and 
services. Along with the core WebTools components, SchoolCenter offers services that go well 
beyond simple web hosting. Content Approval, Grades Online, SchoolCenter Mail and Rapid 
Design are just a few examples of such services.  
 
Whether used in conjunction with WebTools or separately, these services can assist educators in 
becoming more productive and efficient than ever.  
 

Content Approval 
When policy requires, SchoolCenter's software can be configured to require approval from 
administrators or other school authorities before content is posted to the web.  
 

 

The SchoolCenter Content Approval system is not a standard feature of the 
SchoolCenter software. For more information on how you can get Content 

Approval, contact a SchoolCenter representative. 

 
SchoolCenter's Content Approval allows Main Site Administrators to review and approve all pages 
edited on your website before it is released to the general public. An email notification will be 
sent to the user when the pages have been published. 
 

Main Site Administration Setup 
SchoolCenter assigns a Main Site Administrator to your site when it is created. The Main Site 
Administrator is responsible for the approval of all pages waiting to be published.  
 
When a user is chosen to be the Main Site Administrator, SchoolCenter will assign him or her 
privileges by placing a check in the box next to the option Main Site Admin. 
 
This option will allow the user to approve pages to publish on the web. The option, Approve 
Published Pages, will be listed under the Site Admin button. 
 

Who Can Approve What 
The Main Site Administrator has the ability to select users who can approve published pages.  

• To select users, click the Admin button and select the Who Can Approve What option.  
 
 
 

 
 

Figure 3-1 
Who Can Approve Pages 

 
 
 
 

• Here, you will see an index of sections in the box located to the left of the page.  

• To select an area to assign a User to edit, click the names of the sections until you have 
selected the correct section. 

• Once the section is selected, click the Add Approver icon. This will open a new window.  

• Enter in the First, Last, or User name. Then click the [Search] link. 
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Figure 3-2 
Add Approver 

 
 
 
 
 
 
 
 

• A list of users matching that search will show. Click the name of the user you want to 
select to approve.  You will receive a confirmation message.  

• Click the [Close Window] link to finish selecting the user. The list of users who are 
approved to edit this section will be listed on the right side of the page. 

 
 
 

 
 
 
 
 

Figure 3-3 
Approvers List 

 
 
 
 
 
 
 

 
Publish a Page 
When a user has finished editing the web page, it will not automatically be published on the 
Internet. Before a page is published to the Internet, the user must first complete a few steps.   
 
After editing is finished, the user has the option to Publish This Page.  

• To publish a page, locate the Content Approval links in the Edit drop-down menu. 
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Figure 3-4 
Publish Page Buttons 

 
 
 
 
 
 

 
 

• To publish the page you have just completed editing, click the Publish This Page option. 
This will place the page you want to publish into a queue until it has been approved.  

• When the page is approved and published, the user will receive an email notifying that 
the page has been published to the site.  

 

 

The email will be sent to the address of the user that requested to publish the 
page. The email address used is entered in the Email field of the User Editor. For 

more information, view User Setup. 

 

Reset From Live Page 
If you edit your page, but no longer like the changes you made, you can reset the page to display 
as it was before any changes were made.   
 

• To reset your edited page to the "Live", unpublished page, click the Reset From Live 
Page option under the Edit drop-down menu. You will open a new window. 

• Click OK to continue resetting the page to the "Live" version, or click Cancel to quit the 
reset.  

• Click OK, and your page will be reset without any changes. 
 
Remove Page from Queue 
After a page has been placed into the queue, the Edit Page button and the Page Settings button 
will be crossed out and will appear in gray.  You will not be able to make any changes. This 
prevents having multiple versions of 
the same page waiting to be 
approved. 
 

 
 

Figure 3-5 
Queued Pages Buttons 

 
 
 
 
 
 
 
 
If you want to make changes to this page after it has been placed into the queue, you will have to 
remove it first.  
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• To remove the page from the queue, click the Remove This Page from Queue option in 
the Edit drop-down menu.  

• You will open a new window. Click OK.  

• Your page will now be removed from the queue and you can edit this page again.  
 

 

Use the same steps when Publishing a Site. 
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Administration of Content Approval 

 
Administration of Content Approval 
The Main Site Administrator and Selected Users are responsible for the approval of all pages 
waiting to be published.  
 

• To approve pages, click Site Admin and select Approve Published Pages. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 3-6 
Approve Pages 

 
 
 
 
 
 
 
 
 
 
 
 
 
In the Approve Published Pages utility, you can select which page you want to approve. Pages 
or sites selected to be published will be placed in a queue waiting to be reviewed and approved. 
  
 
The queue will list how many sections and pages are waiting to be approved. It will also list the 
pages already approved, but not yet published. Approved Sections and Pages will be placed in a 
queue and published in a one-minute rotation. The time of the next scheduled queue update will 
also be listed. 
 

 

The minute rotation queue is designed so that every page does not publish at one 
time, causing network or server problems. 
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Approving Sections 
Each section, or page, that has had a request to be published will be listed along with the name 
of the user and the date and time of the request. 
 
 

 
 
 
 
 
 
 
 
 
 
 

Figure 3-7 
Pages Awaiting Approval 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Approve Sections  
Sections waiting to be approved are marked in gray and will display every page in that section.  

• To approve sections listed in the queue, check the box next to the name of the section. 
All the pages in that section will automatically be checked. 

• When the sections you want to approve are checked, click Approve Selected Pages. The 
pages in that section will be marked as approved with a green check. 

 
Approve Pages 

• To approve pages listed in the queue, check the box next to the name of the page.  

• When the pages you want to approve are checked, click Approve Selected Pages. The 
pages will be marked as approved with a green check. 

• To review the sections and pages before they are published, click the web page icon and 
you will be directed to that page. 

 
Unapprove Sections and Pages 
If you do not want approved sections or pages to be published, you can choose to not approve 
them.  

• To deny approval of a page or section, check the box next to the name of the section or 
page.  

• Then click Unapprove Selected Pages. The pages will now be marked with a red line. 

• To remove sections and pages from the queue, click the X.  
 

Content Publishing Reports 
The Main Site Administrator has access to the Content Publishing Reports.  
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• To view the reports, click Reports and select Content Publishing Reports. 
 
 

 
 
 
 
 
 
 
 
 

Figure 3-8 
Content Publish Reports 

 
 
 
 
 
 
 
 
 
 
 

 

• The Content Publishing Report will be listed by month. Click the name of the month 
you want to view. 

• Select the day you want to see what was published. The report will expand detailing the 
name of the person who approved the pages, the name of the section the page was in, 
and the page that was approved. You will also be shown the time those pages were 
approved. 

 

 

The Content Publishing Report will show the last  
365 days of approval activity. 

 



Webtools Manual 

16 

Grades Online 

 
Grades Online  
SchoolCenter's Grades Online service was developed with two goals in mind: To assist our 
schools in posting all information to the Internet with SchoolCenter software and to allow 
teachers at our schools to continue working within their current gradebook software.   
 
To that end, SchoolCenter works with your current gradebook company to allow grades and 
attendance to be reported to your school’s website safely and securely. This service allows 
teachers to effectively keep track of their grades along with the rest of their classroom-based 
software.  At the same time, this service allows parents the opportunity to stay up-to-date on 
their child's progress and schoolwork with just the click of a mouse. For SchoolCenter Grades 
Online users, a manual for the Grades is available online at www.schoolcenter.net. 
 

 

For more information on using the SchoolCenter Online Grades, see the 
Reporting Grades section of the Support and Services website. 
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Support and Log Off 

 
Support 
This area provides a link to the SchoolCenter Support and Services site.   
When you click Support, the Support and Services page will be displayed in a new window.  You 
can then leave this window minimized for fast reference while working on your website.   
 

Log Off 
When you click Log Out while on the Desktop, a window will open giving you options for logging 
off the system. 
 
If you want to sign in again or with a different user ID, you can click OK to return to the Log On 
screen. To completely log off and be redirected to your homepage, click Cancel. 
 
When you want to log off while editing your website, click the Log Off button located at the top 
of the screen. This will automatically log you out of your site. 
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Chapter 4 - Desktop Management 
 

SchoolCenter is set up with a View Mode and an Edit Mode. To access your site as a viewer, 
simply type the URL/web address.  To log in and start adding and editing content to your site, 
type your URL/web address followed by /admin.    
 

Logging In 
To log in, type your User ID and Password in the appropriate text boxes. 
 
 
 
 
 

Figure 4-1 
Login Page 

 
 
 
 
 
You have the option to have the computer remember your password by checking the Remember 
Me box located below the login boxes. When the box is checked, the computer will 
automatically remember the password for the last user and will log that user back on when the 
page is accessed. 
 

 

The Remember Me option is not recommended for use for those working in a 
computer lab or working on a computer to which others have access. 

 
You also have the Lost Password? option located to the right of the Remember Me box. If you 
forget or lose your password, you can click this link, enter your user name and an alternate 
email address in the appropriate boxes.  Your password will then be emailed to you. 
 
Once you have typed in your User ID and your password, click Logon. You will then be at your 
Start Page. 
 

Changing Your Password 
• In the Login Information box, click the Edit button located to the right of your user name 

to open the User Editor. 
 

 
 
 

Figure 4-2 
Login Information 

 
 
 

 

• Type your new password into the New Password box, and then re-type it into the 
Confirm New box to confirm your choice.  
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Figure 4-3 
User Info 

 
 
 
 
 
 
 

 

• Click Done. You have now changed your password.  
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Start Page 

 
The Start Page contains your Login Information, a date and time bar, your feed reader, 
scheduler, and other tools. The buttons at the top of the page below the SchoolCenter logo, 
including the Start Page, Public Sites, Design, Organizer and the Support and the Log Off 
buttons, will help you navigate and allow you to receive online help. They will appear at the top 
of each screen throughout the system.  
 

 
 
 
 
 
 
 
 

Figure 4-4 
Start Page 

 
 
 
 
 
 
 
 
By clicking the Edit button located to the right of your user name, you can edit your Login 
Information, including changing your password. 

 
Organizer 
The Organizer drop-down menu contains links to all of your Start Page options, such as Task 
List, Schedule, Notes, Documents, Attendance, Lesson Planner, Contacts, Favorite Sites, My 
Teacher Grades, Feed Reader, and Desktop Settings.  These options may vary depending on 
what extra options your district or school may have.  
 

 
 
 
 
 
 

Figure 4-5 
Organizer 

 
 
 
 
 
 
 
 
 

• To access the Organizer, click the Organizer 
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button located at the top of your screen. 
 

 

If you have selected to use Grades Online, the grades options will be listed in 
your Desktop Organizer. 

 

Contacts 
The Contacts feature is similar to the Address Book in SchoolCenter WebMail, where you can 
store email addresses and other contact information. All contacts are sorted alphabetically by 
the last name of the contact.  
 

 
 
 
 
 
 
 
 

Figure 4-6 
Organizer Contacts 

 
 
 
 
 
 
 
 
 

 

• When you click the Add New Contact tab, you have the option of adding a SchoolCenter 
user or manually adding a contact.  

 
 
 
 
 
 
 
 
 

Figure 4-7 
Edit Contact 

 
 
 
 
 
 
 
 
 
 

 
 

• To begin using groups, click the Manage Groups tab.  

• To add a group, click the Add New Group tab located in the upper right corner. 

• In the display that appears, you will have the option to add individual contacts and/or 
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groups to your message. 

 
Documents 
The Documents tool allows you to add up to 10 mb of personal documents, which cannot be 
shared, to your Desktop. This feature can be helpful for both teachers, who can post files that 
they may want to work on at home, and students, who can use it as their own eLocker or 
student portfolio.   
 
 
 
 

 
 

Figure 4-8 
Organizer Documents 

 
 
 
 
 

• When you select this tool, you have the option to add documents and to organize those 
documents within categories. 

 
Adding Documents 

• To add a document, click the Add New Document tab located on the right side of the 
screen.  

• You now have the option of adding a document from your computer or linking to a 
document that is already on the Internet. 

• To add a document from your computer, click Browse. 

• Select the document file you want to add by double-clicking it. 

• Click Upload file. 

• Choose the category you want the file placed in by selecting the correct category from 
the drop-down menu. 

• You can add text to this document by filling in the text box. 

• Click Done to save your changes. 
 

 
 
 
 
 

 
 

Figure 4-9 
Document Categories 

 
 
 
 
 
 
 

Notes 
Notes can be used as reminders 
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of duties, events, or other important information.   

• Click the Notes link from the Organizer menu to open the feature and then click the Add 
New Note link. A new note now shows on the screen. 

 
 
 
 
 
 
 
 
 
 
 

Figure 4-10 
Edit Note 

 
 
 
 
 
 
 
 
 
 
 

 

• To compose the note, click the Edit icon located to the left of the note. 

• Choose a category for the note from the drop-down menu at the top. 

• Delete “New Note” from the Title text box and type the desired title for the note. 

• Type the text for your note in the Note box.  

• Once you are finished, click Done. The screen will take you back to the Notes page 
where your edited note will be displayed.  

 
 
 
 
 
 
 

Figure 4-11 
Organizer Note 

 
 
 
 
 

 
 
 
 
 
 
 
Schedule 
The Schedule is a calendar feature that displays important daily, weekly, and annual events and 
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agendas. Events can be shown in color-coded categories on a daily/weekly/monthly/annual 
basis.  The feature also includes an option to display the schedule as a list, to show or hide 
details for each event, to import and export information from other calendars, and more.   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-12 
Organizer Schedule 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
When you open the feature by clicking the Schedule link from the Organizer menu, you have the 
options of adding categories and/or new events to the calendar. 
 
Categories 

• To add a category, click the Categories tab.  

• Remove (New Category) from the Name field and type the name of the new category. 

• Click Save.  

• Click the color square that appears next to the drop-down menu to select a color for the 
category. 

Show Other 
A share feature has been built into the Calendar page component so information entered on 
these pages may be shared from classroom to district, school to classroom, and school to school. 
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In this way, information may be entered in one area and shared throughout the entire website.  

• To share the data, you must be in Edit mode. While on the Calendar page, click the 
Show Other tab. This will open a new window with Summary and Browse tabs.  

• Click the Browse tab to show a list of pages in your site.  
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-13 
Summary Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Navigate to the page you want to pull data from, and then select the categories you 
want to place in your page.  

• Once you click Done, the data pulled from the other page will now appear on the site 
with a barrels icon located next to the information instead of an Edit icon. This means 
that you will not be able to edit the information, since it is pulled from another page. If 
the information is changed on the original page, it will subsequently change the 
information on your page.  

• To remove the data from your page, click the Show Other tab.  

• Click the link of the page that originally held the data.  
Clear the check box and click Done. The data will then be removed. 
 
 
 
 
 

Figure 4-14 
Schedule Category 
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Add New Event 
General 

• Under the General tab, you can select the date of your event by either filling in the 
appropriate date in the space provided or by clicking the calendar icon and choosing a 
date from the calendar pop-up window. 

• Next, type the date of the event or click the Date Picker icon to select the 
month/day/year for the event. 

• Remove (New Item) from the Title field and type the name of the new event.   

• Add your text in the Text field or use the Advanced Content Editor.  
 

 
 
 
 
 
 
 
 
 
 

Figure 4-15 
Schedule Event 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

For more on adding text and using the ACE see Chapter 8 - Editing Your 
Webpage. 

 

 
 
 
 
Options 

• Under the Options tab, you can 
choose to make your event either 
an all-day event or you can enter 
in the start and end time for your 
event. 

• You may also choose to either 
show or hide the last user to edit 
this item by clicking the 
corresponding button. 
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Figure 4-16 
Options Tab 

 
 
 
 
 
 
 
 
Styles 

• Click the Styles tab to choose the alignment, font size, and font color. 

• Select the Border box to open the border options.  Choose the desired border color from 
the Color Picker and border size from the drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking the desired color’s 
circle. You will see your choice show up in the Color box. 

Recurrences 

• To make the event recurring, such as a weekly or monthly meeting, or a weekly test, 
click the Recurrences tab. 

• Click Make Event Span/Recur. 

• A new screen will open giving you the option to have your event recur.  If your event 
occurs on specific weeks, choose from the weekly drop-down menu whether your event 
will recur one, two, three, or four weeks. 

• Next, choose what day your event will recur on. 

• Alternatively, if you have a recurring monthly event, you may choose from the drop-
down whether your event recurs on the first, second, third, or fourth of every month. 

• Choose what day of the month your event recurs on from the day of the week drop-down 
menu. 

• Finally, you can make your event recur every year on a specific date by simply clicking 
the Annually (every year on the same date) option. 

 
 
 
 
 
 
 

Figure 4-17 
Recurrences 

 
 
 
 
 

 
 
 



Webtools Manual 

28 

 
Category 

• You can bind your event to categories by clicking the Category tab. 

• If you want to add another event, you can click New Event. Your event will be saved 
and a New Event window will open.  

• You also have the option to hide or show the author of this event or to add an image. 

• In the new window that appears, simply choose the category or categories you want to 
bind your event to and then click Done. 

 
 
 
 
 
 
 

Figure 4-18 
Categories Tab 

 
 
 
 
 
 
Reminder 

• In the Reminder tab, you can choose to have a reminder sent to you prior to the event. 
 Click the Send me an email reminder about this event option. 

• From the drop-down menu, choose whether you want to be reminded one week or one 
day prior to the event.   

• Once you have entered all of the information necessary for your new event, click Done 
to save your changes. 

 

 

For more on adding an image see Chapter 8 - Editing Your Webpage. 

 

• When you are finished entering the information for the event, click Done to save it.  
 

 

Each event can be placed in up to eight different categories. 

 
 

Task List 
With the Task List, you can keep track of things to be done by listing them on your Start Page. 
When the tasks are finished, you can then mark them as finished on the list to keep a record of 
what has been done.  
 

• To access the Task List, click the Task List link from the Organizer menu. 

• You can now add a new task to your Task List by clicking Add New.  

• Delete (New Task) from the Task box and rename the task. 

• Choose a category for it from the drop-down menu located to the right of the Task box.  

• To delete the new task, click the x Delete icon. 
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Figure 4-19 
Organizer Task List 

 
 
 
 
 

 

• When finished, click Save to save the new task. You may add another task by clicking 
Add New.  

 

Desktop Settings 
With Desktop Settings, you can customize your Start Page by choosing which Organizer features 
you want to display and where on the Start Page you want them to be displayed.  
  

 
 
 
 
 
 
 
 
 
 

Figure 4-20 
Desktop Settings 

 
 
 
 
 
 
 
 
 
 

 

• To access this feature, click the Desktop Settings link in the Organizer menu.  

• To place a component on your Start Page, select the box next to that component.  

• After selecting the components, you can arrange how they will appear on the page by 
clicking the black arrows to move them to either side of the page.  

• Once you have decided which side of the page you would like your features to appear, 
you can arrange the order they appear by clicking the Sort icon below each column. 

• A new window will open where you can click and drag the features into the order you 
want them to appear, or you can choose to put them in alphabetical order, reverse 
alphabetical, or simply just reverse the order in which they already appear. 

• Click Done to save your sort, or Cancel to exit the window without saving. 

• When you have finished selecting and arranging the components, click Save Settings and 
then click Done to return to the Start Page. 
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Public Sites 

 
Public Sites 
The Public Sites function allows you to navigate to any page throughout your school or district. 
 This gives you quick access to various pages and also allows you to edit various sites much more 
quickly.  The Public Sites component also lets you know exactly how many sites are listed in your 
district or school.  
 
 
 
 

 
 
 

Figure 4-21 
Public Sites 

 

 
 
 
 
 

• When you click Public Sites, the sections within your site will be listed on the screen.  

• Click the name of the section you want to navigate, or click the down arrows to expand 
that section. 

• When you have found the section that you want to visit, click the link and you will be 
directed to that page. 
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Reports 

 
Login Times of the Day 
This report charts daily editing for this section. It will record login times and the number of 
people who have logged in at those times since the section was created. The data is shown in 
times and login numbers and in a graphic chart.  
 

 
 

 
 
 
 
 

Figure 4-22 
Login Times Report 

 
 
 
 
 
 
 
 

• To print this report, click Print and a new window will open previewing what will be 
printed. Click the Print link and the screen will be printed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Login Times of the Week 
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This report charts weekly editing for this section. It will record the login days and the number of 
people who have logged in on those days since the section was created. The data is shown in 
days and login numbers. It also appears in a graphic chart.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-23 
Login Days Report 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• To print this report, click Print and a new window will open previewing what will be 
printed.  

• Click the Print link and the screen will be printed. 

 
 
Login Days of the Month 
This report charts monthly editing for this section. It will record the login days and the number 
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of people who have logged in on those days since the section was created. The data is shown in 
days and login numbers. It also appears in a graphic chart.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-24 
Login Days Report 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• To print this report, click Print and a new window will open previewing what will be 
printed.  

• Click the Print link and the screen will be printed. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Most Edited Pages 
This report shows the most edited pages for this section and the number of times each page has 
been edited. It will record the page names and the number of times the page has been edited 
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since the section was created. The data is shown in page names and login numbers. It also 
appears in a graphic chart.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-25 
Most Edited Pages 

Report 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• To print this report, click Print and a new window will open previewing what will be 
printed.  

• Click the Print link and the screen will be printed. 
 

Profanity Report 
This report provides you with a list of the attempted profanities that have been perpetrated on 
your school’s website. 
 
The information includes all instances of when someone has uploaded a word that is included in 
the profanity filter. Emails are sent to the Site Administrator upon each occurrence if the 
Profanity Filter has been enabled. 
 

 

For more information and a list of words contained in the profanity filter, see the 
Profanity Filter - Word List section of this manual. 
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Website Stats 
This report charts the number of times your site has been hit and/or accessed. This information 
can be valuable for planning purposes and to track whether or not your marketing is bringing 
people to your website.  
On the first page, the report shows the number of times your section was viewed.  
 
 
 
 
 
 
 
 
 

 
 
 

Figure 4-26 
Web Stats Report 

 
 
 
 
 
 
 
 
 
 
 
Under Page Views, click the numbers to see a breakdown of individual page hits. The Operating 
System and Browser of visitors to your site is also recorded here.  
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Admin 

 
Admin 
The Site Admin area has Full Site Utilities and Image Utilities to assist you in efficiently and 
easily managing your website. To view the utilities available to you, click the Site Admin button.  
 

 

The following is an overview of the Full Site Admin functions; for more 
information and detailed instructions on their uses, see Chapter 5: Site 

Administration. 

 

Edit Site Footer 
With the Site Footer, you can create a text message that will appear at the bottom of every 
page in your district. 
 
 
 
 
 
 
 

 
 
 
 
 

Figure 4-27 
Site Footer 
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Edit Meta Tags 
This option allows you to add keywords and phrases to your website’s meta tags for Internet 
search engines. If these words are typed into the search engine, the search will include your site 
in the results. 
 
 

 
 
 
 
 
 
 

Figure 4-28 
Edit Meta Tags 
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Image Creator 

 
Image Creator 
The Image Creator tool allows you to create your own customized banners, making your 
website more visually appealing as well as creating a unique and personalized atmosphere for 
your visitors.   
 
Creating Your Banner  

• Click the Site Admin button.   

• Select the Image Creator link. 
 
Here, you can view existing banners or create new banners.  

• To see an existing banner, click the (View Banner Archive) link. 

• To create a new banner, type the title for the banner in the New Banner Title field and 
then click Add New.  

 
 
 
 
 
 
 
 
 

Figure 4-29 
Banner Image Creator 

 
 
 
 
 
 
 

 

By using the icons in the Tool Bar, you can add images and layers to your banner and change its 
height and width. You can also change the border size and color as well as the background color 
and image. You can also select whether you want your background to be transparent by clicking 
the dots on the bottom left corner of the Color Picker. If you do not want to have a border, 
leave the border size setting at 0.  
 
Adding an Image to the Image Creator 
When creating an image or a banner that contains images, you can use an image from the 
SchoolCenter Image Gallery, Our Gallery, or you can use your own image.   

• To add an image, click the Our Gallery box to find an image in your school’s gallery.  

• If you want to use an image from the SchoolCenter Image Gallery, click SchoolCenter 
Gallery.  You can also add an image from your local hard drive by clicking the Add 
Media icon.   

• When you add an image, type the name for the layer in the Title field.  

• Once you have changed your settings, click Save. To remove the image from your new 
image or banner, click Remove. 

 



Chapter 4 - Desktop Management 

39 

 

For a list of the types of files that can be added to the Images or Banners, see 
the Media File section in the Upload New Media window. 

 
Adding Multiple Layers  
To add text or another image to your image, click Add New Layer.  
 
Adding Text to the Image 

• Click Add New Layer. When you add a text layer to your image, you can change the 
text (the words being placed on the image) and text size, font type and color, and font 
shadow color.  

• After your text settings are changed, click Save. 

• To align your text, or place it where you want to see it on your image, move your 
mouse over the image. When you have the mouse cursor placed where you want to 
place the bottom left corner of your text, click to place the text on the image.  

• After each change to your image, you will have to click Save to save the new settings. 
 
Saving the Image 
When you are done creating your image, you have two options to save it.  

• Make sure you are on the background layer by clicking the [Background Layer] link. 

• If you want to add your image to your school’s image gallery, click Add image to 
Gallery.  

• You can also save your image to your computer without having to add it to the Our 
Gallery. Click the Generate image icon to display your banner in a new window.  

 

 

PC users can move their mouse over the banner and right-click, then select Save 
As...  

MAC users should press and hold Control and click the mouse. This will open a 
menu where either Save As… or Download Image to Disk can be selected, 

depending on the operating system. 
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Administer Local Image Gallery 

 
Administer Local Image Gallery 
This utility will allow users with the proper access levels to add and/or delete categories within 
Our Gallery. The Administer Local Image Gallery option also allows users to move images 
between categories and to add keywords and descriptions to those images.  
 
SchoolCenter provides your school with its own gallery in which to store images called, Our 
Gallery. The gallery acts as a centralized location that stores images and allows all users to load 
them onto their websites. You may want to store images of your school or other commonly used 
images within the gallery. 
 
Once you click the Administer Local Image Gallery link, you have the options to edit your 
categories and to upload new images.  
 

 
 
 
 
 
 

Figure 4-30 
Administer Image 

Gallery 

 
 
 
 
 
Adding/Editing Categories 
To create a new category or edit an existing category, click the Edit Categories icon located at 
the bottom of the Local Image Gallery window.  
 

 

SchoolCenter will not allow you to delete some categories that it uses in the 
software. 

 
 

 
 
 
 
 
 

Figure 4-31 
Gallery Categories 
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Mass Upload to Local Image Gallery 
This utility allows users to upload multiple images into Our Gallery. To begin, you will need to 
place all images into a zip file on your hard drive.  
 

• Once you click the Mass Upload to Local Image Gallery link, select from the drop-down 
menu the category where you want to place the images.  

• Type the description and keywords for the images and then upload them by clicking  
Browse and browsing for the zipped file on your hard drive.  

• Once you locate the zip file, click Upload Zip File. 
 

 

When mass uploading images, users can fill out a .CSV file that will 
automatically add keywords and a description. 

 

• To upload another zip file, click the [Upload another batch] link or click the [Local 
Image Gallery] link to return to the image gallery. 

 

Add to Local Image Gallery 
You have two methods to add images to the gallery. Enhanced Mode will let you select multiple 
files to upload to the image gallery by simply dragging and dropping the files you select. 
Enhanced Mode uses Java™, so if you are uncertain as to whether you have Java™, simply use the 
Standard Mode.  
 
Choose between the Enhanced and Standard mode and then click Select Upload Method. 
 
 
 
 

 
 

Figure 4-32 
Upload Method 

 
 
 
 
 
 
Adding Images- Standard 

• In the Admin menu, click the Add Image to Local Image Gallery link. 

• In the new window, select Standard Mode, then click Select Upload Method. 

• Click Upload the image by clicking  Browse and locating the file on your hard drive.  
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Figure 4-33 
Standard Upload 

 

 
 
 
 
 
 

• Once you locate the image file, double-click the file the image will be uploaded into the 
gallery. 

• You have the option to click Done or to browse for more pictures.   

• Once you have uploaded all of your pictures, click Done. 

• A new window will open. From the drop-down menu, select the category where you 
want to place the item. You can also select Delete next to any of the image files you no 
longer want uploaded. 

• Click Done once you have organized your images. 
 
 
Adding Images - Enhanced 

• In the Admin menu, click the Add Image to Local Image Gallery link. 

• In the new window, choose Enhanced Mode, then click Select Upload Method. 

• To drag and drop files into this new window, you must open a file browser.  This can be 
done simply by opening the file or files where you store your images. 

• Drag the images you want to add from your file browser to the SchoolCenter Add Image 
Window. 

• You can choose to remove any of the files by highlighting the image and clicking 
Remove. 

• Click Done when you are finished adding your images. 

• Your images will be uploaded and you will be given another opportunity to delete any 
images you do not want to be added to your gallery. 

• Click Done to save your changes. 
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Chapter 5 - Site Administration 
To  

access the Site Administration page, click the Admin button located in the menu. Next, click any 
of the listed links to customize the system to your specifications.  Site Preferences allows you to 
choose exactly how you want your site set up. Site Preferences is where you choose options for the 
login screen, where you enable the profanity filter, and where you will set up terms and 
conditions.  
 

Site Preferences 
The Site Preferences option provides a list of options for customizing your system.  
 

Login Page Options 
This component allows you to either show or hide the "Remember Me" and "Lost Password?" 
features from the Login page.  These two options can be very helpful, but in schools with public 
computer access, using the "Remember Me" option is not advised for security reasons.  However, 
many people will forget passwords, or if the passwords are changed at regular intervals, people will 
find the option of retrieving a password on the login screen very valuable.   
 
 
 
 

Figure 5-1 
Login Options 

 
 
 
 

Desktop Settings 
This component allows you to remove user access to certain types of webpages. You have the 
option to hide the public sites and support buttons for users who do not have edit access or for 
everyone.  These options allow you to determine how much you want certain users to see 
depending on their edit access to your site. 
 
 
 
 

Figure 5-2 
Desktop Settings 

 
 
 

 
 
 

 

You may want to hide the support buttons, which link to the SchoolCenter Support 
site, if your school chooses to create its own documentation for the system.  

 
 

 
 
 
Edit Mode 
The Edit Mode option allows you to choose how you want the edit mode options to appear on your 
site.  Legacy Edit Mode keeps the Edit Mode functioning as it always has with the edit buttons 
appearing on the page.  User Selectable allows users to choose between Legacy Edit Mode and 
New Edit Mode in the Preferences tab located in the Login Information Edit options.  New Edit 
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Mode places the edit options in context menus and drop-down menus.  
 
 
 

Figure 5-3 
Edit Mode Options 

 
 
 
 
 

Web Users 
You have the option to choose between enabling web users or disabling web users.  If you choose 
Web Users enabled, different pages throughout your site, including Blog, Forum, Guestbook, Photo 
Album, and Document Manager will allow web users to create an account and post comments.  If 
you choose this option you have the option of adding an email address.  Notifications 
of web users needing approval will be sent to the email address provided.  If you choose Web Users 
disabled, web users will not be able to post comments. 
 
 

 
Figure 5-4 
Web Users 

 
 
 

Hit Counter Exclude 
This option allows you to exclude certain IP addresses from being counted in the Home Page’s Hit 
Counter.  For instance, blocking out your own IP address or a user that updates or views the site 
daily will keep these hits from being counted along with those of your target audience.  
 
 

Figure 5-5 
Exclude IP Address from Hit Counter 

 
 
 
 

Web Stats 
This option allows you to exclude certain IP addresses from being counted in the Home Page’s Hit 
Counter and the Web Stats Report.  For instance, blocking out your own IP address or a user that 
updates or views the site daily will keep these hits from being counted along with those of your 
target audience.  
 

 
Figure 5-6 
Web Stats 
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Profanity Filter 
If you select Enable profanity filter for web content, the Profanity Filter will be activated. 
 Enabling the profanity filter is generally a good idea if you want to make sure that no profanity is 
posted anywhere on the site, even accidentally. 
 

 
 
 
 

Figure 5-7 
Profanity Filter 

 
 
 

 

Enter the email address of the person who will be monitoring the site for profanity (often the Main 
Site Administrator). Any profanity used within the system in a text box, user name, or file name 
will cause an email notice to be sent out. In addition, the word will automatically be replaced with 
***** and the user will be logged out.  
 

 

For more information, view Profanity Filter – Word List and Profanity Report. 

 

Disable Chat 
This feature allows you to disable chat by group access level, which will prevent certain users from 
using SchoolCenter’s Chat. By allowing specific groups to use the chat feature, you can have 
teachers and administrators chat with each other but not allow students to chat. Since chat is 
faster than email, many schools find it useful. 
 

 
 
 
 

Figure 5-8 
Disable Chat 
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Terms and Conditions 
If you select the Terms and Conditions option, all those wanting to view the site must agree to 
your terms and conditions prior to be allowed entry to the site. This feature will allow you to set 
up rules of conduct for all those entering the site, such as acceptable site content, copyright 
infringement warnings, site policies, or anything else you want visitors of your site to know prior to 
logging in. 
 
Once you have customized the site preferences, click the Save Site Preferences button located at 
the bottom of the screen to save the changes and to put them into effect for the site. 
 

 

You must save your changes before you leave the Site Preferences page. 

 
 

 
 
 
 

Figure 5-9 
Terms & Conditions 
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Password Restrictions 

 
Password Restrictions 
This option allows you to change the password settings for your site so you can increase or 
decrease security of passwords based on your district or school's needs.  
 

Maximum Password Age 
This setting allows you to set the length of time you want before your passwords expire. 
 
Password Never Expires. Choose this option if you want to set the passwords in the system to 
remain in place indefinitely. 
 
Expires in __ Days. Choose this option if you would like the passwords to expire periodically so 
that new passwords must be chosen. You can select the number of days between password 
expirations from the drop-down menu. 
 

 

If you choose to allow passwords to expire, you may want to change your 
Password Uniqueness settings. 

 

Minimum Password Length 
At Least __ Characters. You can require that any password chosen must contain at least a 
certain number of characters. That number can be selected from the drop-down menu. 
 

Password Uniqueness 
Do Not Keep Password History. Old passwords will not be remembered with this option, which 
will allow previously used passwords to be repeated.  
 
Remember __ Passwords. This option allows the system to remember a certain number of 
passwords.  Select the number you want from the available drop-down menu.  This option will 
not let a password be re-used until this number of passwords has been counted. 
 
Passwords must contain both numbers & letters. This option requires that passwords must 
contain numbers and letters. 
 
When you have customized all preferences, click Save to save your changes. 
 
 
 
 
 
 
 
 

Figure 5-10 
Password Restrictions 
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Message Multiple Users 

 
Message Multiple Users 
The Message Multiple Users feature allows you to easily send a mass email to all or some of 
your users. This component is useful in letting different groups know about upcoming events 
and meetings. You will find it is also a useful tool in sending out announcements. 
 
Once you click the Message Multiple Users link, you will see a Compose screen where the From 
field is already filled out and the To field contains a listing of users by groups and by categories.  
This field also has an All Users option, which will include everyone in the site with a User ID.  
 

 
 
 
 
 
 
 
 
 
 

Figure 5-11 
Message Multiple Users 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• Select the groups and categories that you want to receive the email. You may select 
multiple choices.  

• Once you have finished typing the subject and the message for the email, click Send 
Messages.  

 

 

The email address where the message will be sent to is the  
address placed in the User Info. 

 
Your message will automatically be sent to all users in the groups or categories you chose. 
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Global Messages 

 
Global Messages 
By using the Global Messages feature, you can post messages in certain areas on the site for all 
users in selected access levels. This can be useful in giving announcements to a large group of 
people simultaneously. You can announce upcoming holidays, parent teacher conferences, 
school events, or make any other announcement.  
 
 

 
 
 
 

Figure 5-12 
Global Messages 

 
 
 
 
 
 

 
 

• Begin by clicking the Add New Global Message link.  
General 

• Under the General tab, select the access level group that you want to receive the 
message from the Show For drop-down menu.  

• Type the title for the new message in the Title field. 

• Type your message in the Message text box. 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-13 
Global Messages 

Window 
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 If you prefer, you can also use the Advanced Content Editor (ACE) to create the 
message. For more information on using the ACE, see Adding Text and Advanced 

Content Editor. 

 

• When your message is ready, you can then choose whether or not you would like to 
display the message on the Start Page, as a footer on all pages, on the Login Page, on 
the district/school Home Page, or on a combination of these choices. 

Styles 

• Click the Styles tab to choose the alignment, font size, and font color. 

• Select the Border box to open the border options.  Choose the desired border color 
from the Color Picker and border size from the Size drop-down menu.  

 
 
 
 
 
 
 
 
 

 
 
 

Figure 5-14 
Color Picker 

 
 
 
 
 
 
 
 
 
 

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking the desired 
color’s circle. You will see your choice appear in the Color box. 

• Once you are finished, go back to the General tab and select the Make this message 
active box to activate the global message.   

• Click Done.  

• Active global messages will have a green check mark located to the left of the message 
name.  Inactive messages will have a red circle. 

 

 

Only one global message can be active at one time. 

 
Your global message is now set to appear before your selected users and on the page you 
choose. 
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Edit Site Footer 

 
Edit Site Footer 
With the Site Footer, you can create a text message that will appear at the bottom of every 
page in your district. For example, you can put in your district or school address, telephone 
number, or other contact information so that every page of your site has this information.  
 

• Click the Admin button on your Desktop and click the Site Footer link.  

• Type the information you want in the text area and customize the text and appearance 
with the options below. This works the same way as the Advanced Content Editor, 
covered in detail in Chapter 7 - Editing Your Webpage. 

• In the Text Style box, you can choose the alignment, size, font color, whether to bold or 
italicize your text, and to make your text HTML friendly. 

• Select the Border box to open the border options.  Choose the desired border color from 
the Color Picker and border size from the Size drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 

• When you are finished, click Save.  Next, click Done. 
 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-15 
Edit Site Footer 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 

The text you have entered will now appear as your district’s site footer. 
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Edit Meta Tags 

 
Edit Meta Tags 
This option allows you to add keywords and phrases to your website’s meta tags for Internet 
search engines. If these words are typed into the search engine, the search will include your site 
in the results. You can enter words such as your school's name, your sports team's name, or any 
other term you think someone who is interested in your site might look under. 
 

• To view the Edit Meta Tags, click Edit Meta Tags.  

• In the Keywords text box, type key words and phrases, separated by commas, that 
might be used to search for your website.  

 
 
 
 
 
 
 
 

Figure 5-16 
Edit Meta Tags 

 
 
 
 
 
 
 
 
 

 

• In the Description box, type a description for your website. The description will be 
shown with the site link when the search produces your site in a listing. 

 

 

Adding Meta Tags to your site will not automatically register your site with 
search engines. However, if you do register your site with a search engine, you 

must have these Meta Tags filled out.  
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Profanity Filter Word List 

 
 

Profanity Filter – Word List 
You can view, add to, or delete from the Profanity Filter word list. This list contains all the 
words that the system will automatically view as profanity when entered in a text box or as part 
of a user name or file name.   
 

• To view the words in the Profanity Filter, select a letter or number to display the words 
in that section.  

• You have the option to delete any word that is in the Profanity Filter by clicking the 
Delete icon that appears at the left of the word. 

 

• To add words to the Profanity Filter, click Add Word. 

• Type the words you want to add. 

• Click Add Word. You will then receive a confirmation message stating that SchoolCenter 
has been notified of your requested addition. 

 

 

For more information on the Profanity Filter and text that has been marked as 
profanity, go to Reports and click the Profanity Filter link.  

 

Restrict File Types By Group 
Use the Restrict File Types option to block specific user categories from uploading certain file 
types through the system.  
 

• Choose the group you would like to place file restrictions. 

• Click the Edit icon located to the left of the group listing.  

• Delete (none) from the File Restrictions text box.  Type the file extensions you want to 
block, making sure to separate the listings by commas.  

 
 

 
 

Figure 5-17 
File Restrictions 

 
 
 

• Click Done. The file restrictions you have set will show in the far-right column in the list 
of groups.  

 

 

File extensions that are often blocked include .mp3 files and .avi files. 
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Truncate Users By Expiration Date 

 
Truncate Users by Expiration Date 
The Truncate Users by Expiration Date option allows you to delete users by using their 
password expiration date as criteria. This option is helpful for students who will be graduating, 
teachers who are retiring, or any other users that have a specific date when they will no longer 
be using the software.  
 

• You will need to determine the date range by choosing a From date and a To date.  You 
can either type the dates or select them from the Date Picker icon located to the right 
of each text box. 

 
 

 
 
 
 
 
 

Figure 5-18 
Truncate Users 

 
 
 
 
 
 
 
 

• Once you have the dates in place, click Truncate. 

• Click OK to continue. All users whose passwords will expire between the specified dates 
will be listed below.  

• To delete these users, click Yes, I'm Sure.  

• To reset the date criteria, click No, Go Back. 
 
You should now have your site utilities set to your preferences. For more information about Site 
Administration issues, including Image Utilities, see the Desktop Management section of this 
manual. 
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Font Management 

 
Font Management 
In the Font Management Utility, the Main Site Administrator can select font styles to remove 
from user selection.  The available fonts are listed under Font Management. By clicking the box 
located to the left of the font, you are selecting the font or fonts you want excluded from the 
entire site's Font drop-down menu. This feature can give your site a more uniform look and can 
be used to select fonts that show up better on your site background. 
 
Arial, Helvetica, and Verdana are the three fonts highlighted in gray,.  These three fonts are 
considered to be the three best fonts for viewing webpages.   
 
When you have completed selecting the fonts, click Save Fonts.  The fonts selected will now be 
removed from all font drop-down menus within the SchoolCenter software. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-19 
Font Management 
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Themes Management 
SchoolCenter Themes Management allows you to choose which themes you want to be made 
available throughout your site.  In Page Design, the Themes option allows for pre-made page 
themes to be implemented in your site.   
 
Enable Page Design Access allows users to access Page Design so they can make changes to sites 
or pages in which they have edit access.   
 
Disable Page Design: Only allow access to SchoolCenter themes and District layouts will allow 
users to only access themes and districts layouts.  This option gives your district or school sites 
and pages a uniform appearance. 
 
Disable Page Design: Only allow access to District-provided layouts allows users to only use 
layouts provided by the district.  With many districts and schools using Rapid Design for custom-
made sites, this option enables districts to have all sites and pages uniform in design. 
 
There are some themes that may not go well with your district or school's design.  If there are 
themes you do not want used in your school or district, you can disable them in this screen. 
 

• After clicking Themes Management, click the button next to the level of page design 
access you want implemented throughout your site. 

• Click the themes you want disabled.  If you are uncertain what a theme looks like, simply 
click the theme name to see it. 

• When you have finished making your selections, click Save Settings. 
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Admin Reports 

 
Admin Reports 
Valid Upload Filetypes 
Valid Upload Filetypes shows a listing of the different types of files you can upload using the 
SchoolCenter software.  The files types are listed within their categories.  The categories are 
Document, Video, Image, Executable, Audio, and Archive.  

 
 
 
 
 
 
 
 
 
 
 

Figure 5-20 
Reports 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
User Access Lists 
 
The User Access List is a simple and easy way of searching for users within the school district. 
This report allows you to search for a user by last name to see what sections or pages this user 
has access to. This is available only to Site Administrators.   
 



Webtools Manual 

58 

 
 
 
 
 
 
 

Figure 5-21 
User Access List 

 
 
 
 
 
 
 
The Basic and Advanced mode are the two ways you have to view the User Access List. The 
report shows you the user’s last and first name, user name, group level of access, and 
information options. Click the plus sign icon or the [expand all] link to see the access list for 
the user. 
 

 

If a user doesn't expand, this means that the user has yet to be assigned to edit 
any sections/pages. 

 

Export Student Hashes 
The Export Student Hashes feature is used with Grades Online and allows users with this 
permission to export all student hash codes at one time. Hash codes are passwords used so that 
parents can log in and see their child's grade information.  
 
To send a Hash Code Report, click Reports and select Export Student Hashes. Next, click the 
Send Comma-Separated Export Now link. This will send the hashes to the email of the person 
logged in, and you will receive a confirmation message that the file was sent. The hash codes 
will be in a password-protected .zip file that can be unzipped. 
 
 

 

If the district or school email system does not allow .zip files to be sent via 
email, SchoolCenter can change the file extension. Please contact SchoolCenter 

Support for more information. 

 

Export Raw Grades Data 
This feature is used with Grades Online and allows users with this permission to export all 
grades at one time.  
 
To send a Raw Grades Data report, click Reports and select Export Raw Grades Data. Next, 
click the Send Comma-Separated Export Now link. This will send the grades data to the email 
of the person logged in, and you will receive a confirmation message that the file was sent. The 
grades data will be in a password-protected .zip file that can be unzipped. 
 

 

If the district or school email system does not allow .zip files to be sent via 
email, SchoolCenter can change the file extension. Please contact SchoolCenter 

Support for more information. 

 

Full Grades List 
The Full Grades List allows those with access to view all the uploaded grades information 
online.  
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Chapter 6 - User Management 
Adding Multiple Users 

 
Adding Multiple Users 
To save time, or if you are dealing with a large number of users that need to be added into the 
system, you can import users by mass uploading your users from a comma-delimited file. You 
can use any comma-delimited file you have, but if you are not familiar with creating CSV 
spreadsheets in Microsoft Excel, follow the instructions below. If you are familiar with this 
process, follow the manual as it picks up after the creation of the spreadsheet.  
 
 
 
 
 
 
 
 
 

Figure 6-1 
Mass Upload Templates 

 
 
 
 
 
 
 
 
 
 
To Create a CSV Spreadsheet in Microsoft Excel  

• Click the Support button located at the top of the page to go to the SchoolCenter 
Support Site.  

• Click the Mass Upload Templates link on the Component Features page or homepage. 

• Choose the user upload template by clicking the User Template link in the table.   

• The User Template will download a file that has sample data in it. Highlight the data 
and delete it, then enter your users’ information and save the file on your computer.  

 
 

 

You will need a separate file for each type of user or category (for example, 
student email and teacher email) you want to upload. 

 
 

Import Users  
The Import Users tab allows administrators to mass upload users and create user ID's. The mass 
upload option is helpful for districts and schools with large numbers of users. 
 
To use the mass upload option, you will first need to fill out the Mass Data Upload Template. 
This template is a spreadsheet that can be downloaded from the SchoolCenter Support & 
Service site. 
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Be sure to save the template file as a Comma-Delimited (.csv) file. 

 
 
 
 
 
 
 
 
 
 

Figure 6-2 
Import 

 
 
 
 
 
 
 
 
To mass upload users, click  User Editor and select the Import Users tab. In the new window 
that opens, you will see that Comma-Separated has already been selected for you.  

 

• Click the Import User tab, then click Browse to search for the saved .csv file. 

• Once you have found the correct file, click the file name, then click Open. The file 
should now show in the Browse window.  

• Click the Upload File link. 

• When the file is uploaded, the field descriptions from the file are listed on the left side 
and the SchoolCenter field names are listed in the middle. Now, you can match your 
field names with the SchoolCenter field names. 

• Click Upload File to upload the file for mass upload. 
 

 

We recommend uploading files from a floppy disk to the hard drive before 
uploading. 

 

• The next step is mapping the data from the Source box to the Destination box. Highlight 
the matching items and click Map Field. The mapped view will display the items that 
you matched.  
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Figure 6-3 
Map Field 
Window 

 
 
 
 
 
 
 

 
 

To match the fields  

• Click User Name in the left-hand box.  

• Click User Name in the middle box.  

• Click the Map Field link located below the middle box.  

• When you have marked these, the right-hand box will show the mapping details. Repeat 
this procedure until all the fields are mapped correctly.  

 
 
 
 
 
 
 
 
Figure 6-4 
Field Mapping 

 
 
 
 
 
 
 
 
 
 

• If you have titles for your fields, you can select the Skip this record link so the titles 
are not uploaded as users. 

• Click the arrow to the right of the Skip this record link. Now your first record will show 
in the right-hand box.   

• Click the Continue link. 

• You will be asked if you want to save a map of your file. Click Yes to continue. 

• Now you may choose the type of user. You can also at this time mark the user category, 
if necessary, and any user options.  

• Click the proceed with import link to upload your users. 
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Figure 6-5 
Select User Options 

 
 
 
 
 

 

Once you have completed the upload, a report of successful users added as well as any rejected 
records will show.  
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Figure 6-6 
Completed Upload 

 
 
 
 
 
 
 
 
 
 

 

Rejections will occur if you have duplicate user names, student ID's, or if you are 
missing required information. 

 
Imported and Records Skipped are shown.   To continue, you can choose from the Undo the 
Import, Start a New Import or Close This Window options.  
 
After the import is completed, the new users must be assigned to areas to edit. For more 
information on this, see the Adding Users and Assigning Users sections of this manual. 
 
With the User Manager, you can add or delete users, change user information, or change a 
user’s level of access. You can manage users in either the Basic or Advanced modes by locating 
the user you want to manage through the Search function or adding a new user.  
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User Management 

 
The Main Site Administrator is chosen by each district as the person who will ultimately be in 
charge of the district or school's site.  The main site administrator, once chosen, is set up by 
SchoolCenter to control all aspects of the site, including users, content approval, access levels, 
and so forth.  
 
A Site Administrator helps the Main Site Administrator with various aspects of running the site, 
including setting up users and approving pages.   
 

Adding Users to the System 
You can add users to the system by clicking User Editor located just below the blue date and 
time/Organizer bar. 

 
 
 
 

 
Figure 6-7 
Access Manager 

 
 
 
 

 

• To add a single user, first click the User Manager tab. You have the option to use the 
Basic or Advanced mode.  For the purposes of this documentation, you will use the Basic 
mode.  

 
 
 
 
 

 
 

Figure 6-8 
User Search 
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Add a Current User 
 

To Add a Current User 

• To add a user who is already signed up with SchoolCenter, add the user’s first or last name 
and/or their user name. 

• Click Search. 

• When you see the listing for the person you want to add, click the listing to add that user 
to the system. 

 
To Add a New User 

• Click Add A New User to get started.  

• You will then add a user name in the box that appears in the pop-up window. 

• Click Next at the bottom right of the pop-up, which will take you to the User  Information 
window. 

• The fields marked with a red asterisk are required fields. Enter the information you want 
to add.  

• Choose a password for the new user. The password must contain a combination of letters 
and numbers. Once you have selected a password and typed it in the New Password field, 
you will re-type it in the Confirm New field text box to verify the password. For more on 
changing a password, see Chapter 7 - Desktop Management. 

• Click Done. 
 

 

To bypass typing in an email address for a specific user, the "@" symbol 
substitutes for an email address. 

 
User Manager 

• Enter the first and last name and email address for the new user. 
 
 

 
 
 
 
 
 
 
 
 

Figure 6-9 
User Editor Window 

 
 
 
 
 
 
 
 
 

 

The following is a list of characters that cannot be used within a User ID. 
 ' " ~ ` ! @ # $ % ^ & * ( ) = + [ ] | ; : / ? > < 
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If you do not know the email address of the user, you can, as an alternative, add in 
the @ symbol, which will satisfy that required field.  

 

• Type the password for the user in the Password text box.   

• Re-enter the same password in the Confirm New field. (As there are more steps to follow, 
do not click Done yet.) 

Access Info 

• This section provides the opportunity to give edit/view privileges, to remove user access 
from pages, and to delete users from your site. SchoolCenter access levels are designed so 
that, regardless of the access level that you are assigned, you can add, edit, and delete 
users in the levels below your level of access.  

• Click the Access Info tab to choose the level of access you would like to assign to the user. 
  

• To select the level of access for the user, click the Access Level link or click the colored 
box located to the right of the Access Level link.  

 
 
 
 
 
 

 
Figure 6-10 
Access Info 

 
 
 
 
 
 
 
 
 
You have different levels of access that you can assign users: 
 
Site Admin: This level of access is granted to the main site administrator and site administrators. 
Generally, these are the users who monitor the website. These users can include such users as 
tech coordinators, site managers, and technology directors. Site Admin users, by default, have 
access to any portion of the website. 
 
Lead Tech: This level of access is mainly reserved for the website managers of each school. 
Generally, these users will be the main website contact and managers of the school’s website. 
Lead Tech users, by default, have access to any portion of the site. They can, however, be added 
to a single school and be kept within that school. 
 
Section Admin: This level of access is usually reserved for teachers or any other person to whom 
you want to grant editing access confined to a specific section (classroom, club page, PTA page, 
etc.). By default, Section Admin users have view-only access when not added to a specific portion 
of the site. Once they are assigned to a certain section, you can change their edit access to grant 
them edit rights. 
 
View Only: This level of access is reserved for users with access to view password-protected pages 
but who do not have access to edit the pages. This is mostly used for students or restricted users. 
By default, view-only users have view-only access when not added to a specific portion of the site. 
Once they are assigned to a certain section, you can change their edit access to grant them edit 
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rights. 
 
Access Info gives you the following options: Disable Login, Disable Changing User Info and Bypass 
Desktop on Login. Teachers have the option to allow the user to upload grades.   
 
The final option in the Access Info tab is to expire the user's login on a specific date.  Simply 
choose the date you want the user's login to expire from the date picker. 
 

 

Each individual district or school determines the setup of each user’s access and 
privileges. The above assignments are only suggestions. 

 

You can also assign users to a custom group level of access. For more 
information on creating custom group levels, view the Groups Manager section. 

For more information on what level of access should be given to different 
users, see the Access and Privileges section. 

 
If you are granting Site Admin, Lead Tech or Section Admin access to the user, you will also have 
the Teacher Options for the Grades Online. 
 
If your school uses the Grades Online feature, select this option by selecting the Can Upload 
Grades box. This will assign the grades components into the user’s Desktop Organizer. 
 

 

For more information on the Grades Online feature, visit our Support and Services 
site and review the Reporting Grades section. 
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Other Info 
The third tab in the User Editor window is the Other Info tab. This is the area where users can 
enter in additional personal information that will be accessible to only those users that have Site 
Admin or Lead Tech access.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6-11 
Other Info Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

The fields listed under the Other Info tab are not required; however, if you are 
using the Grades Online feature, you may need to fill out the Student ID or Teacher 
ID fields. For more information on the Grades Online feature, visit our Support and 

Services site and review the Reporting Grades section. 
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Categories  
The Categories tab allows you to assign categories for your users. When your users are placed into 
categories, you can easily manage them, as you can search for specific users without having to 
display every user in the district. You can have a category for students, teachers, specific grades, 
extracurricular groups, or any other category you find useful. 
 

 
 
 
 
 

Figure 6-12 
Categories Window 

 
 
 
 
 
 

 

Categories are only available for users at the Site Admin access level. 

 

• To assign a user to a category, select the box located to the left of the category name. 
 Users can be in multiple categories. 

 

 

For more information on managing users within categories, see the User Categories 
section. 

 
Permissions 
In the Permissions tab, you can select specific pages where the user will have editing access. 
 Assigning different users editing access for different areas of your site will allow certain users to 
edit areas in which they are familiar without allowing them to edit everywhere within your site.   
 

• You can do this by either selecting the specific pages you want the user to have editing 
access to, or by choosing a group from the drop-down menu to automatically select pages.  

• Once you have the user’s account set up according to your preferences and have assigned 
the user’s access level, you will need to assign the user’s edit privileges.  

• Once you are finished using the options in the User Editor window, click Done. The user's 
information will be saved and added to your site.  

• If the information in any user’s account needs to be changed, click the Edit Info icon to 
open the User Editor window and make changes to the account. 
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Figure 6-13 
Permissions Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Edit privileges depend on what level of access is assigned to the user. Users assigned to Site Admin 
and Lead Tech access will automatically be given edit privileges. Users with Section Admin or View 
Only access will automatically be given View Only privileges.  
 
Preferences 
In the Preferences tab, you can choose how you would like your toolbar icons to appear.  You can 
choose between Text only or Icons and text. 
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Access Manager 

 
Access Manager 
The Access Manager allows administrators to manually add or remove users and to assign users 
to edit sections or specific pages.  This section provides the opportunity to give edit/view 
privileges, to remove user access from pages, and to delete users from your site. SchoolCenter 
access levels are designed so that, regardless of the access level you are assigned, you can add, 
edit, and delete users in the levels below your level of access.  
 
Assigning Users 
When you assign users to a specific section or page, there are two ways to navigate to the areas 
where users should be assigned. 
 
You can navigate to the section where you want to add the user and then click My Desktop. 
Next, you can click User Editor and select the Access Manager.  
 
The second option is to assign them directly from the User Editor.  

• When working in the User Editor, click the Access Manager.  

• Click the Go To Selection List link, where you will see a list of sections within your site.  

• Click the down arrows to expand your options.  

• When you have found the section where you want to add your user, click that link and 
you will be directed to the User Editor for that section. 

 

 
 
 
 
 
 
 
 

Figure 6-14 
Preferences Tab 
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Assigning Users to a Section 
When you first enter the Access Manager, you will see a blue bar. This bar states exactly where 
you will be giving the user access.  
 
“Full Site Access For:” This title refers to the section that is listed directly after the colon. This 
means that the user assigned here will have edit access within the entire section listed.  
 
To begin adding users, click the Add New or Existing User icon and follow the instructions on 
Adding Users.   
 

Assigning Users to a Page 
• To assigning a user for editing a specific page, expand the Choose a Page drop-down 

menu that is positioned above the orange bar.  

• When you expand the drop-down menu, you will see a list of the pages in that section.  

• From this list, select the page where you want to assign users. You will notice a new 
orange bar will appear below.  

 
“Limited Access For:” This preference refers to the specific page that is listed directly after the 
colon. When you add a user here, they will have access to only the listed page within that 
section.  
 
To begin adding users, click the Add New or Existing User icon and follow the instructions on 
Adding Users.  
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Adding Users 

 
Adding Users 

• To add a user, click Add User.  

• In the new window that opens, choose whether you would like to add a new user or 
assign an existing user to this area.  

 
To add an existing user  

• Select the existing user option.   

• Click Next.  

• To search for the user you want to add, type either the user’s first or last name or the 
User ID and then click Search.  

• You will receive a list of users that matches the name you typed. Select the user you 
want to add. 

 
To add a new user  

• Select the new user option and enter in the User ID you want to assign to this user in 
the text box provided. This will also be their Login ID.  

• Click Next.  From the pop-up window, you can fill in all of the user's information 
including User Info, Access Info, Other Info, Categories, Permissions, and 
Preferences.   

• You can edit this information for users already granted access simply by clicking Edit 
Info. 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 6-15 
Access Manager 

 
 
 
 
 
 
 
 
 
 
 
Edit Access 
To give a user the ability to edit, click the Edit Access icon located to the left of the User ID and 
then select either Edit privileges or View privileges. Once you have chosen your selection, click 
Done. 
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Removing Access 
To remove a user’s access from a section without deleting them from the section, click the Edit 
Access icon, and then click Remove Access.  
 
This will remove the user’s editing access to that section or page without deleting him or her 
entirely from the section or page. You can then assign the user a new area to edit.  
 
Deleting a User 

• To delete a user from your website, click the Edit Info icon located to the right of the 
user’s name to open the User Editor window.  

 

• Click Delete located in the bottom right of the window to remove the user from your 
website.  
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User Categories 

 
Groups Manager 
Along with pre-set groups such as, Site Admin, Lead Tech, Section Admin, View Only, and 
Teachers, you can create new groups.  Creating groups with edit access to specific pages within 
your site allows you to have different groups with varying levels of access.  This can be helpful in 
site management, especially for larger districts and schools. 

• To create a new group, click Add New Group. 
Info 

• In the pop-up window that opens under the Info tab, type the title of your group in the 
corresponding Title text box. 

• You can type a note about this group in the Note text box. 

• Next, assign this group either view or edit access by selecting the corresponding  button. 

• To assign this group a color, click the color box and choose the color you want to assign 
this group from the color picker. 

Permissions 

• Click the Permissions tab. 

• You can choose to populate the page permissions by choosing an already existing group 
from the Populate permissions from existing group drop-down menu. 

• Or, you can select the pages you want this group to access. 

• Once you have made your selections, click Done to save your changes.  The new group 
you have created will appear in the Groups Manager screen. 

 

User Categories 
Categories can be used to manage users more effectively. By placing users in multiple categories, 
you can quickly find the right user. Categorizing teachers, parents, administrator, and students 
can help in messaging specific groups.  For example, in a larger district or school, categorizing 
grade levels can be helpful.  For example, all students in grade 12 can be placed in one category 
so that graduation announcements can be messaged to them.  Once they have graduated, these 
same students can be then removed.   
 
Different categories can be given different permissions within the site.  This is discussed in detail 
in Chapter 5 - Site Administration.  
 
 

 
 
 
 
 
 
 
 

Figure 6-16 
User Categories 
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• To create a category, type the new category name in the New Category field. 

• Click Add New located to the right of the box. The category name will now appear in the 
table of categories for the district.  

 
 
 
 
 
 
 

Figure 6-17 
Manage Categories 

 
 
 
 
 
 

• To add users to this category, you can either upload the user and mark them during 
upload or click the Manage User Categories link and add existing users to categories 
within this function. 

 

Web Users 
The Web Users tab allows you to manage the non-SchoolCenter users who visit your site.  These 
users can be required to login to post comments on various pages throughout the site.  You can 
customize the Web Users login message by clicking Login Page. 

Login Page  
• Click Login Page. 

• In the pop-up window that appears, enter the information you want web users to know 
prior to logging in.  This can be any information you think is necessary, such as 
instructions on how to log into the site or other notices you want users to read before 
logging in. 

• You can use the Advanced Content Editor for advanced HTML editing. 

Register Page 
• Click Register Page. 

• In the pop-up window that appears, you can enter the text you want to appear on the 
registration page.  This can be information pertaining to logging in, logging in 
instructions, or any other information you deem pertinent. 

• You can use the Advanced Content Editor for advanced HTML editing. 

Successful Activation Page 
• Click Successful Activation Page. 

• In the pop-up window that appears, you can enter the text you want to appear on the 
successful activation page.  This can be information you deem pertinent to the successful 
activation page. 

• You can use the Advanced Content Editor for advanced HTML editing. 
 
You can also search for web users in this area by entering in their first name, last name, login or 
email address. 

• To edit a web user’s information, click the edit icon that corresponds to the user’s 
name.   

• In the pop-up window that opens, you can choose to enable or disable the web user. 

• You can also delete the user by clicking Delete. 

• To save your changes, click Done. 
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Figure 6-18 
Web Users 
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Email Manager 

 
Email Manager 
If you have the SchoolCenter Mail as part of your school’s software, you may also have an Email 
Manager button as one of your options. 
 
The Email Manager allows you to redirect emails from one account to another by using email 
Aliases and Forwards. It will also give you information on the email accounts in the system, 
including the numbers and types of the accounts.  

 
 

 

For more information about using the  
Email Manager, see the SchoolCenter Mail Manual. 

 

 
The Users category allows you to add, delete, manage, and organize users of your website. To 
access the User options, click User.  
 

 
 

 
 
 

Figure 6-19 
Access Manager 
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Chapter 7 - Editing Your Webpage 

 

 
When you are in Edit mode, you can add or delete pages from your site. To change to Edit mode, 
click Edit Page located at the top of the page. 
 
 
 
 

Figure 7-1 
Edit Drop-down Menu 

 
 
 
 

Adding a Page  
• To add a page to your site, click the Add a Page option in your Edit drop-down  menu. A 

new window will open with a menu of sections or page components you can add to your 
site.  

• Click the page you want to add.  

• Once your page is added to the site, the Page Settings window will open. Here, you can 
change your settings or click Done. These options vary depending on the type of page 
component you are adding. You can always change these options later by selecting Page 
Settings from the Edit Drop-down menu. 

• Click Done to finish adding your page.   
 
There is no limit to the number of pages you can add, and each type of page component can be 
added multiple times.   
 

 

For descriptions of the various page components, see the Page Components 
section. 

 

Deleting a Page 
• To delete a page on your site, click the page link you want to delete.  

• When you are on that page, click the Edit drop-down menu and the select the Page 
Settings option to open the Page Settings window.  

• Click Delete to remove the page from your site. After the page has been deleted, you 
will be redirected to the Home page of that section. 

 

 

If a page has accidentally been deleted, SchoolCenter has the ability to restore 
that page. However, SchoolCenter cannot restore content (text or images) that 

has been deleted from any page. 
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Edit Navigation 

 
Edit Navigation 
Within the Edit Navigation option, there are three ways of customizing your site’s navigation 
links. You can use Standard Navigation, Image Mapping, or Custom Navigation. 

• To access the Edit navigation window, click the Edit drop-down menu and select the Edit 
Navigation option. 

 

Standard Navigation 
The Edit Navigation feature is a way to customize your navigation links by choosing the order in 
which the pages are listed.    

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-2 
Navigation Editor Standard 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• To sort the links, make sure you are in Edit Mode by clicking Edit Page or choosing Edit 
Mode from the Edit drop-down menu.   

• Click the Edit Navigation option in the Edit drop-down menu. 
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• From the pop-up window, you can sort the links alphabetically by clicking Alphabetize.  
You can reverse the order of links by clicking Reverse, or simply drag and drop the pages 
where you want them. 

• After all changes have been made, click Done to save the settings and close the window. 
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Image Map Navigation 

 
Image Map Navigation 
With the Image Map, you can create a unique navigation using an image. You can use an Image 
Mapped Navigation by following one of two options:  
To Apply Image Map to One Page 

• Click the Edit drop-down menu and select Edit Navigation. 

• The Edit Navigation window will open.  Click the Image Map tab. 

• Choose Select Image Map Navigation by clicking the corresponding selection box. 

• A pop-up window will open asking if you are sure that you want to change your 
navigation to image map.  Click OK.  The navigation for this page will now be an image 
map. 

 
 
 
 
 
 
 
 
 
 

Figure 7-3 
Image MAp 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To Apply Image Map to Multiple Pages 

• Click the Page Settings option in the Edit Drop-down menu. 

• In the Page Settings window, click Page Design.  

• In the new window that opens, click the Advanced tab. 

• Click the Navigational (Sidebar) Type link.  A pop-up window will open. 

• Select the Image Map option, and then click Done.  
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This image should be of the site tier index or the 
design page. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

Figure 7-4 
Site Tier Index 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

• In the Site Tier Index on the right side of the page, select the pages you want to have 
this type of navigation.  

• Click Apply so that your changes will be applied to the pages you have selected. 

• Once you are back to your website, click the Edit Navigation option in the Edit drop-
down menu to open the Navigation Editor and map your navigation. 

 

 

For more on changing the layout in advanced Page Design, see the Advanced 
Page Design section. 
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• Upload a picture to use as your navigation by clicking the Add Media icon. Continue 
uploading a picture from the SchoolCenter Gallery, Our Gallery, or your local 
computer. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-5 
Navigation Editor - 

Image Map 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• Once the image is uploaded click Add Area. A mapped box will appear in the upper left 
corner.  

• Click the box, and the Navigation links will appear.  

• Select the page you want to map to from the tier index on the right.  

• Next, drag and resize the mapped box to the area of the image you want to link.  

• Click Save and the area will be linked to the page selected.  

• To add another area, click Add Area again and repeat the processes.  

• When all the pages are mapped to an area on the image, click Done. Your navigation 
will now display the Image Map to your pages. 
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Custom Navigation 

 
Custom Navigation  
The Custom Navigation allows you to choose multiple navigation for your page.  This area also 
allows Site Administrators to set the navigation for the entire site.  Site Administrators have the 
option to Enable District Defined Navigation.  If this option is checked by the Site 
Administrator, then the navigation throughout the site will be set by the Site Administrator and 
applied to the site. 

• Click the Page Settings option in the Edit drop-down menu. 

• In the Page Settings window, click Page Design.  

• In the new window that opens, click the Advanced tab. 

• Click the Navigational (Sidebar) Type link.  A pop-up window will open. 

• Select the Custom Navigation option, and then click Done.  

• In the Site Tier Index on the right side of the page, select the pages you want to have 
this type of navigation.  

• Next, click Apply so your changes will be applied to the pages you have selected. 

• Once you are back to your website, click the Edit Navigation option in the Edit drop-
down menu to open the Navigation Editor and group your navigation. 

 

 

For more on changing the layout in advanced Page Design, see the Advanced Page 
Design section. 
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Group Navigation 
 

Group Navigation 

• To group your navigation, you will need to create parent links. Click Add Parent and 
type the title of the parent link in the text box. 

• Choose from the drop-down menu whether you want floating or expanding groups. 
Selecting the Floating option will have your links floating off to the side when the cursor 
is hovered over the parent link.  Selecting the Expanding option will make the links 
appear underneath the parent link when the cursor is hovered over the parent link. 

 
 
 

 
 

Figure 7-6 
Parent Link 

 
 
 

 
 
 

 

• Click New to save the current parent link and add another parent. 

• Click Done to save the current parent link and return to the Custom Navigation window. 

• To group a page under a parent link, select the box next to the page title you want to 
place under the parent link and then click the black arrow to add it.  Once you place a 
page under a parent, that page will be italicized and gray. 

• To sort the order of the parent links, click Sort Nav while in the Navigation Editor. 

• You have the options to sort by clicking and dragging; to sort alphabetically; to sort in 
reverse alphabetical direction; or to revert to your original sort by resetting. 

 
 
 
 
 



Chapter 7 - Editing Your Webpage 

89 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-7 
Custom Navigation 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Standard Navigation 
If you want standard navigation in multiple locations, you can customize where you want the 
navigation to appear by clicking the following tabs: Top, Right, Bottom, and Left.   

• When you click the tab, you can add pages by clicking the box next to the page on the 
left and then clicking the black arrow.   

• This will add the pages to the navigation location of your choice. 
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Figure 7-8 
Group Navigation 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
For grouped navigation on the top or bottom side of the page, follow the procedures for grouped 
navigation by clicking Add Parent.  

• For grouped navigation on the right or left side of a page, click  Add Parent. This will 
open a new window asking for a Parent name. This is the same procedure for grouped 
navigation.   

• Select the Nav type drop-down menu button and choose either Floating or Expanding. 
Floating navigation has the various pages listed to the side of the parent when the cursor 
is hovered over the parent link.  Expanding navigation expands downward in a list when 
the cursor is hovered over the parent link.  

• Choose the type you prefer.  This choice will affect both the left and the right side of the 
page.   

• Select the Offset drop-down menu button and choose the amount of indentation you 
want for the grouped navigation menu. 

• Click Save and this will take you back to the Edit Nav window.  The different web pages 
will be listed on the left and the parents will be listed on the right.   

• Just as in grouped navigation, click the boxes of the pages you want for a specific 
parent. 

• Click the button next to the parent. 

• Click the arrow to add the pages to the parent. 
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To edit your floating or expanding option, change the parent name, or delete the parent, you 
can click the pencil icon located next to the parent name.   If you want to delete all of the 
parents, click Delete all located on the bottom of the page.  This will delete all of the parents 
and allow you to start over. 
 

• Once you have finished selecting different options in Multiple Navigation, click Save to 
get back to your page.   

• To see the changes, click View Page located at the top of the screen. 
 

 

 It is necessary to take into account the page width if choosing to have both left 
and right navigation.  The page width may need to be smaller to accommodate 

multi-navigation on both sides. 
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Edit Mode/View Mode 

 
Edit Mode/View Mode 
SchoolCenter has two modes to view your pages: Edit mode and View mode.  
View mode allows you to see what your page looks like publicly. In this mode, your site will 
display as it would to those not logged into the site. To see View mode, click View Mode or 
choose Switch to View Mode from the Edit drop-down menu. 
 
When you first log into your site, you will be in View mode.  
 
To begin editing your site, you will need to be in Edit mode. To get into Edit mode, click Edit 
Mode or choose Switch to Edit mode from the Edit drop-down menu.  In Chapter 5 - Site 
Administration, you are given the option of choosing the type of Edit Mode for your pages: 
Legacy, User Selectable, or New.   
 
If you chose Legacy Edit Mode in Site Preferences, edit buttons will also appear on your pages. 
 
If you chose New Edit Mode, the buttons will not appear on your pages automatically.  The Edit 
icon will appear when you hover the cursor over the edit field.  If you click the Edit icon while 
you are hovering the cursor over it, you will be given a drop-down menu with editing options.  To 
edit the field, simply choose from the drop-down menu. 
 

• To add text to your site, click the Edit icon if in Legacy Mode.  If you are in New Mode, 
click the Edit icon and select Edit Content Box from the drop-down menu.  Your edit 
page text window will open.  

 
 
 
 
 
 
 
 
 

Figure 7-9 
Text Window 

 
 
 
 
 
 
 
 
 

• Type or cut-and-paste your text into the large text box. 

• To create a link or an email link in your text, you can type the Internet address or email 
address (schoolcenter.com), and your text will automatically turn into a link. 

Styles 

• Click the Styles tab to choose the alignment, font size, and font color. 

• Click Done when you are finished. 
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Figure 7-10 
Styles Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Under the Styles tab, you can choose box options such as borders and background colors to give 
your page and text boxes a distinctive look. Changing box options can be accomplished by 
clicking the Edit icon when you are in edit mode. 
 
Box Options 

• To add a border or background color to your text field, click the pencil edit icon to open 
the Edit Page text window if in Legacy Mode.  If you are in New Mode, click the edit 
icon and choose Edit Box Content.  

• From the pop-up window, choose the Styles tab. 

• To choose the color for your border or background, click the empty Color square to open 
the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 

• Select the Border box to open the border options and choose the desired border color 
from the Color Picker and border size from the Size drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

In the Newsletter component, you can also choose to Use Image as Background.  This option 
allows you to have the image you have chosen used as a background image.  By clicking the box 
next to the Tile Background, the image will be replicated as tile.  The tiled background will be 
visible once you click the view page options, but not while in Edit Page mode. 
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The  option is designated transparent or No Color. 
The Border and Background colors are only available in the Advanced Mode. 

 
Attach Items 
To attach a link or file to your text field, click the Attachments tab. You have two methods to 
add attachments to your page. Enhanced Mode will let you select multiple files to upload to the 
image gallery by simply dragging and dropping the files you need from your file browser. 
Enhanced mode uses Java™, so if you do not have the Java™ feature enabled, you cannot use the 
drag and drop feature. 
 

• Choose between the Enhanced and Standard mode and then click Select Upload 
Method. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-11 
Add Image & 
Attachments 

 
 
 
 
 
 
 
 
 
 
 
Adding Attachments 

• Upload the file by clicking Browse and locating the file on your hard drive.  

• Once you locate the file, double-click the file and it will be uploaded into your page. 

• A new window will open allowing you to accept the file you have uploaded by clicking 
Done, or letting you delete the file if you no longer want it uploaded to your page. 

 

 

There is a file size limitation of 10mb. 

 
Adding Links 

• Click the add a link button. 

• From the drop-down menu, choose the correct prefix for your link (Http, https, ftp, 
mailto, etc). 
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• Type the address you want to link to in the Link box.  

• Select Open in a new Window if you want your link to open in a different window.  

• When you have finished, click Done to save your settings and return to your site. 
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Advanced Content Editor 

 
Advanced Content Editor 
When adding text, you have the option of formatting with the Advanced Content Editor (ACE). 
ACE is an HTML editor that enables you to format your text.  ACE allows users who are unfamiliar 
with HTML to create a dynamic website with customized text, links, images, and other options. 
The ACE window is known as a “What You See Is What You Get” or a WYSIWYG window.  The 
changes you make to your content will appear in the WYSIWYG window.   
 

• To open this option, click the Advanced Content Editor button in the Edit Text window.  
 
With the ACE, you can customize your text without the knowledge of HTML. You can also source 
images and text that appear on other Internet websites by copying and pasting them into the 
ACE. 
 

 
 
 
 
 
 
 

Figure 7-12 
Advanced Content Editor 

 
 
 
 
 
 
 
 
 
 
 

 

To learn what each button will do, hover your cursor over the button and a 
description will appear below the toolbar.  

 
Most of the options in ACE are straightforward options, such as Bold, Italics, Underline, Spacing, 
Right Justification, Font Options, Subscript and Superscript.  However, there are a few options 
that might not be familiar to you. 
 

Insert/Edit Link 
• To insert a link, highlight the word or phrase you want to make a link.   

• Click Link.  A pop-up window appears where you can type the web page address.  You 
can name this link whatever you like or leave that option blank.  
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Figure 7-13 
Insert Link 

 
 

 
 
 
 

 

• You are then given several options on how the link will open.  Select the button next to 
the option you want.   

• When you are finished, click Insert to have the link inserted. 
 

Insert/Edit Anchor 
Anchors are used to help navigate a web page.  You can set up anchors to link to any point on the 
page.  Many use this feature to link to the top and the bottom of the page.   
 

• To set up an anchor, first highlight the word you want to be the link to the anchor.   

• When the dialogue box asks for the web address, type the # symbol followed by the 
anchor name you have chosen and then click Insert.   

 
 
 

Figure 7-14 
Insert Anchor 

 
 
 

• Next, go to where you want the anchor, highlight the text, and click the anchor icon.   

• When the dialogue box opens, type the anchor name.  The anchor name will be the same 
word used in creating the link.   

• Click Save. 

• Click Done to save your changes. 
 
 

Additional Inserts 
Inserting the date and time is easy in ACE and can be accomplished by clicking the date or the 
time icons.  Sometimes it is necessary to use symbol rather than a letter or a number, as in cases 
of copyright and trademark symbols, or other frequently used symbols. 
 
If a specific symbol needs to be added, this symbol can be chosen by clicking the symbol button. 
 A window with many symbols will open and the symbol you need can be chosen by clicking it 
once.   
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Figure 7-15 
Insert Symbols 

 
 
 
 
 
 
 
 

Inserting a Table 
You need to have a specific idea of what type of table you want prior to creating it.  

• To Insert a Table, click Insert a New Table.  

• Enter how many rows and columns you want for the table.  

• When you are finished entering in your table properties, click Insert.  

• When you select your table, you will have other editing options. You can enter in text as 
well as insert a picture into the table. 

 
 
 
 
 
 
 
 
 

Figure 7-16 
Insert Table 

 

 
 
 
 
 
 
 
 
 
Once you have created your table, you have many different options for managing it.  You can add 
rows and columns or delete them.  You can choose to merge cells or split them.  If you want to 
see the outline of your table, click the Toggle Guidelines/Invisible Elements.  This will show you 
the formatting outline for your content and not just for your table. 
 

Insert an Image 
• To insert an image, click Insert/Edit Image. The Insert/Edit Image window will open.  

• You can click the +add button to add an image or list the URL of the image.  

• If you click the +add new image icon, the Upload New Media window will open. Add an 
image from one of the galleries or from your hard drive by choosing the appropriate 
option.  

 
 
 



Chapter 7 - Editing Your Webpage 

99 

 
 
 
 
 
 

Figure 7-17 
Insert Image 

 
 
 
 
 
 

• You have the options of adding a description and title to the image as well as changing 
the dimensions and border size of the Image.  

• Select an alignment for the image from the drop-down menu that will work best for your 
content. You also have the option to change the vertical and horizontal space for the 
image.  

• When you have finished setting your preferences for the image, click Insert. 

 
Find/Replace 
The Find/Replace option will let you find words and replace them with other words.   

• Click Find/Replace and in the new window that opens, type the word you want to find 
next to Find What.  Type the word you want to replace it with next to Replace With.   

• You can then go through your content and choose which instances you want to replace a 
word. 

 
 
 
 

 
Figure 7-18 
Find and Replace 

 
 
 
 
 

Edit HTML Source  
Clicking the Edit Html button allows those users familiar with HTML to see the coding for their 
content.  They can then edit the code in the edit HTML window.   
 

Clean-Up Messy Code 
Sometimes it is more expedient for users to copy content from a website or from a word 
processing program and then paste it into ACE.  Occasionally,when this occurs, the formatting is 
either in a different language than HTML or certain formatting options were chosen that are not 
necessary or applicable in the SchoolCenter software.  When this occurs, you can simply highlight 
the text that has been pasted and then click the Clean Up Messy Code option.  This will change 
the formatting to HTML so that when you save it, your content looks the way you want. 
 

Remove Formatting 
If you want to change the look of your content without losing the information, highlight the 
portion you want to change and then click Remove Formatting.  This will remove any formatting 
for the font and the background.  Links and anchors will remain and so will images. 
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New Document 
You have the option to erase your text at any time by clicking New Document.  The New 
Document feature deletes the current content, but lets you know beforehand so you do not 
accidentally erase content.  If this is done in error, you can fix it by clicking  Undo. 
 

Print 
You also have the option to print out the text by clicking Print.  
 

Save 
When you have finished customizing your text, click Save. Your text will be translated into HTML 
and placed into the Edit Page text box.  The option, Make Text HTML Friendly will be 
automatically checked. 
 
 

 

The Advanced Content Editor is not compatible with all browsers. Please contact 
SchoolCenter Support for more information. 
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Images 

 
Images 
There are multiple ways to find an image in the SchoolCenter software. You can upload an 
image from your computer’s hard drive, from Our Gallery, from the SchoolCenter Image Gallery 
or from your Personal Gallery.   
 

• To add an image to your site, click the Add Image icon if in Legacy Mode.  You can also 
click the edit icon and choose Add Image from the drop-down menu. A new window will 
open, allowing you to upload your image. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-19 
Upload Media 

 

 
 
 
 
 
 
 
 
 
 
 
Local Machine 

• You can browse for the image you want to upload from your computer’s hard drive by 
clicking Browse. You will be directed to the hard drive on your computer where you can 
search for the image file. 

• Select the file you want to upload and click Open. 
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• Click Upload File. 
 

 

We recommend transferring files on a floppy disk to the hard drive before 
uploading. 

 
SchoolCenter, Local Gallery or Your Personal Gallery 
The SchoolCenter Gallery contains images provided by SchoolCenter. The Local Gallery is 
designed to store images that will be available to people within your district or school.  The 
Personal Gallery is designed to hold images that will only be usable to the individual users when 
they are signed in to their accounts 

• To use the SchoolCenter Image Gallery, Our Gallery or Your Personal Gallery to add an 
image to your site, click the Add Media icon. A new window will open allowing you to 
upload your image. 

• To add an image from the SchoolCenter Image Gallery, Our Gallery or Your Personal 
Gallery, click the appropriate button to open the gallery.  

 
 
 
 
 
 

Figure 7-20 
Image Gallery 

 
 
 
 
 
 
 
 
 

 

SchoolCenter Image Gallery 
• You have the option to search for an image alphabetically. A list of all the images for the 

letter you selected will be displayed. School Center images are contained within Tags. 

• You will see the name of each Tag and the number of images within the Tag. 

• You also have the option to Search the SchoolCenter Gallery for All items, Items with no 
Tags, and Tags with no items. 

• To view images, click a Tag. 

• Images within the tag you selected will appear. 

• The buttons at the top of the screen allow you to cycle through the images. 

• You also have the option to select a thumbnail size for the images. 

• Select a category to view from the drop-down menu, and then click the image you would 
like to load onto your page. The image will load in a new window.  

• Click Add to Site.  
 

Local Gallery and Your Personal Gallery 
The Local Gallery and Your Personal Gallery operate exactly the same with the only difference 
being that the Local Gallery is for a school or a district and the Personal Gallery is for an 
individual user. 

Adding Images to the Local Gallery and Your Personal Gallery 
• To add an image, click the tab for either the Local or Personal Gallery. 

• Click  Add.   
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Figure 7-21 
Upload Methods 

 
 
 
 
 
Standard Mode 

• To use Standard Mode, click the button next to Standard Mode and then click Select 
Upload Method. 

• To add a file from your computer, click  Browse. 

• Select the image file you want to add by double-clicking it. 

• Click Upload File.  

• After your file uploads, you can browse for another file or click Done. 

• You can change your file name in the text box provided. 

• Choose the category you want to place the file by selecting the correct category from 
the drop-down menu. 

• If you no longer want this image uploaded, you can select the Delete option. 

• You can name your image by filling out the Title field. 

• To add tags or comments to your image click Add Tags/Comments.  Tags act as 
categories for your images.  If you want the images to belong to multiple categories, 
enter multiple tags into the field.  

• This list of tags needs to be coma-separated.  In the new window that opens, enter in 
the tags for your image in the first text box and comments in the second text box. 

• If you no longer want this image uploaded, you can select the Delete option. 

• Click  Done to save your changes. 
Enhanced Mode 

• To add files using Enhanced Mode, you will need to have Java™. 

• Click the button next to the Enhanced Mode option and then click Select Upload 
Method. 

• To add files, you can click Add in the new window to open a file browser to select 
individual or multiple files.  After you have selected your files from the browser, click 
Open.  Alternatively, you can open a file browser.  Once you have opened the browser 
and navigated to the files you want to add, simply drag and drop them into the 
SchoolCenter window. 

• Once you have dragged and dropped the files you are adding to your page, click Done. 

• In the new window, you can change your file name in the text box provided. 

• To add tags or comments to your image click Add Tags/Comments. Tags act as 
categories for your images. If you want the images to belong to multiple categories, 
enter multiple tags into the field.  

• This list of tags needs to be coma-separated. In the new window that opens, enter in the 
tags for your image in the first text box and comments in the second text box. 

• If you no longer want this image uploaded, you can select the Delete option. 

• Click Done to save your changes. 
Adding Image to Site 

• The image you selected will appear in the sidebar.  

• You have the option to change the title and description of the image. You also have the 
option to add additional tags to the image. 
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• When you are finished making changes to the image, click Apply. 

• To delete the image, click Delete.  

• You can add the image to your site by clicking Add To Site. 

• The Edit Image window will open.  You can edit your image by resizing the image, 
adding effects to the image, and by cropping your image. 

• Click Done. 

• The image will now appear on your site. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-22 
Local Tab 

 
 

 
 
 
 
 
 
 
 
 
 

Adding Images from the Local Gallery and Your Personal Gallery 
The Local Image Gallery and Your Personal Gallery may already contain images.  Adding images 
from these galleries is simple.  You have different ways you may search for the exact image you 
want. 

• If in Legacy Mode, click the Add Image icon.  If in New Mode, click the edit icon and 
choose the Add Image option. 

• In the new window, choose whether you want to add an image from the Local Gallery or 
from Your Personal Image Gallery by clicking the gallery's button. 

• A new window will open.  If you do not find the image you are looking for in the gallery 
you selected, you can switch from the SchoolCenter gallery, the Local Gallery and Your 
Personal Gallery simply by clicking one of those tabs.   

Tags 

• To search for an image by its tag, click the tag button. 

• A list of your tags will appear in the left hand column.  You have the option to click one 
of the tags listed, or you can search by clicking All items, Items with no tags, or Tags 
with no items. 

• After you select where you want to search, thumbnails of the images will appear. 

• To select an image, click its thumbnail. 

• The image will appear in the left pane.  You can add a title, description and tags to the 
selected image.  Click Apply to save your changes. 

• You can also delete the image by clicking Delete. 
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• To add the image to your site, click Add to Site. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-23 
Local Tab 

 
 
 
 

 
 
 
 
 
 
 
 
Browse 

• Another way to search for images is to click Browse. 

• You have the option to click  one of the tags listed, or you can search by clicking All 
items, Items with no tags, or Tags with no items. 

• After you select where you want to search, thumbnails of the images will appear. 

• To select an image, click its thumbnail. 

• The image will appear in the left pane.  You can add a title, description and tags to the 
selected image.  Click Apply to save your changes. 

• You can also delete the image by clicking Delete. 

• To add the image to your site, click Add to Site. 
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Figure 7-24 
Resizing Image 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
Manage 

• With the Manage option, you can add tags and delete tags from the Gallery.  

• To add a tag, enter a name for the tag in the Name text box. 

• Click Add. The tag you created will appear. 

• You have the option to search for tags alphabetically by clicking a letter of the alphabet. 

• To delete a tag, select the tag or tags you want to delete. 

• Click Delete. The tag will be removed from the Gallery. 
 
Once you have chosen either a gallery image or a local image, it will open in the Edit Image 
window, where you can change the image options by resizing, applying effects, or cropping the 
image.  

 
Resizing 
The Resizing option allows you to alter the image’s size.  

• To make the image smaller, click different points on the scale in the Resizing Options 
box. The Image Information box will give the size information for both the original and 
the altered image.  
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Figure 7-25 
Image Effects 

 
 
 
 
 
 
 
 
 
 
 

 

The scale is not a sliding scale. Click the percentage number you want to resize 
the image to. 

 
You can enhance your image using the Effects tab. 

• Click the Effects tab. Within the Effects Options box are several icons, including Blur, 
Charcoal, Emboss, Negative Image, Flip Vertical and Flip Horizontal.  

• Hover the cursor over each icon to see a description of what effect it will produce. The 
Effects Options box also offers a Rotate Right and Left icon.  
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Figure 7-26 
Image Cropping 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

• Once you have chosen the effect that you would like to use, click the icon and then click 
Apply. You can see the result on the image below in the Image Information box. 

 

 

If you are unsatisfied with the effect, simply choose another effect or re-click 
same icon to remove the effect. 

 
You can cut down the image by using the Cropping tab.  

• To crop your image, place the cropping box over the area of the image you want to 
keep.  The box size can be adjusted vertically, horizontally and diagonally by clicking 
the side or corner you want to move. 

• Once you have the box covering the area you want to keep, click the Crop button. 

• You can reset the image by clicking Reset. 

• Once you are finished with your Edit Image options, click Done to save those settings.  
Next, upload the image and then close the window.  
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• You can adjust the alignment of the media you have added by clicking the Alignment 
icon.  

• You may also replace the image by clicking the Replace icon or delete the image by 
clicking the Delete icon.  

• To return to the Edit Image window, click the Edit icon if in Legacy Mode.  If you are in 
New Mode, choose the Edit Image option from the drop-down menu. 

 

• Once you have added an image or media to your site, you also have the option of adding 
alt tags or links to the image. 

 

 

For information on adding image to the galleries, see the Add Images to 
Gallery section. 
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Upload Media 
 

In SchoolCenter, you can upload media files onto your page. The three mediums you can add are 
Images, Music, and Movies.  

• To add a media file to your site, click the Add Image icon. While the icon says Add 
Image, you can add media files to your site as well.  

• Click Browse to select the media file you want to upload to your site. 

• Click Upload File.  
 

 

You can not upload flash or music files to/from Our Gallery. 

 
The types of media you can upload are: 
 

Image Files  Movie Files  Music Files 

.jpg .gif   .mov .swf   .mp3 .mid 

.bmp .png   .mpg     .wav .ac3 

.tif            

 

• You can browse for media from your computer’s hard drive by clicking Browse.  You will 
be then be directed to the hard drive on your computer where you can locate whatever 
media files you want to attach. 

 

 

 It is recommended that you transfer files on a floppy disk to the hard-drive 
before uploading. 

 

• Select the file you want to upload and click Open. The path and filename will appear in 
the text box located to the left of Browse.  

• Once you have selected the file you want to upload, click Upload Media File. The file 
will be uploaded and placed in the edit field.  

• Alternatively, you can search for media in Enhanced mode and simply drag and drop the 
media files from your computer's file browser into the SchoolCenter media window. 

• You can adjust the alignment of the media by clicking the Alignment icon. You can also 
replace the media file by clicking the Replace icon or delete the file by clicking the 
Delete icon. 

 

 

Media added will not play while you are in Edit mode. 
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Chapter 8 - Website Design 
 

One of the most important elements of an effective website is a unique and dynamic design.  To 
help you create a website with a great design, SchoolCenter has equipped its software with 
components that make your creation process as simple and stress-free as possible while allowing 
for ease of navigation. 
 
Using the Page Design options will allow you to make design changes to your website. There are 
a few different ways to access the Page Design area. 
 

Basic Page Design 
Using the Page Design options will allow you to make design changes to your website. There are 
a few different ways to access the Page Design area: 
 

• When you are on the Start Page, you can click Design.   

• From any page on your site that you have edit access, you can click Design. 

• From any page on your site, you can click the Page Settings option in the Edit drop-down 
menu, and then click the Page Design option.  

 
Once you have opened Page Design, click the names of any of the features listed on the page to 
make changes to your layout or current settings.  
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 8-1 
Basic Page Design 
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Changes made while in Basic mode are automatic and will affect not only the page you are 
working on, but also every page within the current level (district, school, classroom, etc.).  
However, it will not affect other sections in other levels.  For example, if you changed the design 
at the school level, it will not affect the designs of classroom-level pages. 
 

Page Location 
The Page Location option can be used to change the alignment of your pages within the browser 
window.   
 

• When you click the Page Location link, a new window will open, allowing you to choose 
left or center alignment for your site.  

• Once you have selected the alignment option for your page, click Done to save your 
settings and close the window. 

 

Page Width 
The Page Width option can be used to set the width of your website's pages. All site pages are 
initially set at 720 pixels. This width is the recommended width for pages viewed on 15-inch 
monitors. 
 
 
 

 
 
 
 

Figure 8-2 
Page Width 

 
 
 
 
 

• When you click the Page Width link, a new window will open, allowing you to select the 
page width setting. 

• Once you have selected the width for your page, click Done to save your settings and 
close the window. 

 

 

We recommend that you keep your page width set at 720. 

 

Font Type 
The Font Type option can be used to change your website’s page fonts.  Changing the font type 
here will change not only the fonts of the main content on your page, but also the navigation 
font. 
 

• When you click the Font Type link, a new window will open allowing you to select the 
font type for your site from the drop-down menu.  
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The fonts you can choose from are: 
 

Arial Georgia 

Century Gothic Helvetica 

Charcoal MS Sans Serif 

Chicago Tahoma 

Comic Sans MS Techno 

Cooperplate Gothic Bold Cooperplate Gothic Italic 

Times New Roman Trebuchet MS 

Courier New Verdana 

Garamond  

 

• Once you have selected the font type for your site, click Done to save your settings and 
close the window. 

 

 

Fonts for the main content of the pages can also be changed in the Advanced 
Content Editor. For more information on the Advanced Content Editor, see the 

Advanced Content Editor section of this manual. 

 
 
 

Title bar Visibility 
The Title bar Visibility option can be used to hide or display the title bar at the top of each page 
of the site. When the Title bar is shown, a band of color will appear at the top of your page 
containing the title/name of the page.   
 

• When you click the Title bar Visibility link, a new window will open, giving you the 
options to Show or to Hide your title bar.  

• Once you have selected the title bar visibility for your page, click the Done button to 
save your settings and close the window. 

 

 

It is recommended that you hide your title bar if you choose to display a 
banner/header image. 

 
 

Title Location 
If you choose the Show option within Title bar Visibility, use the Title Location option to 
determine where you want the title bar title to appear at the top of each page of the site.  
 

• When you click the Title Location link, a new window will open allowing you to set your 
title text to align to the left, center or right of the title bar. 

• Once you have selected the title location for your page, click Done to save your settings 
and close the window. 

 

Title Font Size 
If you choose the Show option within Title bar Visibility, use the Title Font Size option to set the 
size of the title bar text that appears at top of each page of the site,.  
 

• When you click the Title Font Size link, a new window will open allowing you to choose 
the size of the title font within a drop-down menu that contains a range of font sizes 
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from 5- to 35-point. 

• Once you have selected the title font size for your page, click Done to save your settings 
and close the window. 

 

Header Image 
The Header Image option allows you to place an image on the top of your site in the form of 
either an image or a banner. If you choose to use a banner, you may use the Banner Image 
Creator to design your own banner or, alternatively, you may use any third-party software.  
 

• When you click the Header Image link, a new window will open allowing you to add an 
image by clicking the Add Media icon and uploading your image.  

• Once you are finished adding your image, click Done to save your settings and close the 
window. 

 

 For more on how to add images, see the Adding Pictures section of this manual. 

 
 

Date/Location Bar 
The Date/Location Bar option allows you the option of turning on or turning off the Drill-Down 
Navigation and the Date Bar.  This option also allows you to change the date format display. This 
is the navigation and date that appears between the Title bar or Header Image and the content 
of your site. 
 
 
 
 
 
 
 
 
 

Figure 8-3 
Drill Down Navigation 

 
 
 
 
 
 
 
 

• When you click the Date/Location Bar link, a new window will open, allowing you to 
select your options.  

• From the drop-down menus, select On or Off for the Drill-Down Navigation and the Date 
and select the Date Format. 

• Once you have selected the options for your site, click Done to save your settings and 
close the window. 

 

Navigation Location 
The Navigation Location option allows you to choose the placement of the navigation links on 
your website. 
 

• When you click the Navigation Location link, a new window will open allowing you to 
choose one the four placement options: Top, Bottom, Side, or Top & Bottom.  Select 
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one of those options to display the navigation links on your page. 

• If you choose the Side display option, you will have a Navigation (Sidebar) color behind 
your links. This color can be changed by accessing the Color Editor. 

• Once you are finished setting up your navigation links display, click  Done to save your 
settings and close the window. 

 

Link Information 
The Link Information option allows you to choose whether you want the links on your site to be 
underlined constantly or underlined on only on rollovers (when the mouse passes over the link.) 
 

• When you click the Link Information link, a new window will open allowing you to select 
your links appearance preference from the drop-down menu.   

• Once you have selected the display option for your links, click  Done to save your 
settings and close the window. 

 

Navigation (Sidebar) Width 
The Navigation (Sidebar) Width option allows you to change the width of the navigation sidebar. 
This option can be used only when you choose to place your navigation links on the side of your 
page.  
 

• When you click the Navigation (Sidebar) Width link, a new window will open allowing 
you to set the pixel width of your navigation sidebar. The width is originally set at 150 
pixels, which will allow most page titles/navigation links to be displayed without 
wrapping the text.  

• To change the width, highlight the number and type the number for the new pixel width.  

• Once you have finished changing the width, click Done to save your settings and close 
the window. 

 

Color Editor 
The Color Editor option allows you to change the colors that appear on your site.  
 

• Before you click the Select Color Editor link, you will need to choose your browser type 
and speed from the drop-down menu located to the right of the Select Color Editor link.  

• Once you have selected one of the two options available, click the Select Color Editor 
link to open a new window that will allow you to select your color preferences. 

 
 

 
 
 
 
 
 
 
 

Figure 8-4 
Color Editor 
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• To change the color of different areas on your site or page, click the area you would like 
to change and then go to the color picker to select the color you want. 

• Once you have finished making your color selection, click Done to save your settings. 
 

 

For more options, click the Options tab located in the upper left corner of the 
Color Editor window. This will allow you to see the Title bar, Header Image, and 

Background Image if they apply to your pages. 

 

Corner Type 
The Corner Type option allows you to choose whether you want the corners of your boxes for 
the Titlebar, Sub-Headers (when your page is in the Newsletter style) and the Navigation Sidebar 
to be rounded or squared.  
 

• When you click the Corner Type link, a new window will open allowing you to select 
your corner preference.  

• Once you are finished making your selection, click Done to save your settings and close 
the window.  

 
 
 

Background Image 
The Background Image option allows you to place an image on your site as a background.  
 

• When you click the Background Image link, a new window will open allowing you to add 
a background image to your site by clicking the Add Media icon. A new window will open 
where you can upload your image.  

• Once you have finished adding your background image to your site, click Done to save 
your settings and close the window. 

 

 

For more on adding images, see the Adding Pictures section of this manual. 

 

Copyright Location 
The Copyright Location option allows you to change the alignment of the copyright as it appears 
on your site.  
 

• When you click the Copyright Location link, a new window will open allowing you to 
choose the alignment for your copyright. 

• The copyright will appear at the bottom of your site. You can choose to locate your 
copyright on the left side, the center, or the right side. 

• Once you have finished selecting your alignment options, click Done to save your settings 
and close the window. 

 

Last Update 
The Last Update option allows you to show or hide from visitors the last date on which the 
website was edited. 
 

• When you click the Last Update link, a new window will open allowing you to select 
Show or Hide from the drop-down menu. When the last update is shown, the date when 
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the site was last edited will appear at the bottom of the page.  

• Once you have made your selection, click Done to save your settings and close the 
window. 
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Advanced Page Design 

 
Advanced Page Design 
Advanced Page Design will allow you to change a single page or multiple pages at one time.   

• Select the Advanced tab for advanced layout options.  
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-5 
Advanced Page Design 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• To make changes to your layout or current settings, click the name of the feature you 
would like to modify.   

 

 

Options are available depending on the settings or options selected.  
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When you have finished changing your layout options, you can apply the changes to multiple 
pages by using the Site Tier Index. 

• Select the page or pages you want to apply these changes to from the Site Tier Index.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-6 
Site Tier Index 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• After the pages have been selected, scroll to the bottom of the page and click Apply to 
save your settings. 

• To preview the changes before applying them to your site, click the blue Preview 
button. A preview of your changes will open in a new window. 

• If you want to change the layout to the previous settings before you modified them, 
click Reset.  

 

 

Resetting the layout will only be modified before you click Apply.. Once the 
changes to the layout are applied, you will not be able to reset the layout. 

 

Page Location 
The Page Location option can be used to change the alignment of your pages within the browser 
window. 
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• When you click the Page Location link, a new window will open allowing you to choose 
left or center alignment for your site.  

• Once you have selected the alignment option for your page, click Done to save your 
settings and close the window. 

 

 
Page Width 
The Page Width option can be used to set the width of your website pages. All site pages are 
initially set at 720 pixels. This width is the recommended width for pages viewed on 15-inch 
monitors.  
 

• When you click the Page Width link, a new window will open, allowing you to select the 
page width setting. 

• Once you have selected the width for your page, click Done to save your settings and 
close the window. 

 

 

We recommend that you keep your page width set at 720. 

 

Font Type 
The Font Type option can be used to change your website page fonts.  Changing the font type 
here will change not only the fonts of the main content on your page, but also the navigation 
font. 
 

• When you click the Font Type link, a new window will open allowing you to select the 
font type for your site from the drop-down menu.  

 
The fonts you can choose from are: 
 

Arial Georgia 

Century Gothic Helvetica 

Charcoal MS Sans Serif 

Chicago Tahoma 

Comic Sans MS Techno 

Cooperplate Gothic Bold  Cooperplate Gothic Italic 

Times New Roman Trebuchet MS 

Courier New Verdana 

Garamond  

 

• Once you have selected the font type for your site, click Done to save your settings and 
close the window. 

 

 

Fonts for the main content of the pages can also be changed in the Advanced 
Content Editor. For more information on the Advanced Content Editor, see the 

Advanced Content Editor section of this manual. 

 
 
The Header Editor option is used for advanced Header Image and Titlebar options. When you 
click the Header Editor link, a new window will open to allow you to select your options.  
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Main 
The Header Editor window will open on the Main tab. 

 
 
 
 
 
 

Figure 8-7 
Header Editor - Main 

 
 
 
 
 
 
 
In this area, you can first select whether you want your titlebar to be shown or hidden.    
 

 

 If you choose to have your titlebar shown, it will automatically update the 
Titlebar Visibility layout option. 

 

• From the next drop-down menu, select if you want just the simple page title or the 
parent section title and page title to appear in the title bar. 

• Next, you can select whether you want the header to be a normal image or a clickable 
link.  

• If you choose to make it a clickable link, type the URL address to which you want the 
header to link, then select whether the link will open in the same window or in a new 
window. 

• In the Main tab, you can also choose to make the corners of your title bar rounded or 
squared by choosing from the drop-down menu.  

 

 

Changes made to the Corner Type will automatically update the Corner Type 
layout option. 

 

• Once you have made your selection, click the next tab to continue within the Header 
Editor or click Done to save your settings. 

 
Positioning 

• Click the Positioning tab if you want to make changes to the placement of the Title bar 
and Header Image. 

• From the drop-down menu, select the location of the header image in relation to the 
titlebar. The image can be placed either inside or outside of the titlebar.  

• Next, select the placement of the header image in relation to the titlebar. You can 
place it at the top, bottom, left, or right of the title bar by selecting one of the choices 
from the drop-down menu. 

• Once you have made your selection, click the next tab to continue within the Header 
Editor or click Done to save your settings. 

 
Title 
Within the Title area, you can change the settings of the titlebar.  
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• From the drop-down menus, select the font size of the title and the position of the title 
within the titlebar. 

• In the Titlebar box below, you can also select the height and width of the titlebar and 
the alignment of the titlebar on the page.  

• Once you have made your selection, click the next tab to continue within the Header 
Editor or click Done to save your settings. 

 
Image 
The Image area of the Header Editor allows you to change the settings of the Header Image. 

• You can determine whether there should be spacing between the header image and the 
titlebar by choosing to turn the padding on or off in the drop-down menu. 

• Once you have made your selection, click Done to save your settings. 
 

Titlebar Visibility 
The Titlebar Visibility option can be used to hide or display the title bar at the top of each page 
of the site. When the title bar is shown, a band of color will appear at the top of your page 
containing the title/name of the page.  
 

• When you click the Titlebar Visibility link, a new window will open allowing you to show 
or to hide your titlebar. 

• Once you have selected the titlebar visibility for your page, click Done to save your 
settings and close the window. 

 

 

It is recommended that you hide your titlebar if you choose to display a 
banner/header image. 

 

Header Image 
The Header Image option allows you to place an image on the top of your site in the form of 
either an image or a banner. If you choose to use a banner, you may use the Image Creator to 
design your own banner or, alternatively, you may use any third-party software.  
 
 
 
 
 
 
 
 
 
 

Figure 8-8 
Image upload screen 
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• When you click the Header Image link, a new window will open allowing you to add an 
image by clicking the Add Media icon and uploading your image.  

• Once you are finished adding your image, click Done to save your settings and close the 
window. 

 

Image Map Image 
The Image Map Image option allows you to use an image as the base for your website’s 
navigation. A certain area of the image will be designated as the link for one area of your site, 
with the page title visible upon the mouse rollover of the area. Visitors can access any webpage 
on your site by clicking the appropriate area of the image.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-9 
Image Map Image 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• When you click the Image Map Image link, a new window will open allowing you to add 
an image by clicking the Add Media icon and uploading your image.  
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• Once you are finished adding your image, click Done to save your settings and close the 
window. 

 

Date/Location Bar 
The Date/Location Bar option allows you the option of turning on or turning off the Drill-Down 
Navigation and the Date Bar.  This option also allows you to change the date format display. This 
is the navigation and date that appears between the title bar or header image and the content 
of your site. 
 

• When you click the Date/Location Bar link, a new window will open allowing you to 
select your options.  

• From the drop-down menus, select On or Off for the drill-down navigation and the date.  

• Next, select the Drill-Down Format to be shown as links or as a drop-down menu and 
select the Date Format. 

• Once you have selected the options for your site, click Done to save your settings and 
close the window. 

• The Navigation Editor allows you to work with advanced navigation layout options. 
When you click the Navigation Editor link, a new window will open to allow you to 
select your options. 

 
Main 
The window will open on the Main tab.  
 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-10 
Navigation Editor - Main 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• In this area, you will first be able to select whether you want your sidebar background to 
be shown or hidden.    
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Your Sidebar background color can also be set in the Color Editor. 

 

• The next option will allow you to specify your underline setting for your navigation links. 
 

 

Changes here will not affect the Link Information setting. Changes here only 
affect the navigation links. 

 

• Next, you can select your navigation link placement choosing from the options in the 
drop-down menu.  

 

 

Changes to the navigation placement in the Navigation Editor will automatically 
update the Navigation Location setting 

 

• The next option allows you to set the size of the Navigation Sidebar when it is located on 
the left side of the page. You can choose the number of pixels from the drop-down 
menu.  

 

 

Changes to the pixel width will automatically update the Navigation (Sidebar) 
Width setting. 

 

• The last option allows you to choose to make the corners of your Navigation Sidebar, 
Titlebar and any Sub-Headers (when in Newsletter style) rounded or squared by choosing 
from the drop-down menu.  

 

 

Changes made to the Corner Type in the Navigation Editor will automatically 
update the Corner Type layout option. 

 

• Once you have made your selection, click the next tab to continue within the Navigation 
Editor, or click Done to save your settings. 

Text 
In this area, you can change your navigation text settings.    
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Figure 8-11 
Navigation Editor - Text 

 
 
 
 
 
 
 
 
 
 
 
 

 

• First, you can select your link text alignment. This specifies the alignment of the link 
text in relation to the inside of its containing box. 

• The next option allows you to choose the link font size from the drop-down menu. 

• Once you have made your selection, click the next tab to continue within the Navigation 
Editor, or click Done to save your settings. 

 
Box 
This area allows you to change the spacing and borders of the navigation links.  
 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-12 
Navigation Editor - Box 
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• The first option allows you to change the spacing between the link containers by 
selecting the pixel width from the drop-down menu. 

• You can also change the size of the border around the link container by selecting the 
pixel width from the drop-down menu. 

• Once you have made your selection, click the next tab to continue within the Navigation 
Editor, or click Done to save your settings. 

Colors 
This area of the Navigation Editor allows you to change the colors of the navigation links. 
 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-13 
Navigation Editor - 

Colors 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• To specify a color, click the color square next to the link option you want to modify and 
select the color from the Color Picker.  

• You can change the Link Font Color, Link Background Color, Link Font Hover Color, Link 
Background Color, and Sidebar Color. 

• Once you have made your selection, click Done to save your settings. 
 

 
The option  is designated transparent or No Color. 

 

Navigation Location 
The Navigation Location option allows you to choose the placement of the navigation links on 
your website.  
 

• When you click the Navigation Location link, a new window will open allowing you to 
choose one the four placement options of Top, Bottom, Side, or Top & Bottom – in 
which to display your Navigation links on your page. 

• If you choose the Side display option, you will have a Navigation (Sidebar) color behind 
your links. This color can be changed by accessing the Color Editor. 
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• Once you are finished setting up your navigation links display, click Done to save your 
settings and close the window. 

 

Link Information 
The Link Information option allows you to choose whether you want for the links on your site to 
be underlined constantly or underlined on only on rollovers (when the mouse passes over the  
link). 
 

• When you click the Link Information link, a new window will open allowing you to select 
your links appearance preference from the drop-down menu.   

• Once you have selected the display option for your links, click Done to save your settings 
and close the window. 

 

Navigation (Sidebar) Type 
The Navigation (Sidebar) Type option allows you to select whether or not you want your 
navigational links to be standard image map, or custom. 
 

 
 
 
 
 
 
 
 
 

Figure 8-14 
Navigation type 

 
 
 
 
 
 
 
 
 
 

• When you click the Navigation (Sidebar) Type link, a new window will open so that you 
can choose the navigation type. Choosing the Standard navigation will place the links in 
a straight line on the page.  

• Grouping the navigation will create a dynamic menu system with a floating navigation. 
Select the style option you want to use.  

• Once you are finished making your selection, click Done to save your settings and close 
the window. 

 

 

The navigation can be grouped from the Page component. For more information 
on grouping the navigation, see the Grouping Navigation section. 

 

Color Editor 
The Color Editor option allows you to change the colors that appear on your site.  
 

• Before you click the Select Color Editor link, you will need to choose your browser type 
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and speed from the drop-down menu located to the right of the Select Color Editor link.  

• Once you have selected one of the two options available, click the Select Color Editor 
link to open a new window that will allow you to select your color preferences.  
 
 
 
 
 
 
 
 

Figure 8-15 
Color Editor 

 
 
 
 
 
 
 
 

• To change the color of different areas on your site or page, click the area you would like 
to change and then go to the color picker to select the color you want. 

• Once you have finished making your color selection, click Done to save your settings. 
 

 

For more options, click the Options tab located in the upper left corner of the 
Color Editor window. This will allow you to see the Title bar, Header Image, and 

Background Image if they apply to your pages. 

 

Corner Type 
The Corner Type option allows you to choose whether you want the corners of your boxes for 
the Titlebar, Sub-Headers (when your page is in the Newsletter style), and the Navigation 
Sidebar to be rounded or squared.  
 

• When you click the Corner Type link, a new window will open allowing you to select 
your corner preference.  

• Once you are finished making your selection, click Done to save your settings and close 
the window. 

 
Navigation (Sidebar) Width 
The Navigation (Sidebar) Width option allows you to change the width of the navigation 
sidebar. This option can be used only when you choose to place your navigation links on the side 
of your page.  
 

• When you click the Navigation (Sidebar) Width link, a new window will open allowing 
you to set the pixel width of your navigation sidebar. The width is originally set at 150 
pixels, which will allow most page titles/navigation links to be displayed without 
wrapping the text.  

• To change the width, highlight the number and then type the number for the new pixel 
width.  

• Once you have finished changing the width, click Done to save your settings and close 
the window. 

 



Webtools Manual 

130 

Navigation Background Image 
The Navigation Background Image allows users to upload an image to use behind the navigation 
links. 
 

• When you click the Navigation Background Image link, a new window will open allowing 
you to upload an image.  

• Click the Add Media icon and upload the image from your local computer, the 
SchoolCenter Gallery, or the local Image Gallery.  

• Once you have finished uploading the image, click Done to save your settings and close 
the window. 

 

Background Image 
The Background Image option allows you to place an image on your site as a background.  
 

• When you click the Background Image link, a new window will open allowing you to add 
a background image to your site by clicking the Add Media icon.  

• This will take you to a new screen where you can upload your image. 

• Once you have finished adding your background image to your site, click Done to save 
your settings and close the window. 

 

 

For more on adding images, see the Adding Pictures section of this manual. 

 

Newsletter Box Options 
The Newsletter Box Options allow you to customize the text boxes on your website when using 
the Newsletter style.   

• When you click the Newsletter Box Options link, a new window will open allowing you 
to customize the title text, the border of the box, the box’s background color, and the 
box’s title image. 

 
 

 
 
 
 
 
 
 
 
 

Figure 8-16 
Newsletter Box Options 
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• Once you have finished customizing your options, click Done to save your settings and 
close the window. 

 

Copyright Visibility 
The Copyright Visibility option can be used to show or hide the copyright on your website's 
pages.  
 

• When you click the Copyright Visibility link, a new window will open allowing you to 
choose if you want it to be shown or hidden. Select your preference by checking the 
radio button next to the option. 

• Once you have selected one of the two options, click Done to save your settings and 
close the window. 

 

Background Audio 
The Background Audio option allows you to place audio files on your site to use as background 
music. When a music file is uploaded to the page, the music will start playing each time the 
browser is refreshed. 
 

 

The media will not automatically play when in edit mode. 

 

• When you click the Background Audio link, a new window will open allowing you to add 
the audio file by clicking the Add Media icon. 

• Click Browse to locate the file you want to use within your computer’s hard drive.   

• Once you have located the file, click Upload Audio File. 
 

 

Audio files that can be used as background music are limited to a 10mb size limit. 
The acceptable media types that can be added are .mp3, .wav, .mid and .ac3 

files. 

 

• When the Background Audio file is uploaded, the media player bar will appear at the 
bottom of the page.  

• Once you are finished adding your audio file, click Done to save your settings and close 
the window. 

 

Copyright Location 
The Copyright Location option allows you to change the alignment of the copyright as it appears 
on your site.  
 

• When you click the Copyright Location link, a new window will open to allow you to 
choose the alignment for your copyright. 

• The copyright will appear at the bottom of your site. You can choose to locate your 
copyright on the left side, the center, or the right side. 

• Once you have finished selecting your alignment options, click Doneto save your settings 
and close the window. 

 

Last Update 
The Last Update option allows you to show or hide from visitors the last date when the website 
was edited. 
 

• When you click the Last Update link, a new window will open giving you the option to 
select Show or Hide from the drop-down menu. When the last update is shown, the date 
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when the site was last edited will appear at the bottom of the page.  

• Once you have made your selection, click Done to save your settings and close the 
window. 
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Themes 

 
Themes 
SchoolCenter offers a variety of theme pages for your use.  Themes are pages that have the 
background and banner already selected for you.  Certain themes also come complete with 
background images, header images, and other pre-selected designs that give your site a polished 
and professional look instantaneously.  There are different varieties of themes to choose from 
and each theme has a choice of color scheme.  
 
Using the Page Design options will allow you to make design changes to your website. There are a 
few different ways to access the Page Design area: 
 

• From any page on your site that you have access to or from your Start Page, you can click 
the Design button. 

• From any page on your site, you can click the Page Settings option in the Edit drop-down 
menu, and then click the Page Design button.  

• Once you have opened Page Design, click the Themes tab. This will open the themes 
library.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-17 
Themes 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• You can choose a theme category from the drop-down menu.  The categories are 
Holiday, SchoolCenter and Sports. 

• You can preview the theme by clicking the theme.  A page with the theme you have 
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chosen will open with the theme in a variety of colors. 

• For a large preview of the theme, click the theme color you want to view. 

• If you decide that you want to see another color, click the Back to Step 2 link.   

• If you decide that you want to view another theme, click the Back to Step 1 link.  

• Select the type of theme you would like to apply to your page or site by clicking the 
theme image.  

• Next, select the color of the theme you want to apply by clicking the theme image. 

• To apply the theme to your page click Apply to This Page.  

• To apply the theme to multiple pages click Apply to Multiple Pages. 
 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-18 
Applying Themes 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
This will take you to the Advanced Page Design page.  

• Select the page or pages you want to apply the theme to from the Site Tier Index.  
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Figure 8-19 
Site Tier Index 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• After the pages have been selected, click Apply to save your settings. 
 

 

Themes are created with pre-selected settings. Changing any of the layout 
options may affect the way the theme displays on your page. 

 

• To preview the changes before applying them to your site, click the blue Preview 
button. A preview of your changes will open in a new window.  

• If you want to change the layout to the settings they were before you modified them, 
click Reset.  

 

 

Resetting the layout will only be modified before you click Apply. Once the 
changes to the layout are applied, you will not be able to reset the layout. 

 

• To remove the applied theme, select the Undo Layout/Theme option from the Edit 
Options drop-down menu located above the Site Tier Index on the right side.   
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Figure 8-20 
Undoing a Theme 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Next, select all the pages you want to remove the theme from by placing a check in the 
box next to the page title.  

• Click Apply and the Page Design will revert back to the design before the theme was 
applied. 
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Chapter 9 - Page Components 
Page Components 

 
SchoolCenter's software contains a wide array of page components to aid you in creating the 
most comprehensive and well-organized website possible. 
 

Creating New Sites 
• To create a section for your site, go to the page to which you want to add a section 

(Administrative Department, Classroom, Non-Student Organization, Clubs and 
Groups, Sports Zone).  

• In the Edit drop-down menu, click Switch to View Mode. 

• From the Edit drop-down menu, click the Add New Site option. 

• A new window will appear. In the Please enter a site title below text box, type the 
name of the section that you want to add, and then click Done. 

• The Page Settings window will open. 

• The section will be added and listed below the text box.  

 
Moving Sites 

• To move this section to a similar page section located elsewhere on your site, click the 
Move icon in Legacy Mode or choose Move Site from the drop-down menu if in New 
Mode. A new window will open that will allow you to choose a destination for the 
section. 

 

 

Sections can only be moved within the same types of page components. Example: 
an Administrative Department section can only be moved to another 

Administrative Department. 

 

• To add/delete users to the section, click User to go to the Access Manager in the User 
Editor area in Legacy Mode.  If you are in New Mode, click the Edit Site Permissions 
option in the drop-down menu.   

• Click the section name to visit that section's home page. 
 

 

For more on adding users, see the User Editor section of this manual. 

 
 

Deleting a Site 
• To delete a section, click the edit icon next to the section. 

• In Legacy Mode, in the new window that opens, click the Delete icon.  In New Mode, 
chose the Delete option from the drop-down menu. 

 

 

Deleting the page listing the sections will delete the sections as well. 

 

• To rename a section, go to that section's home page and choose Page Settings from the 
Edit drop-down menu.  In the Section Title option, enter a new title.  
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Page Settings 

 
Default Pages and Settings 
The Default Pages and Settings is a function in the Advanced Mode that allows you to preset the 
page design and content of created sites. 
 
While in Edit mode, click the [Edit Default Pages & Settings] option in the Edit drop-down 
menu. This will take you into the Template section. Here, you can add pages, change the page 
design, and add content. When you are done making your changes, click the Template link in the 
drill-down navigation. Any new section created after the Template is changed will have those 
changes. 
 

Page Settings 
All pages have settings you can customize for the presentation of the various pages on your 
website. 
 

• To access the Page Settings window for a particular page component, navigate to that 
page and click the Edit drop-down menu. 

• Choose the Page Settings option. 
 
Within this window, you can change the page title and choose from several different options on 
how the page will appear on the screen.  You can also decide who can view the page. The Page 
Settings options differ depending on the page component. The most recent user to edit the page 
and the date of that update will appear in the Page Settings window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-1 
Page Settings 
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Some of the common features available in page components are: 
 
Password protect this page in View mode 
This option will password-protect your page by allowing you to enter in a user name and 
password in the appropriate text boxes to access the page. 
 
Allow more than one (1) Add picture and text 
This option allows you to add more than one edit field to your page. 
 
Use newsletter style scrapbook instead of Add Picture and Text 
This feature changes the edit fields to Newsletter style, allowing for advanced editing and 
display options. 
 
Allow public to subscribe to this page 
When you select this option, visitors can enter their email address and you can email all 
subscribers at the same time to let them know this page has been updated. 
 
Show Babel Fish language translation box  
When you select this option, a Babel Fish translation options box will appear at the bottom of 
your page. This feature gives viewers the choice of having your site translated into eight 
different languages. 
 
Hide link in navigation 
Selecting the Hide Link in Navigation box will keep this page from appearing in the set of links 
unless the user is in Edit Mode. 
 
 
 
 
 
 
 
 
 
 

Figure 9-2 
Details Tab 

 
 
 
 
 
 
 
 
 
 
 
Deny public access to  
This option will hide the link to this page and protect it from users that do not have edit access 
to this page. 
 
Make this page the homepage 
The Make this page the homepage option allows users to make the  page the Homepage of the 
site. 
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Move this page to another section 
This option will allow you to move a page to another section. The page will be copied to your 
Move Buffer. To place the page, go to the homepage of the section you are moving it to. 
 

 

Each Page Component also has unique Page Settings. For more information about 
these page settings, see each Page Component. 

 
Meta 
This option allows you to add keywords and phrases to your site’s or page's meta tags for Internet 
search engines. If these words are typed into the search engine, the search will include your site 
or page in the results. You can type words such as your school's name, or your sports team's 
name, or anything else you think someone who is interested in your site might look under. 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-3 
Meta Tab 
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Page Component Overview 

 
Page Components Overview 
Administrative Departments 
The Administrative Departments page allows you to organize department sections into an easy-
to-navigate list. Examples of administrative departments could include pages for the 
superintendent, principals, guidance counselors, and other important people in your school 
district. 
 
From this page, you can also add or delete departments. The Administrative Department section, 
like the Clubs and Groups and Non-Student Organization sections, is a subsection of the main 
school site.  This means that it can have its own unique layout and users can be granted access 
solely to the pages within each section. 
 
You also have the option to add a header that contains an image and text to the Administrative 
Departments section. For more on adding images and text, see the Adding Pictures and Adding 
Text sections of this manual. 
 

Class Projects 
The Class Projects component is available within the Classroom sections of your website.  This 
feature allows students to have their own area where they can edit and track classroom 
projects. This section is suitable for Web quests, uploading PowerPoint presentations, journals, 
photo albums and countless other classroom-related uses. Students can be given their own login 
name and password and be granted access to this site.  
 
You also have the option to add or delete class projects and pages from the Class Projects 
section. The Project Diary component is part of the Class Projects section. 
 

Clubs and Groups 
The Clubs and Groups page allows you to organize your school’s clubs or groups sections into an 
easy-to-navigate list. Such organizations could include the National Honor Society, Student 
Council, Beta Club and countless other types of groups.  
 
From this page, you can also add or delete clubs and groups. The Clubs and Groups section, like 
the Administrative Departments section, is a subsection of the main school site, meaning that it 
can have its own unique layout and users can be granted access solely to the pages within each 
section. 
 
You also have the option to add a header that contains an image and text to the Clubs and 
Groups section. For more on adding images and text, see the Adding Pictures and Adding Text 
sections of this manual. 
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Non Student Organizations 

 
Non-Student Organizations 
The Non-Student Organizations section allows you to organize non-student, but school-related 
organization pages into an easy-to-navigate list. Such organizations could include the PTA, PTO, 
M.A.D.D., the Boosters, and other similar organizations.  
 
From this page, you can also add or delete non-student organizations. The Non-Student 
Organizations section, like the Administrative Departments section, is a subsection of the main 
school site.  This means it can have its own unique layout and users can be granted access solely 
to the pages within each section. 
 

 

For more on adding or deleting departments, see Creating Sections. 

 
You also have the option to add a header that contains an image and text to the Non-Student 
Organizations section. For more on adding images and text, see the Adding Pictures and Adding 
Text sections of this manual. 
 

Sports Zone 
The Sports Zone section allows your school to set up a separate area on its website designated 
for the school sports teams. Each team can have its own section, each with its own look, layout, 
links, and users. You can add in as many or as few team pages, depending on the needs of your 
school. 
 
From this page, you can also add or delete team pages. The Sports Zone section, like the 
Administrative Departments section, is a subsection of the main school site.  This means it can 
have its own unique layout and users can be granted access solely to the pages within each 
section. 
 

 

For more on adding or deleting departments, see Creating Sections. 

 
You also have the option to add a header that contains an image and text to the Sports Zone 
section. For more on adding images and text, see the Adding Pictures and Adding Text sections of 
this manual. 
 

Page Setting Options 
The Page Setting option for Administrative Departments, Classroom Projects, Clubs and 
Groups, Non-Student Organizations, and Sports Zone are the same. 

• To access Page Settings, navigate to the specific page you are adjusting the setting for 
and then click the Edit drop-down menu. 

• Choose Page Settings from the Edit drop-down menu.  A new window will open. 
General 

• In the General tab, you have the options to change the page title, to password- protect 
your page, and to show picture and text below the listings. 

Details 

• In the Details tab, you can choose one of the following options:   Allow Public to 
Subscribe to Page, Hide Link in Navigation, Deny Public Access, Make This Page the 
Homepage, or  Move this Page.   
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• All of the Page Settings options are explained in detail in the beginning of this chapter. 
Meta 

• Add keywords and phrases to your page's meta tags for Internet search engines. If these 
words are typed into the search engine, the search will include your page in the results. 
You can type words such as your school's name, or your sports team's name, or anything 
else you think someone who is interested in your site might look under. 

• Click Done to save your settings once you have finished. 
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Calendar 

 
Calendar 
The Calendar is a convenient way to inform your visitors about upcoming events within the 
school or district. 
 
Events can be set up in color-coded categories tracked by the Category Legend, which is 
automatically created by the software when new categories are added. You also have the option 
of choosing the colors for each category by clicking the color square when creating the category. 
 
You can choose from several display options (including daily, weekly, monthly, etc.) to display 
the calendar as a list or to show or hide event details. You can import information from other 
calendars in your district and export information out to your Personal Data Assistant (e.g, Palm 
Pilot) and to other applications outside of the software. 
 
 
 
 
 
 
 
 
 
 

Figure 9-4 
Calendar 

 
 
 
 
 
 
 
 
 
 
The Calendar also contains Search and Print features. 
 
Categories 

• To add a category to your Calendar, click the Edit drop-down menu and choose the 
Manage Categories option. 

• Select Add a New Category from the Categories drop-down menu. 

• Type the name of the new category into the Name text box.  

• Click Done to save the new category and return to the Calendar page.  You can also click 
Save & New to save the new category and add more new categories. 

Reminder 

• In the Reminder tab, you can choose to have a reminder sent to you prior to the event. 
 Click the Send me an email reminder about this event option. 

• From the drop-down menu, choose whether you want to be reminded one week or one 
day prior to the event.   

• Once you have entered all of the information necessary for your new event, click Done 
to save your changes. 

 
Share Data 
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A share feature has been built into the Calendar page component so that information entered on 
these pages may be shared from classroom to district, school to classroom, and from school to 
school. This feature results in information being entered in one area and having it shared 
throughout the entire website.  

• To share the data, you must be in Edit mode.  

• While on the Calendar page, choose the Share Data option in the Edit drop-down menu. 
This will open a new window with Summary, Pull Data, and Push Data tabs. 

Summary 

• The Summary tab shows the pages, if any, that data is being pulled or pushed from.  You 
can change the pages by clicking the page name in the page summary.  This will take you 
to the Pull tab or the Push tab where you can select or clear pages. 

Pull Data 

• Click the Pull Data tab to show a list of pages in your site.  

• Navigate to the page you want to pull data from, and then select the categories you 
want to place in your page.  

• Once you are finished choosing sites, click Done.  The data pulled from the other page 
will now appear on the site with a barrels icon next to the information instead of an Edit 
icon. This means that you will not be able to edit the information, since it is pulled from 
another page. If the information is changed on the original page, it will subsequently 
change the information on your page.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-5 
Show Other options 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• To remove the data from your page, click the Pull Data tab.  

• Clear the check box and click Done. The data will then be removed from your page. 
Push Data 

• To push data to another site, you must be a system administrator. This tab does the 
opposite of the Pull Data tab.  Instead of taking information from another site, you are 
giving information, or pushing data, to other sites throughout the district.  This feature 



Webtools Manual 

146 

can be used for district holiday schedules and other events you want to appear on other 
sites. 

• Click the Push Data tab.   

• Select the categories you want to place in your page.  

• Once you are finished choosing sites, click Done.  The data pushed to the other page will 
now appear on those sites with barrel icons next to the information instead of an Edit 
icon. This means that the information cannot be edited since it is pulled from another 
page. If the information is changed on the original page, it will subsequently change the 
information on your page.  

Import 
The Calendar page component also has an import feature providing an import template that will 
mass populate your Calendar page.  

• To import information onto your page, first download the Mass Data Import template 
from our Support & Services site.  

• Enter your information in the template. 

• Once the template is filled out, click the Import option in the Edit drop-down menu 
while in Edit Mode. 

• Click Browse to locate the template and then click Upload File. 
 
You also have the option to add a header that contains an image and text to the Calendar page. 
For more on adding images and text, see the Adding Pictures and Adding Text sections of this 
manual. 
 
Adding a New Event 

• To add an event to your Calendar, click the Add New Event option located in the Edit 
drop-down menu while in Edit Mode. 

 

 

For more information on adding text and using the ACE, see the Adding Text and 
Advanced Content Editor sections of this manual. 

 
General 

• Under the General tab, you can select the date of your event by either filling in the 
appropriate date in the space provided or by clicking the calendar icon and choosing a 
date from the date picker. 
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Figure 9-6 
New Event General Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 

• You can add the title of your event in the Title text box. 

• You have a text box where you can add additional information.  You also have the option 
to use the Advanced Content Editor. 

Options 

• Under the Options tab, you can choose to make your event either an all-day event, or 
you can enter in the start and end time for your event. 

• You may also choose to either show or hide the last user to edit this item by clicking the 
corresponding button. 

Styles 

• Click the Styles tab to choose the alignment, font size, and font color. 

• Select the Border box to open the border options.  Select the desired border color from 
the Color Picker and border size from the drop-down menu.  
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Figure 9-7 
Styles Tab 

 
 
 
 
 
 
 
 
 
 
 

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice appear in the Color box. 

Recurrences 

• To make the event recurring, such as a weekly or monthly meeting, or a weekly test, 
click the Recurrences tab. 

• Click Make Event Span/Recur. 

• A new screen will open giving you the option to have your event recur.  If your event 
occurs on specific weeks, choose from the weekly drop-down menu whether your event 
will occur one, two, three, or four weeks. 

 
 
 

 
 
 
 
 

Figure 9-8 
Recurrences 

 
 
 
 
 
 
 
 

• Next, 
choose 
what day 
your event 
will recur on. 

• Alternatively, if you have a recurring monthly event, you may choose from the drop-
down menu whether your event recurs on the first, second, third, or fourth of every 
month. 
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Lunch Menu 

 
Lunch Menu 
The Lunch Menu component makes it very convenient for your district schools to post lunch 
and/or breakfast menus. Many of the same functions and options of the Calendar can be used in 
setting up a menu. For more information on setting up events and categories and choosing display 
options, see the Calendar section. 
 
You also have the option to add a header that contains an image and text to the Lunch Menu 
page. For more on adding images and text, see the Adding Pictures and Adding Text sections of 
this manual. 
 

Page Setting Options 
The Page Setting Options for the Calendar and Lunch Menu components are the same. 

• You can access the Calendar Page or Lunch Menu Page Settings by navigating to the page 
and then selecting page setting from the Edit drop-down menu. A new window will 
appear. 

General 

• In the General tab, your first option is the title of the page.  You can rename the 
page in the text box next to Page Title. 

• You have the option to password-protect this page while in View Mode. 

• You can change the default appearance of your calendar by choosing from the 
Default Events drop-down menu.  You can choose from Today, Week, Month, and 
Upcoming views. 

• The next option is whether you would like to show the event details.  Simply choose 
Yes or No from the drop-down menu. 

• You can choose how many calendars (up to three) you want to appear next to your 
scheduled information.   

• You can next choose what side of the page you want your information to appear as 
well as the page alignment. 
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Figure 9-11 
General Tab 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• The Trim Color option lets you choose between the Page Title Colors for your 
calendar or the Home Page Box colors. 

• You can next choose whether or not to use background colors.  Selecting Yes  will use 
the colors from your subtitle boxes on your homepage and display backgrounds 
around the toolbar and calendar. 

• Next, you may choose the number of events to be shown per page, where you want 
the placement of the previous and next links, and whether or not you want to show 
the page numbers. 

• The last options under the General tab allow you to decide whether or not you want 
to have the details of the event open in a new window, if you want to allow the 
public to export this calendar, if you want to show last Edited By information and, 
finally, if you want to password-protect this page in View mode. 

Details 

• Under the Details tab, you have several options that have been explained in detail in 
the beginning of this chapter.   

• You can select any or all of the following options:  Syndicate this page with RSS, 
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Allow more than one picture and text box, Allow the public to subscribe to this 
page, Show Babel Fish translation box, Hide the Link in Navigation, Deny public 
access to the page, Make this page the homepage.  If you want to move the page, 
you may click the scissors icon. 

 
 
 
 
 
 
 
 
 
 
 

Figure 9-12 
Details Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Meta 

• In the Meta tab, add keywords or phrases to your page's meta tags for Internet search 
engines.  If these words are typed into the search engine, the search will include 
your site or page in the results.  

• You can type words such as your school's name, your event, or anything else you think 
someone who is interested in your page might look under. 

• Write a brief description of the page in the box provided. 

• Click Done when you are finished with the Page Settings options. 
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Meetings and Agendas 

 
Meetings and Agendas 
The Meetings and Agendas component is an easy way to organize your meetings schedule and to 
post meeting agendas and minutes. 
 
Share Data 
A share feature has been built into the Meetings and Agendas page component so that 
information entered on these pages may be shared from classroom to district, school to 
classroom, and school to school. This allows you to enter information in one area and have it 
shared throughout the entire website.  
 

• To share the data, you must be in Edit mode.  

• While on the Meetings and Agenda page, choose the Share Data option from the Edit 
drop-down menu. This will open a new window with Summary, Pull Data, and Push Data 
tabs. 

Summary 

• The Summary tab shows the pages, if any, that data is being pulled or pushed from.  You 
can change the pages by clicking the page name in the page summary.  This will take you 
to the Pull tab or the Push tab where you can select or clear pages. 

Pull Data 

• Click the Pull Data tab to show a list of pages in your site.  

• Navigate to the page you want to pull data from, and then select the categories you 
want to place in your page.  

• Once you are finished choosing sites, click Done.  The data pulled from the other 
page will now appear on the site with a barrels icon located next to the information 
instead of an Edit icon. This means that you will not be able to edit the information 
since it is pulled from another page. If the information is changed on the original 
page, it will subsequently change the information on your page.  

• To remove the data from your page, click the Pull Data tab.  

• Clear the check box and click Done. The data will then be removed from your page. 
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Figure 9-13 
Pull Data 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Push Data 

• To push data to another site, you must be a system administrator. This tab does the 
opposite of the Pull Data tab.  Instead of taking information from another site, you 
are giving information, or pushing data, to other sites throughout the district.  This 
can be used for district holiday schedules and other events you want to appear on 
other sites. 

• Click the Push Data tab.   

• Select the categories you want to place in your page.  

• Once you are finished choosing sites, click Done.  The data pushed to the other page 
will now appear on those sites with barrel icons located next to the information 
instead of an Edit icon. This means that the information cannot be edited since it is 
pulled from another page. If the information is changed on the original page, it will 
subsequently change the information on your page.  
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Figure 9-14 
Push Data 

 
 
 
 
 
 
 
 
 
 
Import 
The Meetings and Agendas page component also has an import feature with an import template 
that will mass populate your Meetings and Agendas page.  

• To import information onto your page, first download the Mass Data Import template 
from our Support & Services site.  

• Enter your information in the template. 

• Once the template is completed, click the Import tab and then follow the on-screen 
instructions. 

 
Adding a New Event 

• To add an event to your Calendar, click the Add New Event option located in the Edit 
drop-down menu while in Edit Mode. 

 

 

For more information on adding text and using the ACE, see the Adding Text and 
Advanced Content Editor sections of this manual. 

 
General 

• Under the General tab, you can select the date of your event by either filling in the 
appropriate date in the space provided or by clicking the calendar icon and choosing a 
date from the date picker. 
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Figure 9-15 
New Events General Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 

• You can add the title of your event in the Title text box. 

• You have a text box where you can add additional information.  You also have the option 
to use the Advanced Content Editor. 

Options 

• Under the Options tab, you can choose to make your event either an all-day event, or 
you can enter in the start and end time for your event. 

 
 
 
 
 
 
 
 
 
 

Figure 9-16 
Options 

 
 
 
 
 
 
 
 
 
 

• You may also 
choose to 
either show or 
hide the last 
user to edit this 
item by clicking 
the 
corresponding 
button. 

Styles 
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What's New 

 
What’s New 
The What's New component allows you to post current news, events, and updates to your site on 
one page. The initial viewing defaults for visitors can be altered to either display the details or 
just the title of the new item (which doubles as a link to the details).  
 
Share Data 
A share feature has been built into the What's New page component so that information entered 
on these pages may be shared from classroom to district, school to classroom, and school to 
school. This allows you to enter information in one area and have it shared throughout the entire 
website.  
 

• To share the data, you must be in Edit mode.  

• While on the What's New page, choose the Share Data option in the Edit drop-down 
menu. This will open a new window with Summary, Pull Data, and Push Data tabs. 

Summary 

• The Summary tab shows the pages, if any, that data is being pulled or pushed from. 
 You can change the pages by clicking the page name in the page summary.  This will 
take you to the Pull tab or the Push tab, where you can select or clear pages. 

Pull Data 

• Click the Pull Data tab to show a list of pages in your site.  

• Navigate to the page you want to pull data from and then select the categories you 
want to place in your page.  

• Once you are finished choosing sites, click Done.  The data pulled from the other 
page will now appear on the site with a barrels icon located next to the information 
instead of an Edit icon. This means that you will not be able to edit the information, 
since it is pulled from another page. If the information is changed on the original 
page, it will subsequently change the information on your page.  

• To remove the data from your page, click the Pull Data tab.  

• Clear the check box and click Done. The data will then be removed from your page. 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-17 
Summary Tab 
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Push Data 

• This tab does the opposite of the Pull Data.  To push data to another site, you must 
be a system administrator. Instead of taking information from another site, you are 
giving information, or pushing data, to other sites throughout the district.  This can 
be used for District holiday schedules and other events you want to appear on other 
sites. 

• Click the Push Data tab.   

• Select the categories you want to place in your page.  

• Once you are finished choosing sites, click Done.  The data pushed to the other page 
will now appear on those sites with barrel icons located next to the information 
instead of an Edit icon. This means that the information cannot be edited, since it is 
pulled from another page. If the information is changed on the original page, it will 
subsequently change the information on your page.  

 
 
 
 
 
 
 
 
 

Figure 9-18 
Push Data 

 
 
 
 
 
 
 
 
 
 
Import 
The What's News page component also has an import feature with an import template that will 
mass populate your What's New page.  

• To import information onto your page, first download the Mass Data Import template 
from our Support & Services site.  

• Enter your information in the template. 

• Once the template is completed, click the Import tab and then follow the on-screen 
instructions. 

Adding a New Event 

• To add an event to your What's New page, click the Add New Event option located in 
the Edit drop-down menu while in Edit mode. 

 

 

For more information on adding text and using the ACE, see the Adding Text and 
Advanced Content Editor sections of this manual. 

 
General 

• Under the General tab, you can select the date of your event by either filling in the 
appropriate date in the space provided or by clicking the calendar icon and choosing a 
date from the date picker. 
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Figure 9-19 
New Event General Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 

• You can add the title of your event in the Title text box. 

• You have a text box where you can add additional information.  You also have the option 
to use the Advanced Content Editor. 

Options 

• Under the Options tab, you can choose to make your event either an all-day event, 
or you can enter in the start and end time for your event. 

• You may also choose to either show or hide the last user to edit this item by clicking 
the corresponding button. 

Styles 

• Click the Styles tab to choose the alignment, font size, and font color. 

• Select the Border box to open the border options.  Choose the desired border color from 
the Color Picker and border size from the drop-down menu.  
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Figure 9-20 
Styles 

 
 
 
 
 
 
 
 
 
 
 
 

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 

Attachments 

• In the Attachments tab, you can add an image, link, or file to your event by clicking the 
corresponding button.  Follow the instruction as detailed in Chapter 7 - Editing Your 
Webpage for specific instructions on adding images, links and attachments. 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-21 
Attachments 

 
 
 
 
 
 
 
 
 
 



Webtools Manual 

162 

Showing/Hiding Details 
Visitors to your site have the option to show the details of the events by clicking Show Details. 
You can also hide the details to get a quick glance at all events by clicking Hide Details. 
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Contact Directory 

 
Contact Directory 
The Contact Directory allows you to list your administrators, teachers, and staff in an organized 
and attractive manner by creating categories.  These categories list the district’s personnel as 
well as provide direct email links. 
 
Add a Category 

• To add a category to your Contact Directory page, click the Add New Directory 
option in the Edit drop-down menu. The category link will be displayed on your site.  

• To edit the category, click the Edit icon if in Legacy Mode.  If in New Mode, choose 
the Edit Directory option. 

• Add the information for the category in the pop-up window that opens.  
General 

• Under the General tab, you can add the title of your category in the Title text box. 

• You have a text box where you can add additional information.  You also have the option 
to use the Advanced Content Editor. 
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Figure 9-22 
Contact Directory 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Adding Contacts to Categories 

• To add a contact to the category you have created, click the name of the category. 

• A new window will open where you can choose the Add New Contact option from the 
Edit drop-down menu. This will display the words: (No Name Entered) (New Item).  

• Click the Edit icon if in Legacy Mode.  In New Mode, click the edit icon to open the 
drop-down menu.  Choose the Edit Contact option.  

 

 

This feature is useful when moving contacts from category to category. 
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• A new window will open.  Choose the contact's category from the drop-down menu. 

• Enter the pertinent information for the contact in the text boxes provided. Once all the 
information has been entered, you can return to the main category page by clicking 
Done. 

 

 

Contacts will be listed by last name. 

 

If you have specified in the Page Settings to not show email addresses, then this 
particular information will not be displayed. 

 
Styles 

• Click the Styles tab to choose the alignment, font size, and font color. 

• Select the Border box to open the border options.  Choose the desired border color 
from the Color Picker and border size from the drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 

Attachments 

• In the Attachments tab, you can add an image, link, or file to your event by clicking the 
corresponding button.  Follow the instruction as detailed in Chapter 7 - Editing Your 
Webpage for specific instructions on adding images, links and attachments. 

• Once you have entered the information for the category, click Done to save it.  
 
Contact Directory Sharing 
Like the Calendar, the Contact Directory also includes a built-in share feature and an importing 
data feature.  These features allow information to be entered in one area and shared throughout 
the entire website and allow information to be imported from other sources.  

• To share the data, you must be in Edit mode.  

• While on the Contact Directory page, choose the Share Data option from the Edit drop-
down menu. This will open a new window with Summary, Pull Data, and Push Data tabs. 

Summary 

• The Summary tab shows the pages, if any, that data is being pulled or pushed from.  You 
can change the pages by clicking the page name in the page summary.  This will take you 
to the Pull tab or the Push tab, where you can select or clear pages. 

Pull Data 

• Click the Pull Data tab to show a list of pages in your site.  

• Navigate to the page you want to pull data from, and then select the categories you 
want to place in your page.  

• Once you are finished choosing sites, click Done.  The data pulled from the other 
page will now appear on the site with a barrels icon located next to the information 
instead of an Edit icon. This means that you will not be able to edit the information, 
since it is pulled from another page. If the information is changed on the original 
page, it will subsequently change the information on your page.  
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Figure 9-23 
Show Other options 

 
 
 
 
 
 
 

• To remove the data from your page, click the Pull Data tab.  

• Clear the check box and click Done. The data will then be removed from your page. 
Push Data 

• This tab does the opposite of the Pull Data tab.  To push data to another site, you 
must be a system Administrator. Instead of taking information from another site, you 
are giving information, or pushing data, to other sites throughout the district.  This 
can be used for district holiday schedules, and other events you want to appear on 
other sites. 

• Click the Push Data tab.   

• Select the categories you want to place in your page.  

• Once you are finished choosing sites, click Done.  The data pushed to the other page 
will now appear on those sites with barrel icons located next to the information 
instead of an Edit icon. This means that the information cannot be edited, since it is 
pulled from another page. If the information is changed on the original page, it will 
subsequently change the information on your page.  

 
 
 
 
 
 
 
 

Figure 9-24 
Push Data 
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Importing Data 
The Contact Directory page component also has an import feature with an import template that 
will mass populate your Contact Directory page.  

• To import information onto your page, first download the Mass Data Import template 
from our Support & Services site.  

• Enter information into the template. 

• Once the template is completed, click the Import tab and then follow the on-screen 
instructions. 

 
You also have the option to add a header that contains an image and text to the Contact 
Directory page. For more on adding images and text, see the Adding Pictures and Adding Text 
sections of this manual. 
 

School Board 
The School Board component provides a place to post important information about your district's 
school board on your district website. By posting information under categories that you create, 
the School Board component becomes an easy-to-use spot for visitors to learn more about your 
district’s school board members. 
 
Add a Category 

• To add a category to your Contact Directory page, click the Add New Directory 
option in the Edit drop-down menu. The category link will be displayed on your site.  

• To edit the category, click the Edit icon if in Legacy Mode.  If in New Mode, choose 
the Edit Directory option. 

• Add in the information for the category in the pop-up window that opens.  
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-25 
New Category General Tab 
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General 

• Under the General tab, you can add the title of your category in the Title text box. 

• You have a text box where you can add additional information.  You also have the option 
to use the Advanced Content Editor. 

 

 

For more information on adding text and using the ACE, see the Adding Text and 
Advanced Content Editor sections of this manual. 

 
 
 
 
 
 
 
 

Figure 9-26 
Advanced Content Editor 

 
 
 
 
 
 
 
 
Adding Contacts to Categories 

• To add a contact to the category you have created, click the name of the category. 

• A new window will open where you can choose the Add New Contact option from the 
Edit drop-down menu. This will display the words: (No Name Entered) (New Item).  

• Click the Edit icon if in Legacy Mode.  In New Mode, click the edit icon to open the drop-
down menu.  Choose the Edit Contact option.  

 

 

This is useful when moving contacts from category to category. 

 

• A new window will open.  Choose the contact's category from the drop-down menu. 

• Enter the pertinent information for the contact in the text boxes provided. Once all the 
information has been entered, you can return to the main category page by clicking  
Done. 

 

 

Contacts will be listed by last name. 

 

If you have specified in the Page Settings to not show email addresses, then this 
particular information will not be displayed. 

 
Styles 

• Click the Styles tab to choose the alignment, font size, and font color. 

• Select the Border box to open the border options and choose the desired border color 
from the Color Picker and border size from the drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 



Chapter 9 - Page Components 

169 

background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 

Attachments 

• In the Attachments tab, you can add an image, link, or file to your event by clicking the 
corresponding button.  Follow the instruction as detailed in Chapter 7 - Editing Your 
Webpage for specific instructions on adding images, links, and attachments. 

• Once you have entered the information for the category, click Done to save it.  
 
 
 
 
 
 
 
 
 
 
 

Figure 9-27 
Attachments Tab 

 
 
 
 
 
 
 
 
 
 
 

Page Settings 
Page Settings options for both the School Board component as well as the Contact Directory 
component are the same. 

• To access Page Setting, navigate to your School Board or Contact Directory page and 
click the Edit drop-down menu. 

• Choose Page Settings from the listing of options.  A new window will open. 
 
General 

• Under the General tab in the new window, you can name your page in the text box 
provided. 
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Figure 9-28 
Page Settings 

 
 
 
 
 
 
 
 
 

 

• Next, you can choose to give the page a subdirectory.  Type the name of the 
subdirectory listing. 

• You can choose to password-protect this page while in View Mode. 

• You are now given the options to show email addresses for those listed in your contact 
directory or school board, as well as the option to show an alphabetical index. 

• You have the option to allow the public to export the contact information. 

• Finally, the General tab is where you can password-protect the page. 
Details 

• Under the Details tab, you have the following options: Allow more than one picture and 
text box, Allow the public to subscribe to the page, Show a Babel Fish translation 
box, Hide the link in your navigation, Deny public access to this page, Make this page 
the homepage, and Move the page to another section.   

 
 
 
 
 
 
 
 
 
 
 

Figure 9-29 
Details  

 
 
 
 
 
 
 
 
 
 

• If you require more information on the Page Settings option, please refer to the Page 
Setting section in the beginning of this chapter. 
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Meta 

• In the Meta tab, add keywords or phrases to your page's meta tags for Internet search 
engines.  If these words are typed into the search engine, the search will include your 
site or page in the results.  

• You can type words such as your school’s name, your event, or anything else you think 
someone who is interested in your page might look under. 

• Write a brief description of the page in the box provided. 

• Click Done when you are finished with the Page Settings options. 
 
 
 
 
 
 
 

Figure 9-30 
Meta Tab 

 

 
 
 
 
 
 
 
 
Layouts 

• The Layout tab gives you three options for listing your contact information.  Within each 
option you can choose the number of columns you want to appear on your page. 

• Choose the Vertical Layout if you want contacts to appear vertically down the page. You 
may specify the number of columns to divide the contacts into by selecting your option 
from the drop-down menu. 

• Choose the Horizontal Layout to list contacts horizontally across the page. You may 
specify the number of columns to divide the contacts into by selecting your option from 
the drop-down menu. 

• Choose the Staggered Layout to alternate the position of contacts from left to right as 
they are listed down the page.  This option does not give you the option for multiple 
columns. 

• Once you have chosen the Layout for your page, click Done.   

• Pages can be deleted from Page Settings by clicking Delete. 
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Figure 9-31 
Layouts Tab 
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Contact Form 

 
Contact Form & Custom Form Page 
The Contact Form is an easy way for visitors to your page to contact you. The contents of the 
form can either be emailed to you or saved on your site.  
 

• To start using the contact form, navigate to the page and choose Page Settings from the 
Edit drop-down menu. 

General 

• By adding your email address to the Page Settings in the General tab, you create the 
standard Contact Form. People can now contact you without you revealing your Email 
Address.  

• Once you click View Page, you can view your page as your visitors would. 

• When a visitor to your site has filled out the contact form, they can click Send Now and 
the contents of the form will be emailed or stored, depending on your Page Settings.  

 
 
 
 
 
 
 
 
 
 
 

Figure 9-32 
Contact Form General 

Tab 

 
 
 
 
 
 
 
 
 
 
 

• Also, under the General tab, you can change the name of your Contact Form page by 
entering text in the corresponding text box. 

• Next, choose the storage options for the form.  From the drop-down menu you can 
choose Store data or Do not store data. 

• When someone has filled out the contact form, you can choose how you want to be 
notified.  From the drop-down menu you can choose to have the contents of the form 
emailed to you, notification of a form emailed to you, or no notification. 

• Your final option under the Contact Form is to choose whether or not you want to 
password-protect the page. 

Details 

• Under the Details tab, you have the following options: Allow more than one picture 
and text, Allow the public to subscribe to the page, Show Babel Fish translation box, 
Hide the link in your navigation, Deny public access to this page, Make this page the 
homepage, or Move the page to another section.   
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• If you require more information on the Page Settings Option, please refer to the Page 
Setting section in the beginning of this chapter. 

Meta 

• In the Meta tab, add keywords or phrases to your page's meta tags for Internet search 
engines.  If these words are typed into the search engine, the search will include your 
site or page in the results.  

• You can type words such as your school's name, your event, or anything else you think 
someone who is interested in your page might look under. 

• Write a brief description of the page in the box provided. 

• Click Done when you are finished with the Page Settings options. 
 
 
 
 
 
 
 
 

Figure 9-33 
Meta Tags 

 
 
 
 
 
 
 
 

• On the Contact Form page you also have the option to add a header that contains a 
picture and text. For more on adding pictures and text, view Adding Pictures and 
Adding Text in Chapter 7 - Editing Your Webpage. 

Checking stored contact form messages 

• To check your stored contact form messages, click the Edit drop-down menu and then 
click the Read Message option. 

• The Read Message (#) option will contain list of messages. If the form has been filled 
out on multiple days, the dates will be listed, and you can click the date to see the 
messages for that date.  

• To delete a message, click Delete, or click the Purge All option in the Edit drop-down 
menu to remove all the messages. 

 
Exporting Messages 

• You can export all of your saved Contact Form messages by clicking the Export option in 
the Edit drop-down menu. The contents of the messages will be placed into a comma-
separated form. 

• You also have the option to add a header that contains an image and text to the Contact 
Form page.  

• For more on adding images and text, see the Adding Pictures and Adding Text in 
Chapter 7 - Editing Your Webpage. 
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Creating a Custom Contact Form 

 
Create a Custom Form 
As a customized version of the Contact Form, the Create a Custom Form allows you to create a 
form for particular needs or for particular purposes, such as a field trip or questionnaire.  

• To create a custom form, click the Create Form option from the Edit drop-down menu.  

• You can begin building your custom form by clicking the Add to Form link.  

• Select a form option from the left side of the window, and then click the Add to Form 
link.  

• The options listed on the left are: text input, text area, radio button, radio button with 
other, check box, select list, note field, line break, page break, formal name, phone 
number, address, state list, school list, year list, date, time, gender, option ranking. 
 To add one of these options to your form, click the green + button located next to the 
option you want to add. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-34 
Create Custom Form 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Enter the necessary information for each option you choose to add to your form. 

• The Text Styles box allows you to choose the alignment, font size, and font color. 

• Select the Border box to open the border options.  Choose the desired border color 
from the Color Picker and border size from the drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 

• Continue until you have added all the elements you want to your custom form.  

• You can preview your form at any time by clicking the Preview your form link. 

• When you are ready to save your form, click the Preview your form link, then click the 
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Save your form (finish) link. Your custom form will then be placed on your page. 
 
You have the option to add a header that contains an image and text to the Create a Custom 
Form page. For more on adding images and text, see the Adding Pictures and Adding Text 
sections of this manual. 
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Document Manager 

 
Document Manager 
The Document Manager feature allows you to upload files to your site that you want to make 
available for download to your visitors. Anything from student work to permission slips to 
homework assignments can be posted here for easy visitor access. 
 

 

Files on floppy disks or CD-ROM disks must first be placed on the hard-drive 
before being uploaded. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-35 
Document Managers 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Adding a Category 

• To add a category to your Document Manager page, click the Manage Categories option 
in the Edit drop-down menu from you Document Manager page. 

• Click Add New in the pop-up window that opens. 

• You have a text box where you can add the category title.  Type the title of your new 
category. 

• The next option is to choose whether or not you want your category to have a Parent 
category.  For example, if you are posting homework assignments, you can create a 
category called "Homework."  "Homework" would be the parent.  You can then add 
categories such as, "English," "Math," and other subjects with "Homework" being the 
Parent category.  This will create different document directories on your documents 
page. 

• The description is the next field.   You also have the option to use the Advanced Content 
Editor to fill out the category description. 
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Styles 

• Click the Styles tab to choose the alignment, font size, and font color. 

• Select the Border box to open the border options.  Choose the desired border color from 
the Color Picker and border size from the drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 

Attachments 

• In the Attachments tab, you can add an image, link, or file to your event, by clicking the 
corresponding button.  Follow the instruction as detailed in Chapter 7 - Editing Your 
Webpage for specific instructions on adding images, links and attachments. 

 
 
 
 
 
 
 
 

Figure 9-36 
Attachments 

 
 
 
 
 
 
 

• Once you have entered the information for the category, click Done to save it.  
 

 

For more information on adding text and using the ACE, see the Adding Text and 
Advanced Content Editor sections of this manual. 

 
Adding a File 

• To add a file to the Document Manager, click the Add New Document option under the 
Edit drop-down menu. 

• A new window will open.  You have three options for uploading documents:  Enhanced 
Mode, Standard Mode, and Remote File. 

Standard Mode 

• To use Standard Mode, click Standard Mode and then click Select Upload Method. 

• To add a document from your computer, click Browse. 

• Select the document file you want to add by double-clicking it. 

• Click Upload file.  

• After your file uploads, you can browse for another file or click Done. 

• You can change your file name in the text box provided. 

• Choose the category you want to place the file in by selecting the correct category from 
the drop-down menu. 

• If you no longer want this document uploaded, you can select the Delete option. 

• You can enter a description of your document by clicking the edit icon in the description 
field and entering your description in the pop-up window. 

• Click Done to save your changes. 
Enhanced Mode 

• To add files using Enhanced Mode, you will need to have Java™. 
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• Click the Add New Document from the Edit drop-down menu. 

• Click the Enhanced Mode option and then click Select Upload Method. 

• To add files, you can click Add in the new window to open a file browser to select 
individual or multiple files.  After you have selected your files from the browser click 
Open.  Alternatively, you can open a file browser.   

• Once you have opened the browser and navigated to the files you want to add, simply 
drag and drop them into the SchoolCenter window. 

• Once you have dragged and dropped the files you are adding to your page, click Done. 

• In the new window, you can change your file name in the text box provided. 

• Choose the category you want to place the file by selecting the correct category from 
the drop-down menu. 

• If you no longer want this document uploaded, you can select the Delete option. 

• You can enter in a description of your document by clicking the edit icon in the 
description field and entering your description in the pop-up window.   

• Once you click, your files will be added to your page. 
Remote Mode 

• To add files using Remote Mode, click Add New Document from the Edit drop-down 
menu. 

• Click the Remote File option. 

• Click Select Upload Method and a new window will open. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-37 
Remote File Link 

 
 
 
 
 
 
 
 
 
General 

• Under the General tab, you can first select the category that best applies to your 
document from the drop-down menu. 

• In the text box for file location, enter in the web address of your remote file. To obtain 
the address of the remote file, you can right-click the file and select copy link location. 
 Once you are uploading it to your page, simply select paste by right-clicking over the 
text box, or clicking Ctrl+V. 

• You can then fill out the document's name and a description of the file.  
Options 

• Under the Options tab, you choose whether or not to show the date the document was 
added. 
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Styles 

• Under the Styles tab, you can select options for the text, such as font size, alignment, 
color, bold, italics, underlined, etc.  

• You have the option to make the text HTML friendly, which means that any code you 
enter as text will be applied after you save your entry. 

 
 
 
 
 
 
 
 

Figure 9-38 
Styles 

 
 
 
 
 
 
 
 

• When you have finished choosing the style of your text, click Done.  Your linked 
document will be shown in View Mode. 

Once files have been uploaded into the Document Manager, you can sort the order in which they 
appear.  

• To do this, click the arrows next to the header you want to sort in ascending or 
descending order. 

 

 

There are 350 acceptable file types.  For a complete list, visit our Support & 
Services website. File sizes are limited to 10mb each. 

Like the Calendar and the Contact Directory, the Document Manager also includes a built-in 
share feature and an importing data feature.  These features allow information to be entered in 
one area and shared throughout the entire website and allows information to be imported from 
other sources.  
 
Podcast 

• To add files for podcast, click Page Settings and then select the Advanced tab.  

• Click the box next to Enable Podcast Support and then click Done.  Podcast settings will 
appear as a tab when you are in Edit mode.   

• To edit your podcast setting, click the Podcast tab to enter in your information. You 
must fill out the information in settings for the podcast files to be accessible. 

• Once the setting information has been completed, two options for subscribing to podcast 
will appear. One is a link for a subscription to the podcast and the other is a link to 
subscribe through iTunes.  

• To copy the location, right-click the podcast icon and copy. There is a 10mb limit to the 
files that can be stored in a document manager. 

 
Upload files for podcast the same way you would for documents. 
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School Policies 

 
School Policies 
The School Policies component allows you to set up policy categories and post documents under 
those categories for your site visitors to download. 
 

 

Files on floppy disks or CD-ROM disks must first be placed on the hard-drive 
before being uploaded. 

 
Adding a Category 

• To add a category to your Document Manager page, click the Manage Categories option 
in the Edit drop-down menu from your Document Manager page. 

• Click Add New in the pop-up window that opens. 

• You have a text box where you can add the category title.  Type the title of your new 
category. 

• The next option is to choose whether or not you want your category to have a Parent 
category.  For example, if you are posting homework assignments, you can create a 
category called "Homework."  "Homework" would be the parent.  You could add 
categories, such as "English," "Math," and other subjects with "Homework" being the 
Parent category.  This will create different document directories on your documents 
page. 

• The description is the next field.   You also have the option to use the Advanced 
Content Editor to fill out the category description. 

 

 

For more information on adding text and using the ACE, see the Adding Text 
and Advanced Content Editor sections of this manual. 

 
Adding a File 

• Adding a file for School Policies operates the same as adding a file for the Document 
Manager.  For a detailed list of instructions on adding a document, look at the 
Document Manager portion of this manual, in Chapter 10 - Page Components, which is 
the page component explained immediately prior to this one. 

 
Once files have been uploaded into the Document Manager, you can then sort the order in 
which they appear. To do this, enter numbers in the Sort column of the manager and then click 
Sort. 
 

 

There are 350 acceptable file types.  For a complete list, visit our Support & 
Services website. File sizes are limited to 10mb each. 

 
Like the Calendar and the Contact Directory, the School Policies page also includes a built-in 
share feature and an importing data feature.  These features allow information to be entered in 
one area and shared throughout the entire website and allow information to be imported from 
other sources.  
 
You also have the option to add a header that contains an image and text to the School Policy 
page. For more on adding images and text, see the Adding Pictures and Adding Text sections 
of this manual. 
 

Page Settings 



Webtools Manual 

182 

The Page settings for the Document Manager and School Policies is the same.  

• To access Page Settings, simply select Page Settings from the Edit drop-down menu. A 
new window will open. 

• In the General tab, you can change the name of your page by typing the title you want 
in the Page Title text box. 

• You can enter a Subdirectory title and password-protect the page while in View mode. 
 

• Next, you can choose how you would like your categories sorted.  You have the options 
of sorting via alphabetical order or reverse alphabetical order in the corresponding 
drop-down menu. 

 
 
 
 
 
 
 
 
 
 

Figure 9-39 
General Tab 

 
 
 
 
 

 
 
 
 
 

• You are given four additional options in the General tab. 

• You can choose to hide other categories when you are viewing a category.  

• You can choose to show the descriptions of the documents when the cursor is hovered 
over them. 

• You can choose to enable podcast support. 

• You can choose to have this page password protected while in View mode.  
Details 

• In the Details tab, you have many of the same options as in earlier pages.  They are as 
follows:  Syndicate this page with RSS, Allow more than one picture and text, Allow 
the public to subscribe to this page, Show Babel Fish translation, Hide link in 
navigation, Deny public access to the page, Make this page the homepage, and Move 
this page to another a section.  These options are all explained in greater detail in the 
beginning of this chapter. 
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Figure 9-40 
Details Tab 

 
 
 
 
 
 
 
 
 
 
 

 
Meta 

• In the Meta tab, add keywords or phrases for your page's meta tags for Internet search 
engines.  If these words are typed into the search engine, the search will include your 
site or page in the results.  

• You can type words such as your school's name, your event, or anything else you think 
someone who is interested in your page might look under. 

• Write a brief description of the page in the box provided. 

• Click Done when you are finished with the Page Settings options. 
 



Webtools Manual 

184 

 

Boards 
 

Visitors to your site can use Boards to discuss and reply to threaded discussions. Boards are 
useful for such things as collecting community opinions on important issues, showing pride for 
school sports teams, and asking questions of teachers and administrators. There are three 
different board options in SchoolCenter WebTools.  You can have a Blog, a Board, or a 
Guestbook. 
 
In addition, to keep unwanted content from appearing on your website, the boards can be set 
up so that any post to the board has to be approved by you.  You can also choose to allow 
anonymous users to view the board or post to the board.  Much of the information for all three 
types of boards is the same. 
 
Adding Categories 
Categories separate out your boards more clearly.  They show what the boards will be about in 
a general capacity. 

• To add a category to your Board page, click the Manage Categories option from the 
Edit drop-down menu. A new window will open. 

• Click New. 

• In the new window, enter the title of the new category, and then click Done to save 
the category. The new category will be displayed. 

• You can choose to add more categories by clicking the New button again and repeating 
the steps listed above.   

• If have added all of the categories you would like, click Done to save your information 
and return to your page. 

 
 
 
 
 
 
 
 

Figure 9-41 
Board Categories 

 
 
 
 
 
 

• To edit any category, click the Edit button to the left of the Forum title bar and choose 
the category you want to edit from the drop-down menu provided.  

 

 

For more information on adding text and using the ACE, see the Adding Text and 
Advanced Content Editor sections of this manual. 

 
Adding boards 
You can post more than one board on the board page at any time.  The boards are the main 
topic area, where threads pertaining to the board are contained.   For each board you create, 
you need to select viewing and posting options. 

• To add a new board, click the Add New board option in the Edit drop-down menu.  
General 

• Choose a category from the drop-down menu in the General tab of the new window 
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that opens. 

• Type a title for your new board, and enter in a description in the corresponding text 
boxes. 

Options 

• In the Options tab, you can choose to allow anonymous users to view the board.  If you 
choose not to allow anonymous users to view the board, only users signed into the 
SchoolCenter software with a user ID and password will be able to view the board.  
Anonymous users will not be able to see the board. 

• You also can choose to allow anonymous users to post to the board.  If you choose not 
to allow anonymous users to post to the board, only signed in users will be able to post 
the board.  Anonymous users will not be able to post to the board unless this option is 
selected. 

• Once you are finished making selecting your options, click Done. 
 
You also have the option to add a header that contains an image and text to the board page. 
For more on adding images and text, see the Adding Pictures and Adding Text sections of this 
manual. 
   

 

You must select viewing options for each board you create.  If you do not select 
Allow anonymous users to view the board than only users signed into the 

SchoolCenter 
software with a user ID and password will be able to view the board. 

 
Adding Threads to Categories 
A thread is a set of posts on a board, composed of an initial post about a topic and all responses 
to it. 

• To add a thread to the category you have created, click the name of the category link. 

• Click the new thread link. A new window will open. 
General 

• In the General tab, your sign in name will automatically appear, or you can fill in a 
different name in the corresponding text box. 

• Enter in the title of the new thread in the corresponding text box. 

• You can choose where you would like your new thread to appear by choosing from the 
categories listed in the Board drop-down menu. 

• Next, you are given the option of choosing what type of thread this will be.  From the 
drop-down menu, you can choose normal, sticky, or announcement. While normal 
threads can be posted by anyone, a sticky or announcement thread can be created by 
page owners.  These threads will remain at the beginning of the board until the user 
decides to change it. 
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Figure 9-42 
Board General Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• The next option you have for the thread is choosing between normal and locked.  A 
normal thread is open for others to post comments.  A locked thread will allow online 
board administrators the option of posting.  Sometimes if a thread wanders off topic, or 
becomes continually inappropriate, it is necessary to lock it to prevent further postings. 
 The thread will then no longer be posted on.  Since the newest postings appear first, 
the locked thread will eventually be the last thread in the queue. 

• Enter your message in the text box provided or choose the Advanced Content Editor for 
more options, such as font colors, sizes, and alignments.  The Advanced Content Editor 
can also be used to add links and images.  For more information on SchoolCenter 
WebTools Advance Content Editor, see Chapter 7 - Editing Your Webspace for a 
detailed description of the various options listed under the Advanced Content Editor. 

Styles 

• Click the Styles tab to choose the alignment, font size, and font color. 

• Select the Border box to open the border options.  Choose the desired border color 
from the Color Picker and border size from the drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 
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Figure 9-43 
Board Styles Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 

• Click Done to save and post the new thread. 
 
Posting a Message 

• To post a message, click the Post Reply link.  A new window will open. 
General 

• Posting a message is simpler than starting a thread because you have fewer options. 
 Under the General tab, you can change your name from the default of your sign-in 
name in the appropriate text box. 

• Next, you can write your message by either entering text into the Message box or by 
using the Advanced Content Editor. 
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Figure 9-44 
Message Window 

 
 
 
 
 
 
 
Quoting a Message 
Often, especially in busy threads, 
it is helpful to clarify your response by quoting the thread you are responding to.  

• In the upper right corner of each posted message is a Quote link.  To respond to the 
message using quoted text, click this link. 

• A new window will open that is identical to the Posting a Message window.  In the 
message box, the message you quoted will appear first.  You can then follow the 
guidelines listed above for posting a message.  Even though you have quoted text, you 
can still use the Advanced Content Editor and all of the other functions listed above. 

 
 
 
 
 
 
 
 
 
 
 

 
Figure 9-45 
General Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• You will see after your message is completed that the quoted text is clearly separated 
from your message. 

If you have your page set to Approve Posts, you will have to approve the message before it can 
be published on the thread. 
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Approving Posts 
The Board can be set up so that any post to the board has to be approved by you to keep 
unwanted content from appearing on your website. 

• To check your board posts, click the You have (#) post pending approval option in the 
Edit drop-down menu. You can see all pending messages posted on your board.  

• Click Edit to review and approve any and all messages as posts. 

• Once you have reviewed a message, click Done to publish or to save the post or click 
Delete to remove the pending message from the site. 

 

Blog 
Like the board, the Blog is a way for visitors to your site to view and reply to threaded 
discussions, with the initial thread being the blog entry. A blog is a thread-based discussion 
method. You create blog entries and decide if you would like to allow users to post comments 
on them.  
 
The method for utilizing blogs is the same as that listed for the boards, listed above in detail.  
However, in the blog format instead of creating new threads, you are creating new blogs.  You 
can choose the options for your blog by selecting Page Settings from the edit drop down menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-46 
Blog 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Webtools Manual 

190 

Guest Book 
The Guest Book feature can be used by visitors to leave a message after visiting your website. 
 As with the Board and Blog formats, your page options are the same, but the Guestbook layout 
is different.  Instead of creating threads for discussion, you are simply creating messages for 
that will be posted. 

• To post a message on the Guestbook, click the Sign Guestbook link.  A new window will 
open. 

• This window does not contain any tabs.  Instead you have the name option which 
automatically defaults to your screen name unless you opt to change it in the Name 
text box. 

• Next is the text box for your Guestbook message.  You can simply type your message in 
the text box provided or you can use the Advanced Content Editor for more entry 
options.  The Advanced Content Editor is explained in detail in Chapter 7 - Editing 
Your Webpage. 

• Click Done after you have finished entering or editing your message. 
 
Watch This Guestbook 

• If you would like to receive email messages when entries are made to the guestbook, 
click the Watch This Guestbook link. 

• In the new window that opens, enter in your email address to receive email notification 
of guestbook changes. 

• Click Done to save you email address. 
Signing the Guest Book 

• To sign the Guest Book, click the link [Sign Guest Book] and fill out the information for 
the post.  

• When you have entered the information, click the Sign Guest Book button. 
 
If you have your page set to Approve Posts, you will have to approve the message before it can 
be published on the site. 
 
 
 
 
 
 
 
 
 
 

Figure 9-47 
Message Screen 

 
 
 
 
 
 
 
 
 
 
 
Approving Posts 

• To check your 
Guest Book posts, click the You have (#) post pending approval option in the Edit 
drop-down menu. You can see all pending messages posted on your Guest Book.  

• Click the Edit button to review and approve any and all messages as posts. 



Chapter 9 - Page Components 

191 

• Once you have reviewed a message, click Done to publish or to save the post or click 
Delete to remove the pending message from the site. 

 

• To view the posts on the Guest Book, click the View Guestbook link. 
 
You also have the option to add a header that contains an image and text to the Guest Book 
page. For more on adding images and text, see the Adding Pictures and Adding Text sections 
of this manual. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-48 
Guestbook 

 
 
 
 

 
 
 
 
 
 
 
 
 
Page Settings 
The Page settings for Board, Blog and Guest Book are the same.  

• To access Page Settings, navigate to the page and click the Edit drop-down menu and 
choose Page Settings.  A new window will open. 

General 

• Under the General tab, you will find the page type and the page title.  If you would like 
to change the page title, type the new title for your page in the corresponding text 
box. 

• Next, you can choose from the drop-down menu how many threads you want per board. 
 You have choices ranging from 5 to 100. 

• You can also choose how many posts per thread you would like by choosing from the 
drop-down menu where you again have the option of choosing between 5 and 100. 

• If you would like to manually approve the posts to this board, select Manually approve 
posts. 

• As mentioned before, when making posts you have the option to use the Advanced 
Content Editor.  You have the option here to allow anonymous users access to the 
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Advanced Content Editor. 

• You can also password-protect this page in View mode so only those with the correct 
password can view the page. 

 
 
 
 
 
 
 
 
 
 
 

Figure 9-49 
 

 
 
 
 
 
 
 
 
 
 
 
 
Details 

• Under the Details tab, you have following options: Allow more than one picture and 
text, Allow the public to subscribe to this page, Show Babel Fish translation, Hide 
link in navigation, Deny public access to the page, Make this page the homepage, 
and Move this page to another a section. All of these options are explained in greater 
detail in the beginning of this chapter. 

Meta 

• In the Meta tab, add keywords or phrases to your page's meta tags for Internet search 
engines.  If these words are typed into the search engine, the search will include your 
site or page in the results.  

• You can type words such as your school's name, your event, or anything else you think 
someone who is interested in your page might look under. 

• Write a brief description of the page in the box provided. 

• Click Done when you are finished with the Page Settings options. 
Layouts 

• In the Layouts tab, you can choose the layout of your board by selecting Blog, Board, 
or Guestbook. 
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Homepage 

 
Home Page 
The Home Page is important because that is the first thing people will see when they visit your 
site. For this reason, it is vital to add content to this page as soon as possible. The Home Page 
will automatically be added to your site when the site is created.  Set up your Homepage 
Options using Page Settings. 
 

Page Settings 
• To access your page settings, choose the Page Settings option form the Edit drop-down 

menu. 

• A new window will open. 
General 

• In the General tab, you can change the title of your Homepage, and therefore your site, 
by typing in the title you want in the Site Title text box. 

• You have the option to show the hit counter. 

• If you choose to show the hit counter, you can prime the counter.  Visitors to the site 
will see the primed number.  However, in Edit mode you will see both the primed 
number and the actual number of hits. 

• You can change the page title by typing the title you want in the corresponding text 
box. 

• Next, choose whether you want the Homepage to be in Newsletter or Scrapbook format 
by clicking the corresponding button. 

 
Details 

• Click the Details tab. 

• You have the following options: Allow the public to subscribe to this page, hide the 
link in navigation, and deny public access to the page. 

Meta 

• In the Meta tab, add keywords or phrases to your page's meta tags for Internet search 
engines.  If these words are typed into the search engine, the search will include your 
site or page in the results.  

• You can type words such as your school's name, your event, or anything else you think 
someone who is interested in your page might look under. 

• Write a brief description of the page in the box provided. 

• Click Done when you are finished with the Page Settings options. 
 
 
 
Scrapbook Style 
The Scrapbook style of your Home Page allows you to post images and text in multiple sortable 
items. In the Scrapbook style, all the edit fields are in one column and additional edit fields are 
entered vertically, one on top of the other. 
 

• To add images or text to the Home Page, click the Add Picture & Text option from the 
Edit drop-down menu.  

• A new edit field will be added to the page. 
 
When you have more than one edit field, you can sort the fields.  

• To sort the fields, choose the Sort Picture and Text Boxes option from the edit drop-
down menu. 

• A number will appear in the text and image boxes.  Simply change the numbers to the 
order you would like the boxes to appear.  
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• Once you have renumbered the boxes, click Sort.   
 
Editing the Scrapbook 

• To add text or edit the scrapbook box, click the edit button if in Legacy Mode or click 
the edit icon and choose Edit Content Box from the drop-down menu. 

General 

• You can add text under the General tab of the new window that opens.  You can add 
text simply by entering text into the text box, or you can click the Advanced Content 
Editor to edit or enter text. For more information on using the Advanced Content 
editor, see Chapter 7 - Editing Your Webpage. 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-51 
Scrapbook Text Box 

 
 
 
 
 
 
 
 
 
 
 
 
Styles 

• Click the Styles tab to choose the alignment, font size, and font color. 

• Select the Border box to open the border options.  Choose the desired border color 
from the Color Picker and border size from the drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 

• Click Done to save and post the message. 
Attachments 

• In the Attachments tab, you can add an image, link, or file to your scrapbook by 
clicking the corresponding button.  Follow the instruction as detailed in Chapter 7 - 
Editing Your Webpage for specific instructions on adding images, links and 
attachments. 
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Figure 9-52 
Attachments 

 
 
 
 
 
 
 
 
 
 
 
Newsletter Style 
The Newsletter Style of a Home Page allows you to create multiple home page items arranged 
in two columns that are capable of displaying different information each time the page is 
refreshed. 
 
With the Newsletter style, you can display images and text, pull information from other 
components such as the Calendar or What's New pages to be displayed within the newsletter 
box.  You can also add a weather banner that is already set up for your area. 
 

• To add a newsletter group edit field, click the Add Newsletter Group option in the Edit 
drop-down menu. The newsletter group edit field will be displayed on your site along 
with the subtitle bar for that field.  

• To add content or edit an already existing Newsletter field, simply click the Edit icon if 
in Legacy Mode.  You can also click the edit icon and choose the Edit Content Box 
option from the drop-down menu.  A new window will appear. 

General 

• Under the General tab, you can change the title of your newsletter box by filling out 
the information in the corresponding text box. 

• In the description text box you can enter in the information you would like to appear in 
your box.  You can simply type the text or you can use the Advanced Content Editor. 
 For more information on the Advanced Content Editor see Chapter 7 - Editing Your 
Webpage. 
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Figure 9-53 

General Newsletter Tab 

 
 
 
 
 
 
 
 
 
 
 
Options 

• Under the Options tab, you can choose to hide the box title. 

• By clicking Back to List, you can edit your newsletter box.   

• One of the features of the Newsletter boxes is being able to add multiple entries per 
box by clicking the Add Picture and Text icon.  This will allow you to post several 
messages in one box so that every time your page is viewed, a different message will be 
shown.  This is very helpful in making your page look new to the viewer upon every 
visit. 

 
 
 
 
 
 
 
 

Figure 9-54 
Box Options 

 
 
 
 
 
 
 

• If you click Add Picture and Text, you will then be returned to the Options tab.  From 
there, you can choose the General tab so that you can name the new box and fill in the 
description. 

Page Summary 

• Another useful feature found under the Options tab by clicking Back to List is the page 
summary.  A page summary will show in your newsletter box a summary from another 
page.  This is most frequently used with Calendar pages and Lunch Menu pages, but can 
also be used for any page you want.   
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• After clicking the Page Summary option, a new window will open.  From this window, 
choose the page you would like summarized in your newsletter box. 

• After you have chosen the page to summarize, you are given the option to hide the title 
box for the item and make the summary title a link to this page. This will allow users to 
click the newsletter box title and be taken to the page you are summarizing.  You can 
also choose how many items you want shown in the newsletter box and how you would 
like to group recurring events. 

• Once you have made your selections, you may click Done to return to the Back to List 
screen. 

Edit Box Properties 

• Your final option in the Back to List screen is to edit the box properties.  Click Edit Box 
Properties and a new screen will open. 

• Here, your first option is to use the settings from Page Design so that everything is pre-
set per the Page Design settings. 

• The first option refers to the title of your newsletter box.  Here, you can choose the 
alignment of the title, the font size, color and whether or not you want italicized 
and/or bolded font. 

• Select the Border box to open the border options.  Choose the desired border color 
from the Color Picker and border size from the drop-down menu.  

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-55 
Box Properties 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 

• The box title image allows you to choose a specific image for your box title.  This can 
give your page a distinctive look.  Click add image to add an image to your box title. 

• You can choose an image from your computer, the SchoolCenter Gallery, or Your Local 



Chapter 9 - Page Components 

199 

Gallery.  Once you have uploaded the image of your choosing, it will appear in your 
window. 

• Your final option is Tile Box Image and Show Box Title.  This will take your image and 
use it as a background tile for your newsletter box, while showing the title you chose in 
the General tab. 

• After making your selections, click Done to return to the Back to List window. 
Styles 

• From the Page Settings window, the next tab is the Styles tab.  Here, you can choose 
the text styles, which include the font size and color, bold or italics, alignment, and 
whether or not to make text HTML friendly. 

• Select the Border box to open the border options.  Choose the desired border color 
from the Color Picker and border size from the drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

 
 
 
 
 
 
 
 
 
 
 

Figure 9-56 
Newsletters Styles 

 
 
 
 
 
 
 
 
 
 
 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 
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Opinion Poll 

 
Attachments 

• Under the Attachments tab, you can upload images by clicking Add an image.  Further 
explanation on adding an image and editing an image can be found in Chapter 7 - Editing 
Your Webpage.  

• You can also add an alt tag to the image.  An alt tag is the search criteria you want 
associated with your image.   

• You can make the image a link, by clicking Add a link.  In the pop-up window, type the 
web address you want to link to. 

• Click Done to save your changes. 
 
 
 
 
 
 
 
 
 

Figure 9-57 
Attachments 

 
 
 
 
 
 
 
 
 

Opinion Poll 
The Opinion Poll component allows you to gather valuable information about your school, 
teachers, sports teams, website, classroom, and so forth. Visitors to your website can cast their 
opinion on any topic that you choose to post on your site. You may only post one opinion 
question per page, but several of these pages can be placed within your navigation.  
 
The “votes,” all of which are anonymous, are automatically tallied and placed into a bar chart. 
The percentage of votes for each choice is also displayed.  
 
Adding an Opinion Poll 

• In the text boxes provided, type the name of the new opinion poll. 

• Click Add New Opinion Poll.  

• Click the edit button if in Legacy Mode.  You can also click the edit icon and choose Edit 
Poll from the drop-down menu and a new window will open. 

General 

• In the General tab, the first option you are given is the title of your poll.  Enter the title 
of your poll in the corresponding text box. 

• The next field is the question field.  You can enter in the text in the field provided or 
you can opt to use the Advanced Content Editor for more options.  For more information 
on the Advanced Content Editor, see Chapter 7 - Editing Your Webpage. 

• Next, click Add New Answer. Fill out the answer in the text box provided. 

• You can continue to populate your opinion poll with as many answers as you need by 
repeating the steps detailed above. 
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Figure 9-58 
Poll Questions & Answers 

 
 
 
 
 
 
 
 
 
 
 
 
Styles 

• From the Page Settings window, the next tab is the Styles tab.  Here, you can choose the 
text styles, which include the font size and color, bold or italics, alignment, and whether 
or not to make text HTML friendly. 

• Select the Border box to open the border options.  Choose the desired border color from 
the Color Picker and border size from the drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 

• When you are finished, click Done. 
 

• If you have more than one poll, only one can be active at a time.  

• To make an inactive poll active, click the red circle next to the inactive poll. 
 

 

An Opinion Poll can also be added to a newsletter-style page as a page summary. 

 

• You also have the option to add a header that contains an image and text to the Opinion 
Poll page. For more on adding images and text, see the Adding Pictures and Adding 
Text sections of this manual. 

Page Settings 
• To access the Opinion Poll page setting, navigate to the page and then select Page 

Settings from the Edit drop-down menu. 
General 

• A new window will open.  Under the General tab, you can name the page in the 
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corresponding text box. 

• You can also opt to password-protect the page when in View mode. 
 
 
 
 
 
 

Figure 9-59 
Opinion Poll Page 

Settings 
 

 
 
 
 
 
 
Details 

• Under the Details tab, you have the following options: Allow more than one picture and 
text, Allow the public to subscribe to this page, Show Babel Fish translation, Hide link 
in navigation, Deny public access to the page, Make this page the homepage, and 
Move this page to another a section. All of these options are explained in greater detail 
in the beginning of this chapter. 

• Once you have made you selections, click Done to save your changes. 
 
 
 
 
 
 
 

Figure 9-60 
Opinion Poll Details 

 
 
 
 
 
 
 
Meta 

• In the Meta tab, add keywords or phrases to your page's meta tags for Internet search 
engines.  If these words are typed into the search engine, the search will include your 
site or page in the results.  

• You can type words such as your school’s name, your event, or anything else you think 
someone who is interested in your page might look under. 

• Write a brief description of the page in the box provided. 

• Click Done when you are finished with the Page Settings options. 
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Other Web Page 

 
Other Web Page 
The Other Web Page component can be used to create a link to another page by placing the link 
along with the other links in your navigation structure. You can also set these links to open in a 
new window so your visitors can easily return to your site once they have viewed the linked 
website. 

• To add another page's link to your navigation, in Edit Mode, click the Add a Page option 
in the Edit drop-down menu. 

• In the new window that appears, click the Other Web Page component and then click 
Add Page. 

• In the new window that opens, you will need to add the link information. 
General 

• Under the General tab, you are first given the option to change the page title.  The 
page title is how this page will appear in your navigation. 

• Next, type the web address of the page you are placing in your navigation.  Make sure 
the entire web address is placed in the Web Address text box. 

• You now can choose where you would like this link to open.  You can choose between 
current window, framed, or new window by clicking the corresponding button. 

 
 
 
 
 
 
 
 

Figure 9-61 
Other Web Page 

 
 
 
 
 
 
 
Details 

• Under the Details tab, you can select the following options: Hide link in navigation, 
deny public access to the page, or Move the page to different section. 

• Click Done when you are finished to save your changes. 
 
 
 
 
 
 

Figure 9-62 
Details 
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Meta 

• In the Meta tab, add keywords or phrases to your page's meta tags for Internet search 
engines.  If these words are typed into the search engine, the search will include your 
site or page in the results.  

• You can type words such as your school’s name, your event, or anything else you think 
someone who is interested in your page might look under. 

• Write a brief description of the page in the box provided. 

• Click Done when you are finished with the Page Settings options. 
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Parent Registration 

 
Parent Registration 
Your website can also provide a link on the school or district page so that parents can register to 
see their students' grades when using the Grades Online feature. 
 

Page Settings 
• Navigate to the Parent registration page. 

• Click the Edit drop-down menu and choose Page settings. 
General 

• The first text box will allow you to change the name of this page. 

• Choose the default group for this page from the drop-down menu.   

• Choose whether or not you want to allow new parent registration. 

• Choose whether or not you would like to password-protect the page. 
Details 

• Under the Details tab, you can choose from the following options:  Allow the public to 
subscribe to this page, Show Babel Fish translation, Hide link in navigation, Deny 
public access to the page, and Make this page the homepage. 

• Click Done when you are finished to save your changes. 
 

 

For more on the Grades Online feature, see Reporting Grades at our Support & 
Services site. 

 
New User Registration 
Parents who have not yet registered will need to create a user ID and password so they can view 
their students’ grades.  

• To begin, parents will enter in a user name and password.  

• They will need to confirm that password and enter their first and last names and their 
email address, and then click the [new user continue] link. 

• Parents will now need to enter in the hash code the student has received from his or her 
teacher and then click the [continue] link.  

• They will next see a screen confirming that they have entered in the correct hash code.  

• Next, they will click the [Click Here to View Grades] link. They will be directed to a 
Desktop Start Page where they will see an area called My Child's Grades. The names of 
their students will be listed in the box, and an individual student’s grades can be checked 
by clicking the student name. 

 
Meta 

• In the Meta tab, add keywords or phrases to your page's meta tags for Internet search 
engines.  If these words are typed into the search engine, the search will include your 
site or page in the results.  

• You can type words such as your school’s name, your event, or anything else you think 
someone who is interested in your page might look under. 

• Write a brief description of the page in the box provided. 

• Click Done when you are finished with the Page Settings options. 
Registered Users 

• Parents who have already registered can enter in their user name and password in the 
appropriate field then click the [registered users continue] link.  

• They will then be directed to a page where they can enter in new hash codes for more 
students or click the [See Grades Here] link.  

• Next, they will click the [Click Here to View Grades] link. They will be directed to a 
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Desktop Start Page, where they will see an area called My Child's Grades.  

• The names of their students will be listed in the box, and individual student grades can 
be checked by clicking the student name. 

 
You also have the option to add a header that contains an image and text to the Parent 
Registration page. For more on adding images and text, see the Adding Pictures and Adding Text 
sections of this manual. 
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Question and Answer 

 
Questions and Answers 
The Questions and Answers component allows you to post frequently asked questions that 
visitors may have about the community, district, schools, teams, clubs or classrooms.  You can 
have questions and answers for any topic you would like, but since most districts and schools 
hear the same questions often, the Question and Answers component is a great place to 
address commonly-asked questions. 
 
Adding a Question and Answer 

• To add a question and answer, click the Add New Question option in the Edit drop-down 
menu. 

General 

• Under the General tab, in the new window that opens, fill out your question in the 
corresponding text field. 

• Next, fill out the answer to the question in the Answer box.  You can use the Advanced 
Content Editor, explained in detail in Chapter 7 - Editing Your Webpage, or simply 
enter the answer in the box provided. 

• You can add as many questions as you like by clicking the New button after each 
question and answer. 

• Once you are finished entering the information, click Done to save the new question and 
answer.  

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-63 
Question & Answer Edit Field 

 
 
 
 
 
 
 
 
 
 
 
Styles 

• From the Page Settings window, the next tab is the Styles tab.  Here, you can choose 
the text styles, which include the font size and color, bold or italics, alignment, and 
whether or not to make text HTML friendly. 

• Select the Border box to open the border options.  Choose the desired border color from 
the Color Picker and border size from the drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 
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background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 

• When you are finished, click Done. 
Attachments 

• Under the Attachments tab, you can upload images by clicking the Add an image 
button.  Further explanation on adding an image and editing an image can be found in 
Chapter 7 - Editing Your Webpage. 

 
Editing Existing Questions 

• To edit a question, click the Edit icon located to the right of the question. 

• You can also sort the order of the questions by clicking Sort. 

• A new window will open, allowing you to sort alphabetically, sort in reverse alphabetical 
order, or sort by dragging and dropping the questions where you want them to appear on 
the page. 

• Once you have the questions in the order you prefer, click Done to save your changes. 
 
 
 
 
 
 
 
 
 
 

Figure 9-64 
Attachments Tab 

 
 
 
 
 
 
 
 
 
 
Importing  
The Questions and Answers component also has an import feature that will allow you to mass 
populate your page.  

• To import information onto your page, first download the Mass Data Import template 
from the SchoolCenter Support & Services site.  

• Fill out the template. 

• Once the template is filled out, click the Import tab and then follow the on-screen 
instructions. 

 
You also have the option to add a header that contains an image and text to the Questions and 
Answers page. For more on adding images and text, see the Adding Pictures and Adding Text 
sections of this manual. 
 

Page Settings 
• To access page settings, navigate to the page, and click the Edit drop-down menu.  From 

the drop-down menu click Page Settings. 
General 
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• The General tab options for the Questions and Answers page first give you the option 
to change the title of the page. 

• You can also choose whether or not you would like to password-protect your page while 
in View Mode. 

Details 

• In the Details tab, you may choose from the following options:   Syndicate this page 
with RSS, Allow more than one picture and text box, Allow the public to subscribe to 
this page, Show Babel Fish translation box, Hide the Link in Navigation, Deny public 
access to the page, and Make this page the homepage.  If you want to move the page, 
you may click the scissors icon. 

Meta 

• In the Meta tab, add keywords or phrases to your page's meta tags for Internet search 
engines.  If these words are typed into the search engine, the search will include your 
site or page in the results.  

• You can type words such as your school’s name, your event, or anything else you think 
someone who is interested in your page might look under. 

• Write a brief description of the page in the box provided. 

• Click Done when you are finished with the Page Settings options. 
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School History 

 
School History 
Use the School History component to outline the history of your school. Adding pictures and 
text to this page helps make your school history more memorable for the visitors to your site. 
 

• To add pictures or text to your School History page, click the Add Picture & Text option 
in the Edit drop-down menu to display a new edit field.  

 
For more on adding pictures and text, see the Adding Pictures and Adding Text sections of this 
manual. 
 
Once you have more than one edit field, you can sort the fields by choosing the Sort Picture and 
Text Boxes from the Edit drop-down menu.  Next, change the field numbers in the boxes and 
then click Sort.  
 

School Map 
The School Map component is designed to make it easy to upload a map to your school’s 
location or a map of the school building. For directional maps, there are options online such as 
MapQuest, Google Maps, and Yahoo! Maps. 
 

• To add pictures or text to your School History page, click the Add Picture & Text option 
in the Edit drop-down menu to display a new edit field.  

 
For more on adding pictures and text, see the Adding Pictures and Adding Text sections of this 
manual. 
 
Once you have more than one edit field, you can sort the fields by choosing the Sort Picture and 
Text Boxes from the Edit drop-down menu.  Next, change the field numbers in the boxes and 
then click Sort.  
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Schools 

 
Schools 
The Schools page displays links to the websites for the schools in your district so your visitors can 
easily locate and navigate to any school they want.  
 

• To rearrange the order of the school links, click Sort List.   

• Highlight the link that you would like to move by clicking once on its title.  Next, drag 
and drop the highlighted link.  

• You also have the option to sort the schools in alphabetical order or in reverse 
alphabetical order. 

 
 
 
 
 
 
 
 
 
 
 

Figure 9-65 
School Sort 

 
 
 
 
 
 
 
 
 
 

• To return to the default list, click the [reset] link.  After all changes have been made, 
click Done to save the settings and close the window. 

• You also have the option to add a header that contains an image and text to the Schools 
page. For more on adding images and text, see the Adding Pictures and Adding Text 
sections of this manual. 
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Scrapbook 

 
Scrapbook 
The Scrapbook component allows you to put your school or classroom on display.  
 
The Scrapbook is very similar to the Home Page in that you can only add images and text. As it 
does not have a specific use, you can easily use this component as a template for new blank 
pages on your site. 
 
Page Settings 
The Page Settings for the Scrapbook help determine how the page will look, so it might be 
beneficial to start there. 

• Navigate to your scrapbook page and choose Page Settings from the Edit drop-down 
menu. 

General 

• A new window will open.  Under the General tab, you have the option to change the 
page title in the corresponding text box. 

• Next, you can choose how many scrapbook items you would like to appear on each page 
from the Items Per Page drop-down menu. 

• You can also choose to password-protect this page while in View mode. 
 
 
 
 
 
 
 

Figure 9-66 
General Scrapbook 

Options 

 
 
 
 
 
 
 
Details 

• You can choose from the following options:  Allow the public to subscribe to this page, 
Show Babel Fish translation box, Hide the Link in Navigation, Deny public access to 
the page, and Make this page the homepage. If you want to move the page, you may 
click the scissors icon. 
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Figure 9-67 
Scrapbook Details 

 
 
 
 
 
 
 
 
Meta 

• In the Meta tab, add keywords or phrases to your page's meta tags for Internet search 
engines.  If these words are typed into the search engine, the search will include your 
site or page in the results.  

• You can type words such as your school’s name, your event, or anything else you think 
someone who is interested in your page might look under. 

• Write a brief description of the page in the box provided. 

• Click Done when you are finished with the Page Settings options. 
Layouts 

• The final tab is Layouts.  You have three layouts you can choose from. 

• Scrapbook Style allows you to post images and text in multiple sortable items. In the 
Scrapbook style, all of the edit fields are in one column and additional edit fields are 
entered vertically. 

• The Categorized Style allows you to create a scrapbook that is separated by categories, 
an option that works well for scrapbooks containing several pictures.  The Categorized 
Scrapbook works in the same way as a regular scrapbook with the only difference being 
the extra page that breaks the page into categories. 

• The Newsletter Style allows you to create multiple home pages items as boxes arranged 
in multiple columns. Each box is capable of displaying different information each time 
the page is refreshed.  With the Newsletter style, you can display images, text, or pull 
information from other page components.  You can choose how many columns you want 
to appear by clicking the Number of Columns drop-down menu. 

• Once you have finished, click Done to save your settings. 
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Figure 9-68 
Layouts 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Scrapbook Style 
The Scrapbook Style allows you to post images and text in multiple sortable items. In the 
Scrapbook style, all of the edit fields are in one column and additional edit fields are entered 
vertically, one on top of the other. 
 

• To add images or text to the Scrapbook, click the Add Picture & Text option in the Edit 
drop-down menu. For more on adding images and text, see the Adding Pictures and 
Adding Text sections of this manual. 

 
Once you have more than one edit field, you can sort the fields by choosing the Sort Picture and 
Text Boxes from the Edit drop-down menu.  Next, change the field numbers in the boxes and 
then click Sort.  
 
Newsletter Style 
The Newsletter Style allows you to create multiple home page items arranged in two columns 
and capable of displaying different information each time the page is refreshed. 
 
With the Newsletter style, you can display images and text, pull information from other 
components such as the Calendar or What's New pages to be displayed within the item, and a 
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weather banner that is already set up for your area. 
 

• To add a newsletter group edit field, click the Add Newsletter Group option in the Edit 
drop-down menu.  

• A new window will open, where you can choose between Add Picture & Text or Add 
Page Summary.  These options are explained in detail below. 

• To add images or text to your Newsletter field, simply click Add Picture and Text.  A 
new window will appear. 

General 

• Under the General tab, you can change the title of your newsletter box by filling out the 
information in the corresponding text box. 

• In the description text box, you can enter in the information you would like to appear in 
your box.  You can simply type the text or you can use the Advanced Content Editor.  For 
more information on the Advanced Content Editor, see Chapter 7 - Editing Your 
Webpage. 

Options 

• Under the Options tab, you can choose to hide the box title. 

• By clicking Back to List, you can edit your newsletter box.   

• One of the features of the Newsletter boxes is being able to add multiple entries per box 
by clicking Add Picture and Text.   This will allow you to post several messages in one 
box so every time your page is viewed, a different message will be shown.  This is very 
helpful in making your page look new to the viewer upon every visit. 

• If you select Add Picture and Text, you will then be returned to the Options tab.  From 
there, you can choose the General tab so that you can name the new box and fill in the 
description. 

 
 
 
 
 
 
 
 

Figure 9-69 
Box Options 

 
 
 
 
 
 
Page Summary 

• Another useful feature found under the Options tab when clicking Back to List is the 
page summary.  A page summary will show in your newsletter box a summary from 
another page.  This is most frequently used with Calendar pages and Lunch Menu pages, 
but can also be used for any page you want.   

• After clicking the Page Summary option, a new window will open.  From this window, 
choose the page you would like summarized in your newsletter box. 

• After you have chosen the page to summarize, you are given the option of hiding the title 
box for the item and making the summary title a link to this page.  This will allow users 
to click the newsletter box title and be taken to the summarized page.  You can also 
choose how many items you want shown in the newsletter box and how you would like to 
group recurring events. 

• Once you have made your selections, you may click Done to return to the Back to List 
screen. 
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Figure 9-70 
Page Summary 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Edit Box Properties 

• Your final option in the Back to List screen is to Edit Box Properties.  Click Edit Box 
Properties and a new screen will open. 

• Here, your first option is to use settings from Page Design so that everything is pre-set 
per the Page Design settings. 

• The first option refers to the title of your newsletter box.  Here, you can choose the 
alignment of the title, the font size, color and whether or not you want italicized and/or 
bolded font. 

• Select the Border box to open the border options and choose the desired border color 
from the Color Picker and border size from the drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 
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Figure 9-71 
Box Properties
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Album 

 
Album 
The Album page is a great way to showcase a large number of photographs or images.  Visitors 
to your site can cycle through the images on their own, or they can choose to view the Album's 
image as a slideshow.  Many districts and schools have annual events where they take a large 
number of pictures.  These pictures can be placed in the Album page component.  By allowing 
them to post comments on the page helps further involve site visitors with the district and 
familiarize them with the school's activities and traditions. 
 

• To begin editing and adding images to your album, choose the Switch to Edit Mode 
option from the Edit drop-down menu. 

• Select Add Picture and Text from the Edit drop-down menu to edit your page. 
Manage Album 

• To add pictures or manage an existing album, choose the Manage Album from the Edit 
drop-down menu. 

• A new window will open.  From this window, you can edit your images and add new 
images. 

• Click Add to add images to your album. 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-72 
Manage Album 

 
 
 
 
 
 
 
 
 
 
.   
Standard Mode 

• To use Standard Mode, click Standard Mode and then click Select Upload Method.  

• To add a file from your computer, click Browse. 

• Select the image file you want to add by double-clicking it. 

• Click Upload file.  

• After your file uploads, you can browse for another file or click Done. 

• You can change your file name in the text box provided. 

• Choose the category you want to place the file by selecting the correct category from 
the drop-down menu. 

• If you no longer want this image uploaded, you can select the Delete option. 

• You can name your image by filling out the Title field. 
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• To add tags or comments to your image click Add Tags/Comments.  Tags act as 
categories for your images.  If you want the images to belong to multiple categories, 
enter multiple tags into the field.  

• This list of tags needs to be coma-separated.  In the new window that opens, enter in 
the tags for your image in the first text box and comments in the second text box. 

• If you no longer want this image uploaded, you can select the Delete option. 

• Click Done to save your changes. 
 

 

If you want to add several images to your Album quickly, use Enhanced Mode.  In 
Enhanced Mode, you can highlight a large group of image files at once by holding 
down the Shift key to select a list of file.  To select several separate files, hold 

down the Control key. 

 
Enhanced Mode 

• To add files using Enhanced Mode, you will need to have Java™. 

• Click Enhanced Mode then click Select Upload Method. 

• To add files, you can click Add in the new window to open a file browser to select 
individual or multiple files.  After you have selected your files from the browser, click 
Open.  Alternatively, you can open a file browser.  Once you have opened the browser 
and navigated to the files you want to add, simply drag and drop them into the 
SchoolCenter window. 

• Once you have dragged and dropped the files you are adding to your page, click Done. 

• In the new window, you can change your file name in the text box provided. 

• To add tags or comments to your image click Add Tags/Comments. Tags act as 
categories for your images. If you want the images to belong to multiple categories, 
enter multiple tags into the field.  

• This list of tags needs to be coma-separated. In the new window that opens, enter in the 
tags for your image in the first text box and comments in the second text box. 

• If you no longer want this image uploaded, you can select the Delete option. 

• Click Done to save your changes. 
 
 
 
 
 
 
 
 
 

Figure 9-73 
Album Tab 
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Adding Image to Site 

• The images you selected will appear in the sidebar.  

• You have the option to change the title and description of each image. You also have the 
option to add additional tags to the image. 

• You can also choose the size of the thumbnail by clicking the thumbnail and choosing the 
thumbnail size you want from the drop-down menu. 

• When you are finished making changes to each image, click Apply. 

• To delete an image, click Delete.  

• Once you are finished adding a title, description, and tags to your images, click Close. 

• The images you added will appear on your page. 
 
 

 
 
 
 

Figure 9-74 
Slideshow Tab 

 
 
 
 
 
 
Page Settings 

• To access your page settings, navigate to your Album page and then choose the Page 
Settings option from the Edit drop-down menu. 

• A new window will open. 
General 

• In the General tab, you have to the option to change the title of your page.  Since you 
can create many Album pages, it is possible to have an Album page dedicated to an 
event you want to showcase or for a specific group or activity.  Therefore, it would be 
wise to change the title of the page from "Album" to the name of the event, group, 
activity, or Album theme. 

• You have the option to password-protect this page when in View Mode. 

• You can allow users to post comments on the page. 

• If you allow users to post comments on the page, you have the option to manually 
approve all comments, thereby allowing you to screen all comments prior to them being 
posted online.  If you choose this option, you can check for comments while in Edit 
mode from the Edit drop-down menu.  The Unapproved Comments option will allow you 
to read and approve user comments. 

Details 

• Click the Details tab. 

• You have the following options:  Allow more than one Add Picture and Text, allow the 
public to subscribe to this page, Show Babel fish translation box, hide the link in 
navigation, deny public access to the page, make this page the homepage, and Move 
this page to another section. 

Meta 

• In the Meta tab, you can add keywords or phrases for your to your page's meta tags for 
Internet search engines.  If these words are typed into the search engine, the search will 
include your site or page in the results.  

• You can type words such as your school’s name, your event, or anything else you think 
someone who is interested in your page might look under. 



Chapter 9 - Page Components 

221 

• Write a brief description of the page in the box provided. 

• Click Done when you are finished with the Page Settings options. 
Slideshow 

• The Album page has a slideshow that visitors can view.  To set the slideshow options, 
click the Slideshow tab. 

• You can choose to show the slideshow in the Current window or in a New window from 
the drop-down menu. 

• Next, you can choose to have the transition from one picture to another be either a wipe 
or a fade. 

• You can set how long each picture is shown from one second up to one minute from the 
drop-down menu. 

• Once you have finished choosing your slideshow options, click Done to save your 
changes. 

• You can delete your Album page by clicking Delete. 

• You can cancel any changes you made to you Page Settings by clicking  Cancel. 
 
 
 
 
 
 
 
 
 
 
 
 
 



Webtools Manual 

222 

Search 

 
Search 
The Search component allows visitors to search the site via keywords. With the Advanced 
Search option, visitors can search individual page components via keywords. The Google search 
option uses the Google search engine to search the website, not the Internet.   
 
Searching the Site 
Type the keywords that you want to search the website for and click Search Now!. 
 
 
 
 
 

Figure 9-75 
Search 

 
 
 

 
 

• To search by keyword in specific page components, click the Advanced Search tab.  

• Type the keywords for the search, place a check in the box of the components to 
search, and then click Search Now!. The results will be displayed with the keyword 
highlighted.  

• To clear the results and/or to search again, click Clear Results. 
 

 

 The Search component is not an Internet search engine. It will only search your 
site. 

 
You also have the option to add a header that contains an image and text to the Search page. 
For more on adding images and text, see the Adding Pictures and Adding Text sections of this 
manual. 
 

Site Map 
The Site Map component allows visitors to your website to easily navigate to any page 
throughout your school or district.   
 

• To use the Site Map, click the name of the section where you want to navigate to or 
click the down arrows to expand that section. 

• When you have found the section that you want to visit, click that link and you will be 
directed to that page. 

• You also have the option to add a header that contains an image and text to the Site 
Map page. For more on adding images and text, see the Adding Pictures and Adding 
Text sections of this manual. 
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Test Bank 

 
Test Bank 
The Test Bank component is available at the classroom level as a unique and efficient way to 
quiz your students over the material learned in class. This component provides an excellent 
study tool for your students. You can add as many Test Banks to your site as you want, covering 
as many subjects as you want.  With the use of this component, your students’ testing skills can 
begin to improve exponentially. 
 
Add a New Test 

• In the areas stating (New Test), type the name of the new test. 

• Click Add New.  

• Click the Edit icon to begin entering your questions for the new test.  
 

• In the Description text box, type a question you want those taking the test to answer.  

• Enter the instructions for the test in the Instructions text box.  This information will 
appear in the Test window. 

• Click Done to save your test. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9-76 
New Test 

 
 
 
 
 
 
 
 
You also have the option to allow students to retry after answering a question incorrectly by 
selecting the Allow Retries box. 

• To add, delete, and change questions, click the [Edit Questions] link.  

• You can select the number of questions for this test from the drop-down menu.  

• You will then have the option to edit each question by clicking the New Question # 
links provided. 

• You can type the question in the text box at the top.  

• To delete this question, click Delete located above the text box. 

• You can also add an image to the question by clicking Add Media located below the text 
box. 
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Figure 9-77 
Test Questions & Answers 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• To add answers, select the number of answers you would like to make available for this 
question from the Answers drop-down menu. 

• Type the answer, putting the answer to the question in the Answer text box and the 
response (to indicate to the student upon choosing this answer whether it is correct or 
incorrect) in the Response text box. 

 

 

You may enter any information you want (including explanations) into the 
Response text box. 

 

• When you are finished editing this question, click Save Question.  

• To return to the main window, click Back.  
 
You may add as many tests to your Test Bank page as you would like.  
 
You also have the option to add a header that contains an image and text to the Test Bank 
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page. For more on adding images and text, see the Adding Pictures and Adding Text sections 
of this manual. 
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Useful Links 

 
Useful Links 
The Useful Links page is an easy way to add links to your site by creating a directory of links to 
outside web pages. These links can be categorized and can include brief or detailed 
descriptions.  
 
Share Data 
A share feature has been built into the Useful Links page component so that information 
entered on these pages may be shared from classroom to district, school to classroom, and 
school to school. In this way, information may be entered in one area and shared throughout 
the entire website.  

Summary 

• The Summary tab shows the pages, if any, that data is being pulled or pushed 
from.  You can change the pages by clicking the page name in the page 
summary.  This will take you to the Pull tab or the Push tab where you can 
select or clear pages. 

Pull Data 

• Click the Pull Data tab to show a list of pages in your site.  

• Navigate to the page you want to pull data from, and then select the categories 
you want to place in your page.  

• Once you are finished choosing sites, click Done.  The data pulled from the 
other page will now appear on the site with a barrels icon located next to the 
information instead of an Edit icon. This means that you will not be able to edit 
the information, since it is pulled from another page. If the information is 
changed on the original page, it will subsequently change the information on 
your page.  

 
 
 
 
 
 
 
 
 
 

Figure 9-78 
Browse Tab 

 
 
 
 
 
 
 
 

• To remove the data from your page, click the Pull Data tab.  

• Clear the check box and click Done. The data will then be removed from your page. 
Push Data 

• To push data to another site, you must be a system Administrator. This tab does the 
opposite of the Pull Data. Instead of taking information from another site, you are 
giving information, or pushing data, to other sites throughout the district.  This can be 
used for district holiday schedules, and other events you want to appear on other sites. 

• Click the Push Data tab.   
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• Place a check next to the categories you want to place in your page.  

• Once you are finished choosing sites, click Done.  The data pushed to the other page 
will now appear on those sites with barrel icons located next to the information instead 
of an Edit icon. This means that the information cannot be edited, since it is pulled 
from another page. If the information is changed on the original page, it will 
subsequently change the information on your page.  

Import 
The Useful Links component also has an import feature in the form of an import template that 
will mass populate your Calendar page.  

• To import information onto your page, first download the Mass Data Import template 
from our Support & Services site.  

• Fill out the template. 

• Once the template is filled out, click the Import tab, and then follow the on-screen 
instructions. 

 
Adding Categories 

• To add a category to your Useful Links page, click the Add Category option from the 
Edit drop-down menu. 

• A new window will appear where you can enter the information for the category into 
the text boxes.  The first text field is for the title of your category. 

• Next, you can enter in a description of the category in the corresponding text box, or 
use the Advanced Content Editor, explained in detail in Chapter 7 - Editing Your 
Webpage. The level of the category can be selected from the drop-down menu. 

 

 

For more information on adding text and using the ACE, see the Adding Text and 
Advanced Content Editor sections of this manual. 

 
 
Adding Links 

• To add a link to your Useful Links page, click  Add New Link from the Edit drop-down 
menu and a new window will open.  

 
General 

• Under the General tab in the new window, the first option is for a title to the link. 
Enter the title in the corresponding text box. 

• Next, enter the link address in the URL text box. 

• From the drop-down menu, choose whether you want your link to open in a new window 
or the same window. 

• Next, you have the option to fill out the link description in the description text box. 
 You can also use the Advanced Content Editor, explained fully in Chapter 7 - Editing 
Your Webpage, to provide a full description of the link. 

• You can also choose what category you would like the link placed in from the drop-down 
category menu. 

Styles 

• From the Edit window, the next tab is the Styles tab.  Here, you can choose the text 
styles which include the font size and color, bold or italics, alignment, and whether or 
not to make text HTML friendly. 

• Select the Border box to open the border options.  Choose the desired border color 
from the Color Picker and border size from the drop-down menu.  

• Select the Background Color box to open the color options and choose the desired 
background color for this text field from the drop-down menu. 

• Click the empty Color square in each to open the Color Picker.  

• Move the cursor over the Color Picker and select the color by clicking in the desired 
color’s circle. You will see your choice show up in the Color box. 
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Attachments 

• Under the Attachments tab, you can upload images by clicking Add an image.  Further 
explanation on adding an image and editing an image can be found in Chapter 7 - 
Editing Your Webpage.  

• You can also add an alt tag to the image.  An alt tag is the search criteria you want 
associated with your image.   

• You can make the image a link, by clicking Add a link.  In the pop-up window, simply 
type the web address you want to link to. 

• Click Done to save your changes. 

• Once you are finished entering the information for the category, click Done to save it or 
click Save & New to save it and create another category. 
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Chapter 10 - Advanced Editing 
 

In addition to the options already detailed, many users have found there are helpful, advanced 
editing options offered in SchoolCenter WebTools.   
 

Linking Pages 
You can link to external pages.  Sometimes this is for reference purposes, or simply because you 
have a found an external web page that is useful.  Linking to an external page is an option in 
SchoolCenter WebTools.  

• First, you will need to copy the link you want to link to by either right-clicking in PC or 
function-clicking the link in Macs.  Select "Copy Shortcut" or "Copy Link Location." This 
copies the address of the file.  

 

 

Do NOT left- click the link and copy the shortcut in the URL / address bar. If you 
do, you will see a /sctemp/ 1 in the address which will eventually cause your 

document link to expire. 

 
 

• To link to a page, you need to add a page. Choose Add a Page from the Edit drop-down 
menu. 

• A new window will open.  From this window, choose click Other Web Page option. 

• Click Add Page. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 10-1 
Linking to Outside Pages 
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• A new window will open.  Title this page as you would like it to appear in your 
navigation. 

 
 
 
 
 
 
 
 
 

Figure 10-2 
Other Page Page Settings 

 
 
 
 

 
 
 
 
 
 

• Next, right click or Control-click for Mac and choose Paste Link. 

• Click Done when you are finished. 

• To see if the link works, you will need to be in View Mode. 
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Hidden Pages 

 
Hidden Pages 
Hidden Pages are pages that are hidden from view. 

• On your homepage, click Edit to view your page in Edit Mode.   

• Once in Edit mode, navigate to the page you want to hide.   

• Click the Edit drop-down menu and select Page Settings. 

• In the page settings window, choose the Hide Link in Navigation option under the 
Details tab. 

 
 
 
 
 
 
 
 
 

Figure 10-3 
Hide Link 

 
 
 
 
 
 
 
 
 

• Click Done to save your changes.   
 
Once you have hidden a page, you can view the page while in Edit Mode, but the link will not 
appear in the navigation once you are in View Mode. 
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URL Redirect 

 
Password Protecting Pages 

• By password-protecting a page, you are ensuring that only those who have the correct 
password may view the site.  This means that the general public will have to sign on to 
use the site, so anyone without sign-on privileges will be unable to view your page. 
 Those with sign-on access can view your page.  

• To password-protect your page, navigate to the page in question. 

• Once on the page you want password-protected, click the Edit drop-down menu and 
click Page Settings. 

• In the pop-up window, choose Password-Protect this page in View mode. 

• Enter in the user id and password you want for this page in the fields provided.   

• Click Done to save your changes. 
 

URL Redirect 
URL Redirect is an option available from your homepage.  For users who already have a 
website, URL Redirect allows them to use this site by redirecting their SchoolCenter page.  

• To redirect your page, from your Home Page click the Edit drop-down menu.  Click Page 
Settings. 

• A new window will open.  In this window, you are given the option to URL Redirect. 
 Type the web address of the site you want this page redirected to. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 10-4 
URL Redirect 
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Make sure to include the complete address as it appears in your browser. 
 Shortened web addresses will not get redirected properly. 

 

• Click Done to save your changes. 
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Copy Content 

 
Copy Content 
Copying content can be a huge time saver, especially if you find you are using the same 
information on different pages, or from year to year.   
 
Copying Edit Fields 

• You can simply and easily copy content from one edit field to paste in another. 

• To copy content, make sure the page is in Edit Mode by clicking Edit Mode. 

• Go to the field you want to copy.  Click the edit icon and select copy content from the 
drop-down menu. 

• A new window will open asking if you are sure that you want to copy.  Click ok. 

• The content has now been copied and is in the copy buffer. 

• To paste the content, navigate to the area you want the content to appear.   

• In Edit Mode, the edit fields should now have a Paste option.  Click  Paste. 

• Your content will appear. 

 
Copying Pages 
In SchoolCenter, you can easily copy content from one page to another. This is a useful tool 
when archiving a previous year’s website or duplicating pages.  
 

• On the page that you want to copy the content on, click Copy Page in the Edit drop-
down menu. This will place the page in what is called your Copy Buffer.  

• A new window will open asking you to verify that you want to copy that page. Click Ok. 
 
 
 
 
 

Figure 10-5 
Copy Buffer 

 
 
 
 

• To paste the copied content, add a new page or go to a current page that you want to 
paste the content to.   

 

 

Content can only be pasted to the same type of page component. Example: If a 
Contact Form is copied, it can only be posted to another Contact Form page 

component. 

 

• To paste the content, click the Paste To This Page icon.  

• A new window will open asking you to verify pasting to this page. Click OK. 
 
The content will now be pasted to your page.  

• If you have more than one page copied, you can clear them out of the Copy Buffer by 
clicking the Clear Copy Buffer option in the drop-down menu.  

• A new window will open verifying that you want to clear the buffer. Click Ok. 
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Moving a Page 

 
Checking Links 
Checking Links enables you to see what links are working on the page. You can check links in 
the Edit drop-down menu.   

• After clicking the Check Links option in the Edit drop-down menu, a new window will 
appear asking you to wait while the links are checked.  

• After a brief pause, another window will open telling you how many links you have per 
page.  If any links are no longer working, then this information will be listed as well.  

 
Moving a Page 
You can move a page from an existing section to another section via the Page Settings.  

• To move a page to another section click Page Settings in the Edit drop-down menu.  

• In the Page Settings area, click the Move This Page to another section link.   
 

 
 
 
 
 
 
 
 

Figure 10-6 
Move A Page link 

 
 
 
 
 
 
 
 
 
 

 

• The page will be copied to your Move Buffer. To place the page in a section, go to the 
homepage of the section you are moving it to. If you have selected to move a page, you 
will add the page to the site from that section's Homepage.  

• A link will be place in the Page Settings. Click the link to move the page to this section.  
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Moving a Section 

 
Moving a Section 
You have the option of moving sections from one area to another.  This might be useful if a 
classroom has changed schools within a district or if you want to move administration pages from 
one school to another. This also might be necessary simply if an error is made and the wrong 
section is placed in an area it does not belong. You can move similar sections to different schools 
within the same district by using SchoolCenter WebTools.  
 
There are two different ways to move a section.  You can choose to move your section from the 
section page or from the section's homepage.  

• The first way to move a section, such as Classrooms, Class Projects, Administrative 
Departments, is to navigate to the section page.  

• Put the page in Edit Mode by choosing Edit Mode from the Edit drop-down menu. 

• Once the page is in Edit Mode, click the Move icon located next to the section you want 
to move. 

• A new window will open.  Choose the school you would like your section moved to from 
the drop-down menu. 

• Next, you have the option to choose the section page you would like your section moved 
to from the drop-down menu. 

• Finally, you have the option to choose the category of your section from the drop-down 
menu. 

• Click Done. 
 

• To move a section, click the Edit drop-down menu from the homepage of the section you 
want to relocate. 

• Click the Page settings option in the Edit drop-down menu. The Page Settings window 
will open. 

• Click the Details tab.  

• Under this tab is the option, Move this section to another section list. Click this option. 

• The window will now say, This section is currently in your move buffer. Click Done. 
 
 
 
 
 
 
 
 
 

Figure 10-7 
Moving a Section 

 
 
 
 
 
 
 
 
 
 
 
 

• Navigate to the site you want to move your section.   
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• From this site, choose the area you want to add your section.  For example, if your 
section was in Classrooms, you will choose the Classrooms pages.  If it was from Clubs 
and Groups, you will choose the Clubs and Groups pages, etc. 

• Once you have navigated to the appropriate section, click the Edit drop-down menu and 
choose Pages Settings. 

• Once the Page Settings window opens, choose the Details tab. 

• In the Details tab, there will be an option for "Move [section name] here".  Click this 
option to move the section. 

• A pop-up window will open asking if you are sure you want to move the section.  Click 
OK. 

• Click Done to save your changes. 
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Sharing Information 

 
Sharing Information 
Sharing information in SchoolCenter WebTools is extremely easy.  For example, in the 
Calendar page, linking your calendar to the school or district calendar is as simple as clicking 
the Share Data option in the Edit drop-down menu.  This means that per district or school, only 
one person needs to enter in vacation information, school events, School Board meetings, or 
any other event that others would want to be shown on their calendar.  This feature is not 
limited to the Calendar page, but works on any page where Show Other is an option, such as 
What's New, School Board, Lunch Menu and other pages. 
 
Share Data 
A share feature has been built into the Calendar page component so that information entered 
on these pages may be shared from classroom to district, school to classroom, and school to 
school. In this way, information may be entered in one area and shared throughout the entire 
website.  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 10-8 
Pull Data 

 
 
 
 
 
 
 
 
 
 
 
 

• To share the data, you must be in Edit mode.  

• While on the Calendar page, click the Share Data option from the Edit drop-down 
menu. This will open a new window with Summary, Pull Data and Push Data tabs. 

Summary 

• The Summary tab shows the pages, if any, that data is being pulled or pushed from. 
 You can change the pages by clicking the page name in the page summary.  This will 
take you to the Pull tab or the Push tab where you can select or clear pages. 

Pull Data 

• Click the Pull Data tab to show a list of pages in your site.  

• Navigate to the page you want to pull data from, and then select the categories you 
want to place in your page.  
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• Once you are finished choosing sites, click Done. The data pulled from the other page 
will now appear on the site with a barrels icon located next to the information instead 
of an Edit icon. This means that you will not be able to edit the information, since it is 
pulled from another page. If the information is changed on the original page, it will 
subsequently change the information on your page.  

• To remove the data from your page, click the Pull Data tab.  

• Clear the check box and click Done. The data will then be removed from your page. 
Push Data 

• To push data to another site, you must be a system Administrator. Instead of taking 
information from another site, you are giving information, or pushing data, to other 
sites throughout the district.  This can be used for district holiday schedules and other 
events you want to appear on other sites. 

• Click the Push Data tab.  This tab does the opposite of the Pull Data.   

• Place a check next to the categories you want to place in your page.  

• Once you are finished choosing sites, click Done.  The data pushed to the other page 
will now appear on those sites with barrel icons located next to the information instead 
of an Edit icon. This means that the information cannot be edited, since it is pulled 
from another page. If the information is changed on the original page, it will 
subsequently change the information on your page.  

 

Sharing Data with Page Summary 
Another simple way to share information is through the Newsletter page component.  Through 
the Page summary component, you can simply link to another page.  This is helpful in many 
situations and saves the trouble of having to re-enter information you would like to use on your 
page.   
 
In many instances, several people will need to use the exact same information, such as 
homework assignments, test days, or even an instructional video or other attachments.  Instead 
of each person entering this information, one person can enter the information with others 
linking to it, which saves time and energy. 
 
Page Summary 

• Navigate to the page you want to add your shared information.  Choose Edit Mode from 
the Edit drop-down menu. 

• To access the page summary, click the edit icon for the newsletter box and then choose 
the Edit Box Content from the drop-down menu. 

• Page Summary is found under the Options tab.  By clicking Back to List, you will find 
the page summary.  A page summary will show in your newsletter box a summary from 
another page.  This is most frequently used with Calendar pages and Lunch Menu pages, 
but can be used for any page that is listed in the summary list.   

 
 
 

Figure 10-9 
Box Options 

 
 
 
 
 

• After clicking the Page Summary option, a new window will open.  From this window, 
choose the page you would like summarized in your newsletter box. 

• After you have chosen the page to summarize, you are given the option to hide title box 
for the item and make the summary title a link to this page.  This will allow users to 
click the newsletter box title and be taken to the summarized page.  You can also 
choose how many items you want shown in the newsletter box and how you would like 
to group recurring events. 
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Figure 10-10 
Page Summary 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Once you have made your selections you may click Done to be taken back to the Back 
to List screen. 
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Glossary 

A 
AC3 - AC3 is an audio file format that is compatible with SchoolCenter’s software. 

Active Directory – Active Directory is a Microsoft Windows tool used to organize information and 
settings for an organization in a central database. 

Active Link Color – The active link color is the color of the text while selecting the link, but 
before actually leaving the site.  As you place your mouse pointer over the link, the 
active link color appears.  When the pointer is removed, the link returns to its original 
color. 

Add Picture & Text - The Add Picture & Text button within the SchoolCenter program allows you 
to add new items to your pages. 

Add-on Service – Additional software service that interacts with SchoolCenter’s software.  
Examples of such additional services include email, additional web hosting, ftp access, 
domain hosting, and content approval. 

Administrative Departments – These pages allow you to set up non-academic departments for 
your district or school.  Under each department, you can input images, text, and all 
relevant information about the department. 

Advanced Content Editor– The Advanced Content Editor (ACE) is used to apply a special format 
to text. 

Anchor – An anchor is a tool within the Advanced Content Editor (ACE) that will allow the user to 
create a link to a specific area on the same page.  For example, the user may create a 
link at the top of the page that, when clicked, takes the page viewer directly to a section 
near the bottom of the page without refreshing the page. 

Animated GIF– An animated GIF is a graphic image that moves (e.g., a twirling icon, a banner 
with a hand that waves, or letters that become larger.). 

Apache web server – Apache web server is the web server system used by SchoolCenter. 
 
Application - An application is a program designed to perform a specific function directly for the 

user or for another application program. Examples of application programs include word 
processors, database programs, web browsers, development tools, drawing, paint, image 
editing programs, and communication programs. SchoolCenter is an application program 
that provides the tools to assist in the development and maintenance of your website. 

 

B 
BMP – .BMP is a graphics file extension that is compatible with SchoolCenter’s software. 
 
Babel Fish – Babel Fish is a tool that will translate a web page into Chinese, German, Japanese, 

Korean, French, Italian, Portuguese, or Spanish.  This tool is optional and available on 
each page. 

Background Color– This is the base color of the site background. 

Background Image– A graphic can be uploaded from your hard-drive and used as a background for 
the site. When using the SchoolCenter program, images are tiled to fill the screen. 
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Banner Image- A Banner Image is a graphic image that announces the name and identity of a site 
and often is spread across the width of the web page. A banner image can replace the 
Title Bar. 

Board – See Message Board. 

Blog –  A Blog is a SchoolCenter component that allows a user to create journal style entries that 
display in reverse chronological order.  This component may also allow other users or 
visitors to leave comments about the author’s post. 

Browse - The Browse button lets you view the file names in your disk folders. 

Browser – The browser is the program you are using to visit sites and download information on 
the web.  The two most common browsers are Internet Explorer and Netscape Navigator. 

 
Bug – An identified error in software or hardware. If the bug is in software, it can be corrected by 

changing the program. If the bug is in hardware, new circuits have to be designed. 

 

C 
Calendar- This page allows you to post event information in a calendar format. The name, date, 

time, category, and details for each event are also available through this page. 
 
Cell Padding – Cell Padding is a value set within the Table Properties in the Advanced Content 

Editor (ACE) that determines the minimum width within each cell. 
 
Cell Spacing – Cell Spacing is a value set within the Table Properties in the Advanced Content 

Editor (ACE) that determines the spacing between each cell in the table. 
 
Cancel – The Cancel option redirects you back to the previous page without adding any new 

information into a component or page. 
 
 Categorized Scrapbook - With a Categorized Scrapbook page, a user can create categories under 

which they can list links to other internet sites for visitors to their website to access. 
These categories might include educational resources, community pages, etc. 

Classrooms - A Classroom is a designated area off the main school site. This area allows teachers 
to create unlimited web pages for their classroom. 

Cleanup Messy Code Tool – The Cleanup Messy Code Tool is a tool located within the Advanced 
Content Editor (ACE) that removes extraneous HTML code that might otherwise adversely 
affect the appearance of content on the page. 

Clubs & Groups - A designated area off the main school site. This area allows club or group 
sponsors to create unlimited web pages for their club or group. 

Color Picker – The color picker is a tool that opens in a pop-up window that gives the user the 
ability to set a color for any feature of the software where the color is changeable. 

Component- A component is a template. Templates provide the easy creation of different types 
of web pages. SchoolCenter has many different components available to users (e.g., 
Calendar, Scrapbook, Document Manager and many more). 

Contact Directory - A Contact Directory is a SchoolCenter component that allows you to make a 
directory for the contacts in your school or district. 

Contact Form - A Contact Form is a form available at each level of the program that allows 
parents and others to contact school personnel. Users fill out a form and your email 
address is never displayed. 
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Content Approval – An add-on service requiring administrative approval before web page content 
becomes publicly available. 

Content Management System - A Content Management Tool is a template that provides for the 
easy creation of different types of web pages. SchoolCenter has many different tools 
available to users (e.g., Calendar, Scrapbook, Document Manager and many more). 

 
Custom Navigation – Custom Navigation is a feature that allows you to group similar links under a 

main link, also referred to as a parent link.   

 

D 
Database - A database is a collection of records stored in a computer in a systematic way so that 

a computer program can consult it to answer questions. The items retrieved in answer to 
queries become information used to make decisions. The computer program used to 
manage and query a database is known as a database management system (DBMS). The 
properties and design of database systems are included in the study of information 
science.  

 
Delete – The Delete option deletes data and redirects you to the previous page. 
 
Desktop – The Desktop is the site management for the SchoolCenter program. The Desktop Page 

allows users to add new users to the site, navigate easily throughout the site, edit the 
layout of the site, define area access, add or remove components, view occurrences of 
profanities, view website statistics, and other administrative functions. 

 
District Calendar – The District Calendar page allows you to post information in a calendar 

format. The name, date, time, category, and details for each event are also available 
through this page. Multiple calendars can be created for the district. 

 
DNS - The Domain Name System (DNS) is a global network of servers that translate host names 

like www.schoolcenter.com into numerical IP (Internet Protocol) addresses like 
255.255.255.255, which computers on the internet use to communicate with each other. 

 
Document Manager - This page allows you to post documents or files that are common to your 

district. The Document Manager is available in every department and will accept over 350 
different file types. 

 
Done – The Done option saves the data and redirects to the previous page. 
 
Download - Downloading is the process of saving files to your computer from another source 

(e.g., the internet). People often download files such as free-ware, share-ware, 
installation programs, sounds, movie clips, text files, news streams for viewing or 
listening, and countless other types of files. 

 
Drill-down Navigation – Drill-down navigation is the string of links located near the top of the 

page.  The function of drill-down navigation is to help the user quickly locate where he or 
she is within the hierarchy of a website.  As a user moves down the hierarchy and into 
specific sections of the software, links to the top level of the section will be available.  
Thus, a user who has navigated down to a classroom page may quickly navigate back up 
to the district site by clicking on the district link at the beginning of the drill-down 
navigation. 
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E 
Edit- This feature brings up a text box where you can type in information for inclusion on your 

website. Other options available allow you to edit the size, alignment, and style of the 
text. You also have the ability to preview what the text will look like on your page before 
saving it.  In addition, you have access to a spell checker. 

F 
FTP – (File Transfer Protocol) A protocol used to transfer files over a TCP/IP network (internet, 

Unix, etc.). For example, after developing the HTML pages for a website on a local 
computer, they are typically uploaded to the Web server using FTP. 

 
Feed Reader - A feed reader, also known as a news aggregator, is a software application or 

remotely-hosted service that collects syndicated information such as news, sports scores, 
weather forecasts and reference materials from various sources and makes it available to 
its customers. 

 
Font - A set of type characters of a particular typeface design and size. Usually, each typeface 

(Times Roman, Helvetica, Arial, etc.) is made available in four variations: normal weight, 
bold, italic and bold italic. Fonts come built into the printer, as plug-in cartridges or as 
soft fonts, which reside on the computer's hard disk or a hard disk built into the printer. 

 

 

G 
GIF– GIF is an abbreviation for Graphical Interchange Format. GIF is a digital image format 

developed by CompuServe to help the transfer of image files through their online service, 
but now used universally on the internet, web, and even CD-ROM applications. A GIF 
image will have the file extension .gif.  GIF is a file extension format that is compatible 
with SchoolCenter’s software. 

 
Group Access – Any SchoolCenter component can be created so that it is only accessible to one or 

more user groups. For example, a calendar can be set up so only users with a teacher 
level access can view it.   

 

H 
Hide Title - Hide Title lets a user hide the title bar in order to replace the title bar with a 

banner-sized image. 
 
Homepage - The home page is the first page that viewers see when accessing your school or 

district site. It is also the first page available when clicking on a teacher's classroom, an 
administrative department, club, group, or sports page. 

 
HTML - HTML (Hypertext Markup Language) is the set of symbols or codes inserted in a file 

intended for display on a World Wide Web browser page. HTML tells the web browser how 
to display words and images of a web page for the user. Although knowledge of HTML is 
not necessary for use of the SchoolCenter program, it can be implemented into the text 
boxes. 
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I 
Icon – An Icon is a visual representation of an operation or function within the software. 

Intranet - An intranet is a private network that is contained within an enterprise. The main 
purpose of an intranet is to share information and computing resources among a select 
group of users, while not being available to those outside an organization. 

J 
JPEG – JPEG, or jpg, is the abbreviation for Joint Photographic Experts Group and is a digital 

image format. This format uses a standard compression for color images, allowing more 
graphical information to be stored in smaller files. This image format is used universally 
on the web and in some local software and CD-ROM applications.  JPEG file extensions are 
compatible with SchoolCenter’s software. 

L 
LDAP – LDAP (Lightweight Directory Access Protocol) is a network protocol that allows for the 

querying and modifying directory services. 

Lead Tech - The person who is assigned by the site administrator to manage the website for one 
or more schools. This person is generally responsible for setting up classrooms and 
training the teachers as well as maintaining the site. 

Legacy Mode – Legacy Mode refers to a method of functionality used in a previous version of the 
software. 

Limited Access - SchoolCenter program users can be assigned privileges to edit and administer a 
specific component such as the school's calendar or a district message board. Any of the 
four levels of access can be assigned to this user. 

Link – A link is a reference or navigation element in a document to another section of the same 
document, or a specified section of another document, that automatically brings the 
referred information to the user when the navigation element is selected by the user.  As 
such, it is similar to a citation in literature, but with the distinction of automatic instant 
access 

Link Color - The color of the links on your website prior to being visited. 

Listserve - A listserve is an electronic mailing list. A listserve may be a discussion group or may 
be announcement-only. Users may subscribe or unsubscribe to the listserve through 
commands sent to a specific email address on the listserve. Likewise, within a discussion 
group, users may post messages by sending the message to a specific email address on the 
listserve, which in turn, emails a copy of the message to all subscribers. In an 
announcement-only listserve, only a select few people, called moderators, are allowed 
to post messages. 

Local Account – A Local account involves all sites, district and schools, Local on servers in 
SchoolCenter’s datacenter.  

 

M 
M4A – An M4A is an audio file that is compatible with SchoolCenter’s software.   

MP3 – An MP 3 is an audio file extension format that is compatible with SchoolCenter’s software. 

MIDI – MIDI is an audio file extension format that is compatible with SchoolCenter’s software.  
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Main Site Admin - Main Site Administrators are responsible for adding users and managing the 
administrative functions of the website. There is no higher level of access. This access is 
granted to only one User account. 

Meetings and Agendas - This page allows you to post information about meetings and agendas for 
upcoming meetings in your school or district. 

Message Board - A Message Board is a dedicated spot for individuals to have threaded discussions 
by posting and replying to messages. This component is available at each level of the 
program. The message board administrator must approve both messages and replies 
before they appear live on the site. 

Meta tags – Meta tags are descriptive keywords pertaining to content on the page added in the 
Page Settings.  These meta tags are used to help a visitor find content they are looking 
for when they use the Site Search. 

My Desktop - This button takes you to the Desktop Page for the area that you have privileges to 
(e.g., district, school, classroom, etc.). 

MySQL – MySQL is a Relational Database Management System (RDBMS) that relies on SQL for 
processing the data in the database. 

N 
Navigation Links – Navigation is the list of links that a user or visitor to a web page would use to 

go to various pages on the site.  Navigation may be located on the top, right, or bottom 
of the web page, but it is most commonly found on the left side. 

 
Navigation Tools – Navigation Tools refers to the SchoolCenter interface that a user would use to 

build the navigation on a web page. 

Newsletter Style – The Newsletter style component is what you use to insert pictures and text to 
your homepage. The Newsletter style gives you a way to create fields arranged in 
columns that can display different information each time the page is refreshed. Not only 
do you have the option of displaying pictures and text, but you can also share information 
from other pages.   

Non-Student Organizations - Non-Student Organizations are departments in the school that are 
not directly related to students or administration (e.g., PTA or sports booster clubs). 

O 
Onsite Account – An onsite account involves all sites, district and schools, hosted on a 

SchoolCenter server located on the district/school network. 

Other Web Page - The Other Web Page component allows you to add a link to a web page outside 
of the SchoolCenter pages. 

P 
Page Design - In the Desktop, this area allows the user to edit colors, navigation layout, font type 

and font size, add background and header images, and other layout options for their site. 

Password - A password is a unique and individual word, or series of numbers, that is assigned to 
users of the SchoolCenter program. The password is used to log onto the site. 

PDF - PDF (Portable Document Format) is a file format that has captured all the elements of a 
printed document as an electronic image. To view and use the files, you need the free 
program Acrobat Reader. 
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PHP – PHP is the code SchoolCenter’s software is written in. 

Pixel: A pixel (a word invented from "picture element") is the basic unit of color on a computer 
display or in a computer image. 

Podcast – A podcast is an audio or video file that is distributed through subscription over the 
internet via syndication.  While the audio or video file may be available directly from the 
authors’ web page, a podcast uses a third party application to aggregate the files.  Within 
the SchoolCenter software, the Document Manager can be used to create a podcast. 

Privileges - The website or designated portions of the website that a user has the right to edit 
using the SchoolCenter program. 

Profanity Filter- The Profanity Filter is a feature within the SchoolCenter program that filters 
inappropriate words and language so they will not show up on the web pages. Once the 
Profanity Filter is turned on, profanities are monitored automatically through the 
program. 

Pull Data – Pull Data is a function within the software that allows a user to show data from 
another component on a component the user has created.  This allows the user to show 
data they created/posted as well as data brought in from another component.  This 
function works with the Calendar, Contact Directory, Document Manager, Meetings & 
Agendas, Useful Links, and What’s New components. 

 
Push Data – Push Data is a function within the software that allows the Main Site Administrator to 

show data from a particular component on another component as well.  This function 
works with the Calendar, Contact Directory, Document Manager, Meetings & Agendas, 
Useful Links, and What’s New components. 

 

Q 
Questions and Answers - This page allows frequently asked questions and the answers to be 

posted to your website. As with most of the SchoolCenter components, descriptive text 
may be added to the top or bottom of the page. 

R 
Radio Button – A radio button, found throughout the SchoolCenter program, is a graphical user 

interface element whereby the user is presented with a list of options of which only one 
may be selected.  Typically, a radio button is circular in shape and empty if unselected, 
and has a black dot in the center if selected.   

 
RSS – RSS (Really Simple Syndication) is a type of web feed format used to publish regularly 

updated content.  An RSS reader will aggregate several feeds so that the user may read 
them all from one site. 

Resolution - Resolution is the number of pixels, or individual points of color, contained on a 
display monitor or a graphic image. Resolution is expressed as dpi, or dots per inch. 

S 
Save - The Save button, found throughout the SchoolCenter program, allows you to save text, 

images, or other information. 
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School Board: A program component that allows you to post information and/or images of your 
school board members. 

School History: A component that permits you to include your school's history, with images, on 
the school website. 

School Map: A component page that allows you to post maps of your school building or driving 
directions by inputting images and text. 

School Policies: With this page you can list your school's policies. 

Scores: In the Sports Zone pages, you can list the scores from athletic events, show pictures of 
your teams, and input any other pertinent information about your team. 

Scrapbook: This page allows you to add text and graphics to create scrapbook pages for your 
school. You may create unlimited scrapbook pages. 

Scrapbook - The Scrapbook component allows you to add text and graphics to create scrapbook 
pages for your school. You may create unlimited scrapbook pages. 

Section - A section is an area in your website. Examples of sections are District, School, 
Classrooms, Administration Departments, Clubs and Groups, Non-Student Organizations 
and Sports Zones. 

Server - A server is a computer or device on a network that manages network resources. For 
example, a file server is a computer and storage device dedicated to storing files. Any 
user on the network can store files on the server. A print server is a computer that 
manages one or more printers.  A network server is a computer that manages network 
traffic. A database server is a computer system that processes database queries. 

Share Data – Share Data is a function that allows the user to either pull in data from another 
component or push data to another component.  Currently, the push function is only 
available to the Main Site Administrator. 

Side Navigation Bar - The rectangular box that surrounds the websites links. This will only appear 
if you choose to have your links located on the side view. The side navigation bar can be 
hidden by making its color the same as the background color. 

Site Administrator – A Site Administrator is the person (or persons) who is the primary 
administrator of the SchoolCenter Program. This person generally is either a Technology 
Coordinator or a Web Master. The site administrator has complete access over the whole 
program. 

SIF – SIF (Schools Interoperability Framework) is the specification for modeling data and 
information in an XML format for sharing that information between software applications 
in the educational sphere. 

 
SSL – SSL (Secure Sockets Layer) provides for secure transmission of information over the 

internet.  Within the SchoolCenter software, everything within the desktop interface will 
be encrypted as it is transmitted, the only exception being areas where the Advanced 
Content Editor (ACE) is used.  At this time, only the Desktop is encrypted and not 
individual pages. 

 
Syndication – Syndication refers to a section of content on a web page that is available for use by 

other websites or may be pulled by a Feed Reader. 

T 
TIF – A TIF, also known as a Tagged Image File, is a graphics file extension format that is 

compatible with SchoolCenter’s software. 
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Table – A table is a collection of information displayed in a matrix. Also called an "array," tables 
may remain constant or be updated. 

Template - A template is a pattern used as a guide when developing a site or page.  SchoolCenter 
templates are the components that help you in developing your website. 

Ticket/Trouble Ticket – A ticket refers to SchoolCenter’s system of identifying problems that 
users of our software have reported.  When a ticket is issued, SchoolCenter takes action 
to correct the trouble.  This system is effective in allowing SchoolCenter to track the 
process of a problem with the software.   

 
Title Background – The title background is the rectangular box that surrounds the title at the top 

of every page. 

Title Bar - The title bar is the descriptive text at the top of the page usually enclosed in a 
rectangular box that announces the name and identity of a site. 

Title Font - The title font is the text font type that appears within the rectangular box at the top 
of every website page (e.g., Ariel, Times New Roman, etc.). 

Toggle Guidelines – Toggle Guidelines is a tool in the Advanced Content Editor (ACE) used to 
show or hide invisible elements within the editing area, such as table cells and borders. 

 
Truncate – Truncate refers to limiting something within the software by an amount of time or 

length of characters.  For example, the option to “Truncate Users by Graduation Date” 
will remove users from the system based on their graduation date.  Likewise, on user 
imports where the user name or password exceeds 15 characters, the user name or 
password will be limited to the first 15 characters only. 

 

U 
Upload – Upload refers to the process of creating an exact copy of a file from a user’s local 

computer on a Onsite Server.  This file is then simply stored or used on a web page. 

URL - An Internet address (for example, http://www.schoolcenter.net/newsletter), usually 
consisting of the access protocol (http), the domain name (www.schoolcenter.net), and 
optionally the path to a file or resource residing on that server (newsletter). 

Useful Links - With this page, a user can list links to websites outside of SchoolCenter. These 
links might include educational resources or community pages. 

User – A User is anyone who has been issued a User ID and password for the SchoolCenter program 
in order to update, manage information, or view areas of the site. The Site Administrator 
determines what access level will be assigned to the users. 

User ID, Logon - This is the unique and individual nickname the User is given to log onto 
SchoolCenter. It is also known as the Logon Name or Login ID. 

User Selectable – User Selectable is a setting within the Admin settings.  Setting this option will 
allow the user to choose between new edit mode and legacy edit mode. 

 

V 
Visited Link Color– The Visited Link Color is the color of the link after the link has been visited. 

Visitor– A Visitor is anyone who visits your district or school website. Visitors can be issued a User 
ID and Password to view password-protected areas of the site. 
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W 
WAV – A Wav is an audio file extension format that is compatible with SchoolCenter’s 

software. 
 
Weblog- A weblog is a dedicated spot for individuals to have threaded discussions by posting 

messages. This component is available at each level of the program. The weblog 
administrator must approve replies before they appear live on the site. Can be used as an 
online diary or a personal chronological log of thoughts published on a Web page. 

 
WebMail – WebMail is the name of the SchoolCenter Email Management Solution. 
 

Web page - A Web page is one page in your site or section. Examples of a web page would be a 
Homepage, Calendar, and Scrapbook. 

Web Quest - Web Quest is a research activity in which students collect information from Internet resources. 

WebTools – WebTools is the name of the SchoolCenter Content Management Solution. 

What’s New - A SchoolCenter component that allows you to post the title, date, and a brief 
description for each new item. This page is useful for posting upcoming news and changes 
that occur in your district or school. This component is available in all sections. 

Z 
 
ZIS – ZIS (Zone Integration Server) is the key component of SIF and makes SIF possible.  It is a 

server that creates a central point of communication among the various systems within 
the school framework. 
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